
 

 

LearnMate LMS V3.2 
User Manual 

 

 
 

Catalog #100395 Rev. C 

August 2006 
 



  
 

 

 



  
 

 

 
 

Copyright ©2006  Inc. 

LEARNMATE V3.2 USER MANUAL 

 

Catalog #100395 Rev. C 

August 2006 

 

 

Every effort has been made to make this book as complete and accurate as possible. However, 
no warranty of suitability, purpose, or fitness is made or implied.  is not liable or 
responsible to any person or entity for loss or damage in connection with or stemming from the 
use of the application and/or the information contained in this publication. 

 bears no responsibility for errors that may appear in this publication and retains the right 
to make changes to the application and manual without prior notice. 

 

 

INTELITEK INC. 
444 East Industrial Park Drive 
Manchester, NH 03109-5315 
Tel: (603) 625-8600 
Fax: (603) 625-2137 
Website: www.intelitek.com  

http://www.intelitek.com/


  
 

 

 



  
 

LearnMate v3.2 User Manual  i 

Table of Contents 
1. Required System Configuration 1 

Introduction ............................................................................................................................. 1 
Objectives ......................................................................................................................... 1 

Required Utilities ..................................................................................................................... 1 
LM Agent and Required Software ........................................................................................... 2 

Installing the LM Agent...................................................................................................... 2 
Installing Required Software ............................................................................................. 5 

LearnMate Utility Check .......................................................................................................... 6 
Utility Check Page.............................................................................................................6 

Accessing the Utility Check from the Login Page........................................................ 6 
Testing for the Required Applications ......................................................................... 7 
Checking the Server Version....................................................................................... 8 

Active System Check ........................................................................................................ 8 
Pop-up Blocking...................................................................................................................... 9 

Internet Explorer................................................................................................................ 9 
Google............................................................................................................................. 10 

Adding LearnMate as a Trusted Site..................................................................................... 10 
Review .................................................................................................................................. 12 

Ask Yourself .................................................................................................................... 13 

2. Logging In 14 
Review of Previous Chapter.................................................................................................. 14 
Introduction ........................................................................................................................... 14 

Objectives ....................................................................................................................... 14 
The Login Page..................................................................................................................... 15 

Introduction ..................................................................................................................... 15 
The Login Page............................................................................................................... 15 
Accessing LearnMate...................................................................................................... 15 
Accessing the System..................................................................................................... 17 
Self-Registration..............................................................................................................17 
Password Tips and Tricks ............................................................................................... 19 
Logging in to the System................................................................................................. 19 

Review .................................................................................................................................. 20 
Ask Yourself .................................................................................................................... 20 

3. Navigation Bar and Main Menu 21 
Review of Previous Chapter.................................................................................................. 21 
Introduction ........................................................................................................................... 21 

Objectives ....................................................................................................................... 21 
Navigation ............................................................................................................................. 22 

Components.................................................................................................................... 22 
Navigation Menu ............................................................................................................. 22 
Path Bar .......................................................................................................................... 22 
Panels ............................................................................................................................. 22 
Hyperlinks and Icons....................................................................................................... 23 
Main Menu ......................................................................................................................23 

My Calendar.......................................................................................................................... 23 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  ii 

Viewing the Calendar ...................................................................................................... 24 
Adding an Event.............................................................................................................. 24 
Viewing All Scheduled Events......................................................................................... 26 
Modifying Events............................................................................................................. 26 
Deleting an Event............................................................................................................ 27 
Sending Events ............................................................................................................... 27 
Approving/Declining an Event ......................................................................................... 30 

My Inbox................................................................................................................................ 31 
Viewing Your Inbox ......................................................................................................... 31 
Opening a Message ........................................................................................................ 31 
Composing a New Message ........................................................................................... 32 
Replying to a Message.................................................................................................... 36 
Forwarding a Message.................................................................................................... 37 
Deleting a Message ........................................................................................................ 38 
Saving a Message........................................................................................................... 39 
Viewing Sent Mail............................................................................................................ 40 
Viewing Saved Mail ......................................................................................................... 41 

My Folder .............................................................................................................................. 42 
Opening My Folder.......................................................................................................... 42 
Adding a File to My Folder .............................................................................................. 43 
Viewing a File in My Folder ............................................................................................. 45 
Downloading a File from My Folder ................................................................................ 46 
Deleting a File from My Folder ........................................................................................ 47 
Creating a New Subfolder ............................................................................................... 47 
Moving a File to a Different Folder .................................................................................. 48 
Deleting a Subfolder........................................................................................................ 49 
Assignments and My Folder............................................................................................ 51 

My Profile .............................................................................................................................. 51 
Modifying My Profile and Changing your Password........................................................ 51 

My Grades............................................................................................................................. 54 
Viewing My Grades ......................................................................................................... 54 

My Favorites.......................................................................................................................... 57 
Adding Links to My Favorites .......................................................................................... 57 
Modifying Links in My Favorites ...................................................................................... 58 
Deleting Links from My Favorites.................................................................................... 59 

Customer Support ................................................................................................................. 59 
Mail.................................................................................................................................. 59 

Review .................................................................................................................................. 60 
Ask Yourself .................................................................................................................... 60 

4. My Desktop 61 
Review of Previous Chapter.................................................................................................. 61 

Objectives ....................................................................................................................... 61 
My Desktop ........................................................................................................................... 62 
The Class Main Page............................................................................................................64 

Introduction ..................................................................................................................... 64 
Viewing the Class Main Page ......................................................................................... 64 
Page Layout ....................................................................................................................66 

Header Panel ........................................................................................................................ 68 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  iii 

Viewing the Class Main Page of Another Class.............................................................. 68 
Contacting your Instructor ............................................................................................... 68 
Performing a Utility Check............................................................................................... 69 
Viewing a Schedule (Laboratory Classes Only) .............................................................. 69 

Modules................................................................................................................................. 70 
Launching a Module........................................................................................................ 71 
Module Resources .......................................................................................................... 72 

Viewing a Module Resource...................................................................................... 73 
Saving a Resource File ............................................................................................. 74 

Software Check............................................................................................................... 75 
Students ................................................................................................................................ 77 

Scheduling an Event ....................................................................................................... 77 
Accepting or Declining an Event Invitation...................................................................... 80 
Sending a Mail Message................................................................................................. 80 

Chats..................................................................................................................................... 82 
Joining a Chat .................................................................................................................82 
Saving a Chat to a Local File .......................................................................................... 84 
Viewing Archived Chat Sessions .................................................................................... 85 
Chat Manager ................................................................................................................. 87 

Editing a Chat (Chat Manager Only) ......................................................................... 87 
Archiving Chat Sessions (Chat Manager Only)......................................................... 88 
Editing a Chat Archive (Chat Manager Only) ............................................................ 89 
Deactivating a Chat (Chat Manager Only) ................................................................ 90 

Forums.................................................................................................................................. 91 
Participating in a Forum .................................................................................................. 92 

Viewing Topics and Replies ...................................................................................... 93 
Replying to Messages ............................................................................................... 94 
Printing Messages..................................................................................................... 95 
Saving Messages ...................................................................................................... 96 
Creating a Topic ........................................................................................................ 97 

Forum Manager............................................................................................................. 100 
Editing Forum Details (Forum Manager Only)......................................................... 100 
Deactivating a Forum (Forum Manager Only)......................................................... 100 
Editing and Deleting Forum Entries (Forum Manager Only) ................................... 101 

Class Tests ......................................................................................................................... 102 
Start Date and End Date ............................................................................................... 103 
Test Status ....................................................................................................................103 

Not Started .............................................................................................................. 103 
In Progress .............................................................................................................. 103 
Completed ............................................................................................................... 103 
Expired .................................................................................................................... 103 

Launching a Test........................................................................................................... 103 
Authentic Assessment Questions............................................................................ 105 
Open/Essay Questions............................................................................................ 106 

Assignments........................................................................................................................ 107 
Launching an Assignment............................................................................................. 107 
Working with User Files ................................................................................................ 109 

Adding a New User File........................................................................................... 109 
Opening and Downloading a User File.................................................................... 111 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  iv 

Uploading an Existing User File .............................................................................. 112 
Creating a New Version of a User File .................................................................... 114 
Deleting a User File................................................................................................. 115 
Creating and Viewing Working Notes...................................................................... 116 

Preliminary Evaluations................................................................................................. 117 
Submitting an Assignment for Evaluation................................................................ 117 
Evaluating an Assignment (Student and Instructor) ................................................ 119 
Viewing Past Evaluations ........................................................................................ 123 

Submitting an Assignment for Grading ......................................................................... 124 
Class Resources................................................................................................................. 124 

Opening a Resource File .............................................................................................. 125 
Saving a Resource File ................................................................................................. 125 

Review ................................................................................................................................ 125 
Ask Yourself .................................................................................................................. 126 

5. Viewing LearnMate Content 127 
Review of Previous Chapter................................................................................................ 127 
Introduction ......................................................................................................................... 127 

Objectives .....................................................................................................................127 
Overview of Content Viewer................................................................................................ 128 
Launching a Module............................................................................................................ 129 
Navigating a Module ........................................................................................................... 130 

Moving from Page to Page............................................................................................ 130 
The Upper Icons.................................................................................................................. 131 

My Learning .................................................................................................................. 131 
Print............................................................................................................................... 132 
Help............................................................................................................................... 133 

Exploring the LearnMate Toolbox ....................................................................................... 133 
Audio Narration ............................................................................................................. 134 
Competencies ............................................................................................................... 134 
Safety Instructions......................................................................................................... 135 
Glossary ........................................................................................................................ 135 
Notes............................................................................................................................. 136 
Links Library..................................................................................................................136 

Tests and Questions ........................................................................................................... 138 
Reaching a Test in a Module ........................................................................................ 139 
Reviewing Answers to a Test........................................................................................ 140 
Answering Test Questions ............................................................................................ 141 

Multiple Choice Questions....................................................................................... 141 
Matching Questions................................................................................................. 142 
Hotspot Questions................................................................................................... 143 
Drag and Drop (Ordered) Questions ....................................................................... 144 

Review ................................................................................................................................ 146 
Ask Yourself .................................................................................................................. 146 

6. Catalog 147 
Review of Previous Chapter................................................................................................ 147 
Introduction ......................................................................................................................... 147 

Objectives .....................................................................................................................147 
What is the Catalog?...........................................................................................................148 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  v 

Class Enrollment ................................................................................................................. 148 
Enrolling in a Class ....................................................................................................... 148 
Launching the Class...................................................................................................... 151 

Review ................................................................................................................................ 151 
Ask Yourself… .............................................................................................................. 151 

7. Administration Quick-Start Guide 152 
Foreword............................................................................................................................. 152 
Introduction ......................................................................................................................... 152 
Step 1: Set Up an Organization .......................................................................................... 153 
Step 2: Add Users to an Organization................................................................................. 153 
Step 3: Create a Class ........................................................................................................ 153 
Step 4: Add Modules to a Class.......................................................................................... 153 
Step 5: Enroll Students in a Class....................................................................................... 153 
Step 6: Manage the Class................................................................................................... 154 
The Administrator’s LearnMate Interface ............................................................................ 154 

Navigation .....................................................................................................................154 
Components ............................................................................................................ 154 
Navigation Menu ..................................................................................................... 155 
Path Bar .................................................................................................................. 155 
Submenus ............................................................................................................... 155 
Panels ..................................................................................................................... 156 
Hyperlinks and Icons ............................................................................................... 156 
Main Menu............................................................................................................... 157 
My Folder ................................................................................................................ 157 
My Desktop ............................................................................................................. 157 
Catalog .................................................................................................................... 158 

Review ................................................................................................................................ 158 
Ask Yourself… .............................................................................................................. 158 

8. System Administration 159 
Review of Previous Chapter................................................................................................ 159 
Introduction ......................................................................................................................... 159 

Objectives .....................................................................................................................159 
Administration Overview ..................................................................................................... 160 
Reports................................................................................................................................ 160 

List of Available Reports ............................................................................................... 161 
Reports – Competencies............................................................................................... 163 

Competencies per Module ...................................................................................... 163 
Competencies per Skills Standard .......................................................................... 166 
Modules per Skills Standard.................................................................................... 168 

Reports – Module.......................................................................................................... 170 
Available Modules ................................................................................................... 170 
Module Enrollments and Progress .......................................................................... 172 
Module Index........................................................................................................... 174 
Modules Studied per Day ........................................................................................ 177 

Reports – System.......................................................................................................... 180 
Enrollments ............................................................................................................. 180 
User Logins ............................................................................................................. 182 

Reports – User .............................................................................................................. 186 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  vi 

Academic Progress Report ..................................................................................... 186 
Class Grades........................................................................................................... 189 
Test Grades............................................................................................................. 192 
User Competency Progress .................................................................................... 194 
User Details............................................................................................................. 199 
Username and Password ........................................................................................ 202 

Organization Management.................................................................................................. 205 
Adjusting Settings for Your Own Organization.............................................................. 207 

Name....................................................................................................................... 209 
ID.............................................................................................................................209 
Description .............................................................................................................. 209 
Password................................................................................................................. 210 
Measurement Type ................................................................................................. 210 
Language ................................................................................................................ 211 
Organization Logo ................................................................................................... 211 
Date and Time Format ............................................................................................ 214 
Welcome Name....................................................................................................... 215 
Prefix Before Name................................................................................................. 215 
Suffix After Name .................................................................................................... 215 
Show Glossary Letters ............................................................................................ 215 
Allow Users to Change Password ........................................................................... 216 
Customer Support ................................................................................................... 216 
Uploads ................................................................................................................... 217 

Creating a New Sub-Organization ................................................................................ 217 
Changing Settings for Sub-Organization....................................................................... 218 

Skills Standards....................................................................................................... 219 
Modules................................................................................................................... 219 
Reports.................................................................................................................... 220 

Editing an Organization................................................................................................. 221 
Deleting an Organization............................................................................................... 222 

User Management............................................................................................................... 222 
Roles ............................................................................................................................. 223 

Student .................................................................................................................... 224 
Instructor/Manager .................................................................................................. 225 
Administrator ........................................................................................................... 225 

Permissions................................................................................................................... 225 
Content Administrator.............................................................................................. 225 
Organization Administrator...................................................................................... 226 

Creating a New User..................................................................................................... 226 
Personal Details Panel ............................................................................................ 227 
Account Information Panel ...................................................................................... 228 

Username.......................................................................................................... 228 
Password........................................................................................................... 228 

Other Information Panel .......................................................................................... 228 
Administration Details Panel ................................................................................... 229 

Status ................................................................................................................ 229 
Role ................................................................................................................... 229 
Registration Expiration ...................................................................................... 229 
Organization ...................................................................................................... 230 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  vii 

Classes.............................................................................................................. 230 
Permissions....................................................................................................... 231 

Personal Details Panel ............................................................................................ 231 
Searching for a User ..................................................................................................... 232 
Editing a User................................................................................................................ 233 
Deleting a User ............................................................................................................. 233 

Replacements ..................................................................................................................... 234 
Class Management ............................................................................................................. 234 

Creating a New Class ................................................................................................... 235 
Class Name............................................................................................................. 236 
Assigning Instructor................................................................................................. 237 

Class Details (Administrator)......................................................................................... 238 
Description .............................................................................................................. 238 
Type ........................................................................................................................ 238 
Enrollment Via Catalog............................................................................................ 238 
Room....................................................................................................................... 239 
Laboratory Details Panel ......................................................................................... 239 

Rotations ........................................................................................................... 239 
Times................................................................................................................. 239 
Days .................................................................................................................. 239 
Class Main Page ............................................................................................... 239 
Enrollment ......................................................................................................... 239 
Enrollment Dates............................................................................................... 240 

Viewing Modules ........................................................................................................... 240 
Copying a Class ............................................................................................................ 241 
Editing a Class .............................................................................................................. 242 
Deleting a Class ............................................................................................................ 242 
Archiving a Class .......................................................................................................... 244 

Organization Chats and Forums ......................................................................................... 245 
Creating an Organization Chat...................................................................................... 245 

Name....................................................................................................................... 246 
Description .............................................................................................................. 246 
Selection of Chat Manager...................................................................................... 246 

Deactivating an Organization Chat ............................................................................... 248 
Reactivating an Organization Chat ............................................................................... 248 
Deleting an Organization Chat ...................................................................................... 250 
Creating an Organization Forum................................................................................... 250 
Deactivating an Organization Forum............................................................................. 251 
Deleting an Organization Forum ................................................................................... 251 

Review ................................................................................................................................ 252 
Ask Yourself… .............................................................................................................. 252 

9. Class Management 253 
Review of Previous Chapter................................................................................................ 253 
Introduction ......................................................................................................................... 253 

Objectives .....................................................................................................................253 
Setting Up the Class – Class Main Page ...................................................................... 254 
Header Panel ................................................................................................................ 255 

Average Class Grade .............................................................................................. 255 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  viii 

Utility Check ............................................................................................................ 256 
Class Details (Instructor) ......................................................................................... 256 
Customize Gradebook............................................................................................. 256 

Defining Module Grades.................................................................................... 258 
Defining Class Test Grades............................................................................... 259 
Defining Assignment Grades............................................................................. 259 
Defining Additional Grades................................................................................ 260 
Adjusting Top-Level Grades.............................................................................. 261 

Rotational Schedules .............................................................................................. 262 
Generating a Rotational Schedule..................................................................... 263 
Restricting Students in Rotational Assignments................................................ 265 
Manually Adjusting an Automatically Generated Rotational Schedule.............. 267 
Printing Rotational Schedules ........................................................................... 269 

Modules (Instructor) ...................................................................................................... 269 
Adding Modules to Class......................................................................................... 269 

Select Modules for Addition............................................................................... 269 
Specify Open Index Navigation ......................................................................... 270 

Defining Module Delivery Options ........................................................................... 270 
Enabling Pre-Test.............................................................................................. 271 
Selecting Pre-Test ............................................................................................. 271 
Test List Panel................................................................................................... 272 
Select Test ........................................................................................................ 273 
Preview Test...................................................................................................... 273 
Test Navigation ................................................................................................. 274 
Number of Retakes ........................................................................................... 274 
Time Limit .......................................................................................................... 275 
Availability Dates ............................................................................................... 275 
Authentic Assessment Questions...................................................................... 275 
Feedback and Results....................................................................................... 275 
Randomize Questions ....................................................................................... 276 
Save .................................................................................................................. 276 

Deleting Modules from Class .................................................................................. 276 
Students ........................................................................................................................ 277 

Enrolling Students ................................................................................................... 277 
Unenrolling Students ............................................................................................... 279 
Modifying a Student’s Module Enrollments ............................................................. 279 
Updating All Students’ Grades ................................................................................ 281 

Grades .......................................................................................................................... 281 
Opening a Student’s Gradebook ............................................................................. 282 
Changing Overall Test Grades................................................................................ 282 
Changing Individual Question Grades..................................................................... 283 
Changing Assignment Grades ................................................................................ 284 
Changing Additional Grades ................................................................................... 285 
Grading Open/Essay Questions.............................................................................. 285 
Printing a Student’s Gradebook .............................................................................. 286 

Class Chats................................................................................................................... 287 
Create a Class Chat ................................................................................................ 287 
Appoint a Chat Manager ......................................................................................... 288 
Reactivate a Chat.................................................................................................... 288 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  ix 

Class Forums ................................................................................................................ 288 
Class Tests ................................................................................................................... 288 

Adding a Test to a Class ......................................................................................... 288 
Removing a Test from a Class ................................................................................ 290 
Note on Test Status................................................................................................. 290 
Setting Availability Dates for a Test......................................................................... 291 
Define Test Delivery Options................................................................................... 292 
Viewing Test Questions........................................................................................... 296 

Assignments.................................................................................................................. 297 
Adding an Assignment ............................................................................................ 297 
Removing an Assignment from a Class .................................................................. 299 
Setting the Dates for an Assignment....................................................................... 299 
Editing an Assignment............................................................................................. 300 

Class Resources ........................................................................................................... 301 
Resource Restrictions ............................................................................................. 301 
Uploading Resources .............................................................................................. 302 
Importing Resources ............................................................................................... 304 

Review ................................................................................................................................ 305 
Ask Yourself… .............................................................................................................. 306 

10. Content Management 307 
Review of Previous Chapter................................................................................................ 307 
Introduction ......................................................................................................................... 307 

Objectives .....................................................................................................................307 
Modules............................................................................................................................... 308 

Viewing the List of Modules .......................................................................................... 309 
Adding a Module ........................................................................................................... 310 
Adding/Creating a Post-test .......................................................................................... 314 
Removing a Post-test from a Module............................................................................ 316 
Deleting a Module ......................................................................................................... 317 
Editing Module Details .................................................................................................. 318 
Editing Module Content................................................................................................. 319 
Copying a Module ......................................................................................................... 319 
Launching a Module...................................................................................................... 320 

Content Objects .................................................................................................................. 320 
Viewing the List of Content Objects in a Module........................................................... 321 
Adding the First Content Object to the Index ................................................................ 322 
Adding Additional Content Objects to a Module............................................................ 324 
Reordering Content Objects.......................................................................................... 326 
Changing Hierarchy of Content Objects........................................................................ 327 
Removing Content Objects from a Module ................................................................... 328 
Previewing Content Objects.......................................................................................... 330 

Uploading Media ................................................................................................................. 330 
Uploading Media Files................................................................................................... 331 

Category Management........................................................................................................ 333 
Notes on Category Inheritance ..................................................................................... 333 
Adding Categories......................................................................................................... 334 
Editing a Category Name .............................................................................................. 334 
Deleting a Category ...................................................................................................... 335 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  x 

Copying a Category ...................................................................................................... 336 
Competencies ..................................................................................................................... 337 

What is a Skills Standard? ............................................................................................ 338 
Creating a Skills Standard File...................................................................................... 338 
Uploading a Skills Standard .......................................................................................... 339 
Assigning Competencies to Modules ............................................................................ 342 
Associating Questions with Competencies ................................................................... 344 
Viewing Competencies that have been Mapped to a Module ....................................... 344 
Disassociating Modules and Competencies ................................................................. 345 
Viewing Modules to which a Competency has been Mapped....................................... 347 
Manually Editing Skills Standards ................................................................................. 348 

To edit a skills standard:.......................................................................................... 348 
To add a new item to the skills standard: ................................................................ 348 
To add an item at a lower level in the skills standard hierarchy: ............................. 349 
To edit an item in the skills standard: ...................................................................... 350 

Inheriting Skills Standards to Sub-Organizations.......................................................... 351 
Copying a Skills Standard ............................................................................................. 352 
Importing Standards from Sub-Organizations............................................................... 353 
Deleting A Skills Standard............................................................................................. 354 
Competencies Reports.................................................................................................. 355 

Links Management.............................................................................................................. 355 
Notes on Links Inheritance............................................................................................ 356 
Adding Links.................................................................................................................. 356 

Glossary Management ........................................................................................................ 358 
Notes on Glossary Inheritance...................................................................................... 358 
Adding Glossary Terms................................................................................................. 359 
Viewing a Glossary Definition ....................................................................................... 360 
Editing a Glossary Definition ......................................................................................... 361 

Assignments........................................................................................................................ 362 
Creating an Assignment................................................................................................ 363 
Searching for an Existing Assignment .......................................................................... 368 
Editing an Assignment .................................................................................................. 369 
Copying an Assignment ................................................................................................ 369 
Deleting Assignments ................................................................................................... 371 
Managing Assignments................................................................................................. 372 

Review ................................................................................................................................ 372 
Ask Yourself… .............................................................................................................. 372 

11. Content Authoring 373 
Review of Previous Chapter................................................................................................ 373 
Introduction ......................................................................................................................... 373 

Objectives .....................................................................................................................373 
Introduction to Content Editing............................................................................................ 374 

XML Tags...................................................................................................................... 374 
Adding or Editing Text.........................................................................................................374 

Adding or Editing Text................................................................................................... 374 
The Navigation Hyperlinks ............................................................................................ 376 
Tips and Tricks.............................................................................................................. 377 

Content Object Types ......................................................................................................... 377 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  xi 

Formatting Text ................................................................................................................... 378 
Bolding (Emphasizing) Text .......................................................................................... 378 
Italicizing (Slanting) Text ............................................................................................... 379 
Changing the Font Size................................................................................................. 380 
Changing the Font Color ............................................................................................... 382 
Changing the Font Face................................................................................................ 384 
Adding a Header ........................................................................................................... 385 
Creating Bulleted Lists .................................................................................................. 386 
Creating Numbered Lists .............................................................................................. 388 
Adding Page Breaks ..................................................................................................... 389 
Adding Media Items ...................................................................................................... 391 
The Media Bank ............................................................................................................ 391 
Uploading Media Files................................................................................................... 391 
Adding a Media File ...................................................................................................... 392 
Referencing Multiple Media Items on One Page........................................................... 394 
Tips and Tricks.............................................................................................................. 396 
Linking to Glossary Terms ............................................................................................ 396 
Tips and Tricks.............................................................................................................. 398 
Linking to Sections ........................................................................................................ 398 
Linking to Other Modules .............................................................................................. 400 
Linking to External Applications .................................................................................... 401 
Linking to Websites ....................................................................................................... 403 
Adding Tests and Questions ......................................................................................... 404 
Searching for a Question .............................................................................................. 405 
Adding a Question to a Content Object......................................................................... 405 
Searching for a Test...................................................................................................... 407 
Adding a Test to a Content Object ................................................................................ 408 
Adding Automatically Converted Measurements .......................................................... 410 
Entering Measurements ................................................................................................ 411 

Adding Audio Narration Files .............................................................................................. 414 
Recording Speech Files ................................................................................................ 414 
Uploading a Speech File ............................................................................................... 415 

Content Editing Icons Quick Reference .............................................................................. 419 
Review ................................................................................................................................ 421 

Ask Yourself… .............................................................................................................. 421 

12. Test Authoring 422 
Review of Previous Chapter................................................................................................ 422 
Introduction ......................................................................................................................... 422 

Objectives .....................................................................................................................422 
Questions............................................................................................................................ 423 

Question Types ............................................................................................................. 423 
Generic and Non-Generic Questions ............................................................................ 423 
Creating Questions ....................................................................................................... 424 
Editing a Question......................................................................................................... 433 
Associating Questions with Competencies ................................................................... 434 
Inserting Questions into a Module................................................................................. 436 
Deleting Questions........................................................................................................ 436 

Tests ................................................................................................................................... 437 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  xii 

Creating a Test.............................................................................................................. 437 
Adding Questions to a Test........................................................................................... 438 
Inserting Tests into a Module ........................................................................................ 441 
Adding Tests to a Class ................................................................................................ 441 
Deleting a Test .............................................................................................................. 441 

Pre-Tests............................................................................................................................. 442 
Comparing the Pre-Test and Post-Test Results ........................................................... 442 

Review ................................................................................................................................ 442 
Ask Yourself… .............................................................................................................. 443 

13. Troubleshooting 444 
Introduction ......................................................................................................................... 444 
Class Management ............................................................................................................. 444 
Content Editing.................................................................................................................... 445 
Content Management and System Administration.............................................................. 449 
My Folder ............................................................................................................................ 450 
Other ................................................................................................................................... 451 

0609  Required System Configuration 



  
 

LearnMate v3.2 User Manual  xiii 
0609  Required System Configuration 



  
 

1 
Required System Configuration 

Introduction 
In this chapter, you will learn how your system must be configured to allow LearnMate to function 
properly. In addition to an appropriate operating system, LearnMate requires a number of 
multimedia applications to be installed – the installation of these is covered in detail. 

Objectives 
In this chapter, we will explore the following topics: 

• The utilities required by LearnMate 

• Installing the LM Agent 

• Installing required software 

• Using the Utility Check function 

• Installing required utilities 

• Disabling pop-up blockers 

Required Utilities 
LearnMate Content is displayed using the LM Content Viewer. LearnMate Content utilizes a 
variety of multimedia tools to enhance the learning experience. To prepare your computer for 
LearnMate Content, you need to ensure that the following applications are installed: 

• Windows 98, 2000 or XP operating system 

• Internet Explorer 6.0 or higher 

• LM Agent and Required Software 

• Macromedia Flash Player 9.0 or Higher. LearnMate Content modules are rich in interactive 
Flash animations that enrich the learning experience by giving you the opportunity to perform 
virtual hands-on experiments.  

• Java Virtual Machine 1.5.06 or Higher. Test questions are provided throughout LearnMate 
Content modules to help you measure knowledge of the materials taught. These questions 
incorporate Java technology. 
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• Acrobat Reader. Acrobat Reader is used to read all documentation provided with LearnMate 

products.  

LM Agent and Required Software 
LearnMate Content works in conjunction with ’s 3D simulation software to provide you 
with virtual hands-on learning experiences. When installed on your computer, the required 
simulation software can be launched and controlled directly from the LearnMate environment 
using the LM Agent.  

Installing the LM Agent 
The LM Agent enables you to operate external software directly from the LearnMate Content 
Viewer without having to leave the LearnMate system or access the Start menu. The LM Agent 
runs in the background until required by links in the modules. The LM Agent utilizes ActiveX 
technology.  

You are prompted to install the LM Agent on your computer the first time that you launch a module 
requiring the application’s use. 

To install the LM Agent: 

1. Launch a LM Content Module that requires external software. If the LM Agent is not already 
installed on your PC, you will receive the following message: 
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2. Click Confirm. The following message is displayed at the top of the page if you have Microsoft 

XP SP2 installed. 

 
3. Click on the message to begin the install and select Install ActiveX Control from the pop-up 

menu that opens. 

 
The LearnMate Agent – InstallShield Wizard opens, at the Welcome page. 

4. Click Next. 

 
The Choose Destination Location page is displayed. 
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5. To accept the default destination folder, click Next. If you click Change, you will be asked to 

select another folder. 

 
The Ready to Install the Program page is displayed. 

6. Click Install. 

 
The LearnMate Agent is installed. After installation, the InstallShield Wizard Complete page 
is displayed. 
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7. Click Finish. 

 
The InstallShield Wizard closes. A success message is displayed in the LearnMate window. 

8. Click Confirm to launch the module you selected in step 1, or Cancel to return to the Class Main 
Page. 

 

Installing Required Software 
When working a LearnMate Content module that requires integration with simulation and control 
software, the LM Agent will prompt you to install external software the first time you click a 
hyperlink that calls the software in the module. Proper installation of these applications will ensure 
that they work seamlessly from within the module. See Software Check on page 75 
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LearnMate Utility Check 
LearnMate offers several methods for checking whether applications are installed, as well as for 
enabling you to easily install these applications. 

• Utility Check Page: The Utility Check hyperlink – located both on the LearnMate login page 
and on the Class Main Page – enables you to quickly test whether the required applications 
are installed on your PC. From this page, you can install missing applications from either the 
Web or your local server. 

• Active System Check: Anytime LearnMate requires an external plug-in to display an object 
(e.g., Flash animation, Java applet, PDF file), LearnMate checks to ensure that the plug-in is 
installed on your PC. If the plug-in is not installed, you are prompted to do so. 

Utility Check Page 
Utility Check allows you to test for applications required by LearnMate Content. If the 
applications are not installed, the Utility Check page enables you to either download the 
application from the Internet or from the LearnMate server.  

The Utility Check may be accessed from the Login page or from any Class Main Page.  
See Performing a Utility Check on page 69. 

Accessing the Utility Check from the Login Page 
1. Open Internet Explorer. 

2. Enter the address you have been given for the LearnMate server in the Address field  
(e.g. http://www.learnmate.com or http://roothost). The LearnMate Login page is displayed. 

3. Click Utility Check in the Login to LearnMate LMS panel on the right side of the page. 
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The Utility Check page is displayed. 

 

Testing for the Required Applications 
1. To test for Macromedia Flash Player: 

� An animation should be playing in the Test column. If no animation is displayed, click the 
hyperlink in the Downloads column to install from the Internet. 

� Alternatively, click the hyperlink in the Local Server column to install from the LearnMate 
server. 

2. To test for Java: 

� A clock should be displayed in the Test column; its second hand should be moving. If the 
clock is not displayed, click the hyperlink in the Downloads column to install from the 
Internet. 

� Alternatively, click the hyperlink in the Local Server column to install from the LearnMate 
server. 

3. To test for Acrobat Reader: 

� Click the icon in the Test column. A PDF file should open in a separate browser window.  
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� If the file does not open, click the hyperlink in the Downloads column to install from the 
Internet. 

� Alternatively, click the hyperlink in the Local Server column to install from the LearnMate 
server. 

Checking the Server Version 
The Utility Check page is also used to show the version of the LearnMate server on which you are 
using. This information is important if you have any customer support questions. The first question 
an intelitek Customer Support engineer should ask you is which version of the product you are 
running.  

To determine the version: 

1. Look at the Version Information panel of the Utility Check window (at bottom). 

 
2. Note the LearnMate Version and Build listed in this section. 

Active System Check 
Any time that LearnMate requires an external plug-in to display an object (e.g., Flash animation, 
Java applet, PDF file), LearnMate checks to ensure that the plug-in is installed on your PC.  
If the plug-in is not installed, you are prompted to do so, as shown below. 

 
1. Click the message shaded in yellow at the top of the screen. A submenu is displaye. 

Note: The example shown is specific to the installation of Java and will vary per application 
requiring installation. 
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2. Select Install ActiveX Control from the submenu. Internet Explorer prompts you to install the 

application. The graphic shown below will vary depending on the application being installed. 

 
3. Click Install. The Installer begins the installation process.  

4. Select all defaults during the installation process. Once the installation process is complete, 
the object should display correctly. 

Pop-up Blocking 
LearnMate uses pop-up windows that may be blocked by your Internet browser or by software 
that may be installed on your computer. For LearnMate to function properly, you should prevent 
LearnMate pop-ups from being blocked. (Pop-ups from other sites will continue to be blocked.) 

Instructions for disabling Internet Explorer’s built-in pop-up blocker and for disabling the pop-up 
blocker supplied with the Google toolbar are presented below. 

Internet Explorer 
1. In Internet Explorer, select Tools > Internet Options. 

2. Click on the Privacy tab. 

 
3. If the Block pop-ups checkbox is selected, click Settings in the Pop-up Blocker panel. 

 
The Pop-up Blocker Settings window is displayed. 
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4. Type www.learnmate.com in the Address of Web site to allow field. (If you log on to LearnMate 

installed on a local server, type in the address of that server.) 

 
www.learnmate.com is added to the Allowed Sites list. 

 
5. Click Add, and then click Close to close the Pop-up Blocker Settings window.  

6. Click OK on the Privacy tab to close the Internet Options window. 

Google 
1. After browsing to www.learnmate.com, click the  icon on the Google toolbar. 

 
Google will no longer block pop-ups opened by LearnMate. 

Adding LearnMate as a Trusted Site 
With some versions of Internet Explorer, you may get the following ActiveX error message on 
each new LearnMate Content page.  
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To remove this message, but at the same time not compromise the security of your PC, you need 
to add the LearnMate server as a trusted site. This process must be performed on every PC in 
which the message appears. 

1. Login as an administrator to the PC receiving the message. 

2. Open Internet Explorer.  

3. In Internet Explorer, select Tools > Internet Options. 

4. Click on the Security tab. 

 
5. Click the Trusted Sites icon (the 3rd icon over in the window at the top of this page).  
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6. Click the Sites button. The Trusted Sites dialog box is displayed. 

 
7. Uncheck the Require server verification (https:) for all sites in this zone checkbox.  

8. In the Add this Web site to the zone: field, add the IP for your LearnMate server  
(e.g. http://www.learnmate.com or http://192.172.1.1).  

9. Click OK.  

The ActiveX message should no longer appear when navigating through LearnMate Content. 

Review 
In this chapter, we covered the following material: 

• The utilities required by LearnMate 

• Installing the LM Agent 

• Installing required software 

• Using the Utility Check function 

• Installing required utilities 

• Disabling pop-up blockers 
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Ask Yourself 
• How do you install the LearnMate Agent? 

• Can you use the Utility Check function to identify missing multimedia applications? 

• Can you install the multimedia applications required by LearnMate (Java, Flash and Adobe 
Reader)? 

• What happens if a missing application is required while viewing LearnMate Content? 

• What do you do if you receive an ActiveX message in the Content Viewer? 

• What do you do if pop-ups are blocked, preventing you from viewing LearnMate Content? 
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2 
Logging In 

Review of Previous Chapter 
In Chapter 1, we learned about: 

• The utilities required by LearnMate 

• Installing the LM Agent 

• Installing required software 

• Using the Utility Check function 

• Installing required utilities 

• Adding LearnMate as a trusted site 

• Disabling pop-up blockers 

Introduction 
In this chapter, we are going to register and log in to the LearnMate system. By the end of this 
chapter, you will be able to register for the system and modify your system profile. 

Objectives 
In this chapter, we will explore the following topics: 

• The Login page 

• Changing the System Language 

• Self-Registration 

• Usernames and passwords 
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The Login Page 

Introduction 
The LearnMate system is a members-only web environment, meaning that you must have a 
username and password for access. 

Inside the system, you can enroll in classes and take advantage of all their resources, including 
content modules, forums, chats, local mail, specialized glossaries and collections of Web links. 

The Login Page 

 
The first page of LearnMate, the Login page, provides the following features: 

• Login Facility: Enter your username and password to enter LearnMate. 

• Utility Check: Allows you to ensure that the applications required for running LearnMate 
successfully are installed on your computer. 

• Forgot Your Password: LearnMate will mail your password to you. 

• New User: Allows a new user to self-register, using a registration code supplied by the 
organization administrator. 

• Select Language: Allows you to choose the language in which you would like the login page 
of LearnMate to be displayed. 

Accessing LearnMate 
LearnMate is accessible from any Internet Explorer browser connected either to the Web or to a 
local LearnMate server. 

To view the LearnMate Login page: 

1. Direct your web-browser to http://www.learnmate.com,  

OR 
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2. If your organization has LearnMate installed on its own server, direct your web-browser to the 

IP address supplied by your Organization Administrator. 

The Login page is displayed. 

 
The default language for the system is English. To select a different language, use the Select 
Language drop-down list in the right-hand panel. 

 
The Login page is now displayed in the language you have selected. 
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Accessing the System 
There are two ways to access the system for the first time: 

• Self-registration, in which you choose your own username and password. To self-register, you 
must obtain a self-registration password from your Organization Administrator. 

• Typical access, in which your username and password are set by your Organization 
Administrator. 

Self-Registration 
Users can self-register to LearnMate, provided they are given a self-registration password. 

To self-register: 

1. Click New User on the Login page.  

 
The Self Registration page is displayed. 

2. Enter the password you were provided in the empty field. Then click Submit. 
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3. The Add User page is displayed. 

 
4. Fill in the First Name and Last Name fields. These fields are mandatory (as indicated by a *). 

5. Fill in the Middle Name and Mail fields, if desired. The Mail field is for the user’s regular mail 
address outside of the LearnMate system. 

6. Fill in the ID field, if desired. This field must consist only of numbers, and not more than 10 
digits long. 

7. Choose a unique username of four to nine characters. If you have requested a username 
which is already in use in the LearnMate database, you will be prompted to select a different 
one. Usernames may include numbers, but not accented characters or characters from 
non-Latin character sets. 

Note: A username cannot be changed once it has been registered in LearnMate. 

8. Enter a password in the Password and Verify Password fields. When choosing your password, 
consider the tips and tricks listed in the next section. When all fields are completed correctly, 
click Save. The LearnMate Login page is displayed. 

9. Log in using the username and password you defined in step 3. 
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Password Tips and Tricks 
• Your password must begin with a letter A-Z, and must be at least four and no more than twelve 

characters long. Keep in mind that your password is case sensitive. Apple is not the same 
password as apple. 

• To increase the security of your password, deliberately misspell a word and/or include 
numeric digits somewhere after the first digit. Homewerk and for2n are more secure 
passwords than Homework and fortune. 

• Do not use your username as your password. 

• Do not use the word “password” – it is the first password hackers check. 

• If allowed by your organization, you can change your password after you have logged into the 
system. For instructors and administrators, in particular, it is wise to change your password 
periodically. 

• Keep your username and password in a safe place. 

Logging in to the System 
You will now log in to the LearnMate system. 

1. Begin on the LearnMate Login page. See Accessing LearnMate on page 15. 

2. Enter your username in the Username text field. 

3. Enter your password in the Password text field. 

4. Click Go. 

 
5. If you have forgotten your password, click Forgot your password? You will be prompted to enter 

your mail address; if your email is part of your User Profile, your password will then be mailed 
to you. If it is not – or you do not have an email address, ask your instructor to either retrieve or 
overwrite your password for you. 

 
If you have entered your username and password correctly, the My Desktop page is 
displayed. This is your home base of operations. 

In the next section, we will explore navigation in the LearnMate environment. 
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Review 
In this chapter, we covered the following material: 

• The Login page 

• Changing the System Language 

• Self-Registration 

• Usernames and passwords 

Ask Yourself 
• Can you show another person how to log in to LearnMate? 

• Have you recorded your user name and password in a safe place? 

• Do you know what to do if you lose your password? 

• How do you change the System Language? 

 

LearnMate v3.2 User Manual  20 
0609  Logging In 



  
 

3 
Navigation Bar and Main Menu 

Review of Previous Chapter 
In Chapter 2, we learned about the following topics: 

• The Login page 

• Changing the System Language 

• Self-Registration 

• Usernames and passwords 

Introduction 
In this chapter, we will explore the Navigation Menu and the Main Menu, the parts of the My 
Desktop page which are always visible at the top and left of the browser window once you have 
logged into the LearnMate system. By the end of this chapter, you will view links and grades, use 
LearnMate’s built-in mail system, manage your LearnMate folder and be able to use your 
LearnMate calendar. 

Objectives 
In this chapter, we will master the following topics: 

• LearnMate Navigation 

• My Calendar 

• My Inbox 

• My Folder 

• My Profile 

• My Grades 

• My Favorites 
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Navigation 

Components 
Each page in LearnMate contains some or all of the following components: 

• Navigation Menu 

• Main Menu 

• Path Bar 

• Panels 

• Hyperlinks and Icons 

Navigation Menu 
At the top of each page is the Navigation Menu, consisting of two tabs which take you to two 
different sections of the LearnMate system, My Desktop and Catalog. These tabs are always 
visible. 

 
• My Desktop: Provides access to your personal learning organizer, containing all the tools 

required to manage your learning experience. This is the default and LearnMate always opens 
to this page. See My Desktop on page 61. 

• Catalog: Provides access to all the classes in the LearnMate system, enabling users to see 
all classes available to their organization, the modules included in each class, and an 
enrollment start and end date, where relevant. Where permitted by the organization, students 
can self-enroll in the classes of their choice. See Catalog on page 147. 

Path Bar 
The Path Bar always appears immediately below the Navigation Menu. The Path Bar of each 
submenu and page is color-coded according to the color of the corresponding Navigation Menu 
tab. The text inside the Path Bar reflects your present position within the tree-structured 
organization of pages within the LearnMate system. This helps you maintain your orientation as 
you navigate around the system. 

Panels 
Most of the pages in the LearnMate system are divided into separate panels. Most panels are 
distinguished by a title in the top bar. The header panels at the top of the page sometimes do not 
have a title. 
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Hyperlinks and Icons 
Located in appropriate places within the panels are text hyperlinks and pictorial icons which 
enable you to perform a variety of functions within the LearnMate environment. Because of the 
wide variety of tasks available to you, the system also provides Tooltip text to explain the function 
of the icons. Simply hold your mouse pointer over any icon for a second and the Tooltip text will 
appear in a little box by your mouse pointer. 

Main Menu 
The Main Menu is displayed at the left side of the page, providing quick access to many 
commonly used LearnMate pages. Like the Navigation Menu, it is always visible. 

 

See the following sections: 

• My Calendar on page 23 

• My Inbox on page 31 

• My Folder on page 42 

• My Profile on page 51 

• My Grades on page 54 

• My Favorites on page 57 

• Customer Support on page 59 

 

My Calendar 
My Calendar is one of the options available from the My Desktop menu. My Calendar enables 
you to record school or personal events, such as a lab, class, chat, or on-line session, that you do 
not want to forget.  

The My Calendar – Today’s Events panel on the My Desktop page displays the details of events 
scheduled for today. See My Desktop on page 62. 

As no events have been defined in your profile yet, your calendar is currently empty. You will now 
learn to add an event to your calendar. 
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Viewing the Calendar 
1. Select My Calendar from the Main Menu. The My Calendar page is displayed with today’s diary 

shown. 

2. To view the diary for a different day in the current month, click the required day in the calendar 
shown at the top right of the page. 

 
3. To change the month of the calendar display, click the right or left arrows in the month 

heading. 

 

Adding an Event 
Event is the term used to refer to items listed in a user’s My Calendar.  

To add an event to your calendar: 

1. Select the event’s date by doing one of the following: 

� Use the calendar at the top right of the display. 

OR 

� Click the  icon and select the date from the pop-up calendar. 
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Important Note: Dates and times are set according to the location of the LearnMate server. 
Therefore, if the LearnMate server resides in a different time zone from the end user, the 
dates and times should be set for the event accordingly. 

2. Enter the name of the event in the Event text field. 

3. Enter a description of the event in the Description text field. 

4. Select the type of event from the Event Type drop-down menu. This field is optional. 

 
5. Select the start and end times from the Start Time and End Time drop-down menus. 

 
6. Click Save. Your event is added to your calendar and appears in the diary for that day. 
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Viewing All Scheduled Events  
To see all scheduled events: 

1. Select My Calendar from the Main Menu. The My Calendar page is displayed, with today’s 
diary shown. 

2. Click View All Events. 

 
The All Events page is displayed, listing all events that have been scheduled with the most 
recent event listed first. 

 

Modifying Events 
You can modify the details of an event at any time. 

1. Open the All Events page as described in Viewing All Scheduled Events on page 26. 

2. Click the Edit icon  next to the event that you want to modify. The Event page is displayed. 

3. Make the necessary changes and click Save. 
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Deleting an Event 
Events can be deleted, either by clicking Delete in the Event page discussed above, or from the All 
Events page, as described below: 

1. Open the All Events page as described previously. 

2. Select the checkbox next to the event to be deleted. Multiple checkboxes can be selected. 

3. Click Delete. 

 
4. You will then be asked for confirmation.  

Important Note: This event will also be deleted from the calendars of all users you have sent the 
event to. 

Sending Events 
LearnMate allows you to add an event to another user’s calendar. Once an event is sent to 
another user, the user will be notified that an event has been added to their calendar and has the 
option of approving/declining the event. After an event has been sent, it should not be resent to 
the same users. 

To send an event to other LearnMate users:  

1. Select My Calendar from the Main Menu. 

2. Click View All Events. 

3. Select the checkbox of the event you wish to send. Click Send.  

 
The Send Event page for this event – showing the event’s details – is displayed. 
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4. Click the Choose User icon  to select the user to which you wish to send this event.  

 
The Search for User pop-up dialog box opens. 

5. Enter search parameters and click Search.  

 
Search results are displayed. 

6. Select the user(s) to which you wish to send this event by clicking the checkbox(s) to the left of 
the user’s name. 
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Note: To select or deselect all users at one time, select the Select All checkbox to the left of 
the text “Last Name”. 

7. Click Choose User. The dialog box closes and the user’s name appears in the Send to field. 

8. Complete the remaining fields and then click Send. 

 
The event has been sent to the user’s calendar. The event now appears in your calendar with 
the message: Pending Approval (1), where “(1)” indicates the number of users still to approve 
receipt and addition of the event to their own calendars.  

 
Once the user has approved the receipt of this event, the “Pending” message will be removed 
from your calendar and replaced with either an “Approved” or “Declined” message. 
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Approving/Declining an Event 
If another user scheduled an event and invited you, a message is displayed in red at the top of 
your My Calendar page You have 1 pending event(s).  

 
To view the event, and to accept or decline its addition to your calendar: 

1. Click View All Events. The All Events page is displayed. Approve/Decline is displayed under a 
pending event. 

 
2. Click the name of the pending event. The Approve/Decline Events page is displayed. 

 
3. To approve the event, click Approve. The All Events page is redisplayed. The event you 

approved is listed, without the Approve/Decline message. 

 
OR 

4. To decline the event, click Decline. The All Events page is redisplayed. The event you 
declined is listed, with the message Declined. 
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Note: At any time, you can click on an event to which you were invited and the Approve/Decline 
page is displayed, allowing to you to approve or decline the event. Thus you can approve an event 
after having declined it previously, or decline an event you previously accepted. 

My Inbox 
My Inbox is LearnMate’s internal mail system (IMS) that allows you to send and receive 
messages to and from other LearnMate users.  

LearnMate also uses My Inbox to generate notification messages automatically. For example, a 
student receives a message notifying him when his enrollment in a class has been approved. Or, 
an instructor receives a message when a student has submitted an assignment for evaluation. 

Viewing Your Inbox 
To view your Inbox: 

1. Click My Inbox in the Main Menu. The My Inbox page is displayed. Any messages you have 
are listed. New messages are listed in bold, while previously viewed messages are un-bolded. 

 

Opening a Message 
To open a message: 

1. Click on any of the entries in the line of the message.  
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The message is displayed. 

 

Composing a New Message 
To compose a new message: 

1. Click Compose from the My Inbox page. 

 
2. To select the user to which you wish to send this message, click To.  

 
The Search for User dialog box opens. 
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3. Enter search parameters and click Search.  

 
Search results are displayed. 

4. Select the user(s) to which you wish to send this message by clicking the checkbox to the left 
of the user’s name. 

5. Click Choose User. 

 
The selected names are added to the To field. 

 
6. To carbon copy (cc) additional users on the message, click Cc and repeat step 2. 
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7. Enter the subject of the message in the Subject field. 

 
8. To add an attachment to this message: 

� Click Attachments.  

 
The Attachments dialog box is displayed.  

 
9. Click Browse to search for the attachment you wish to add. The Windows Choose File dialog 

opens. 

LearnMate v3.2 User Manual  34 
0609  Navigation Bar and Main Menu 



  
 
10. Select the file to attach and click Open.  

 
11. Click Attach. 

 
The file name is displayed in the Attached Files panel. 

 
12. Click Close. The file name is displayed in the Attachments field.  
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Note: When you send an attachment, that attachment file is stored in your allocated space on 
the LearnMate server. The attachment file will be deleted only once you and the recipient have 
deleted the message that contains the file.  

13. Select the High Priority checkbox if the message is critical and you wish for it to be marked as 
such in the recipient’s Inbox. 

14. Write the body of the message. 

 
15. Click Send. The message is sent. 

Replying to a Message 
To reply to a message: 

1. Click Reply. 
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A Reply page is displayed, with the sender’s name automatically entered in the To field. 

 
2. Enter your reply in the large text field. 

Note: To add additional recipients to this message, you may click the word To or Cc. 

3. Click Send. The message is sent and the My Inbox page is displayed. 

Forwarding a Message 
To forward a received message to others: 

1. Click Forward. 
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The Forward Message page is displayed. 

 
2. To select the user(s) to which you wish to send this message, follow the instructions for 

selecting users in Composing a New Message on page 32. The selected users are added to 
the To field. 

3. Click Cc and repeat step 2 to carbon-copy other users. 

4. Make whatever changes are necessary to the body of the message. 

5. Click Send. The message is forwarded and your Inbox page is displayed. 

Deleting a Message 
Messages can be deleted in two ways: 

1. From My Inbox, select the checkbox of the message(s) to be deleted. 

2. Click Delete. 

 
Note: You can delete multiple messages at a time by selecting more than one checkbox. 
Alternately, you can select all messages in your Inbox by selecting the Select All checkbox to 
the left of the From column title. 

OR 

3. Open the message so that it is displayed in the View Message page. 
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4. Click Delete. 

 
5. Confirm the deletion of the message. 

Saving a Message 
Messages are saved in the Inbox until they are deleted. However, to organize your messages 
efficiently, you may want to separate your old messages from new ones, or delete all messages 
except for those with particular importance. For this reason, the Saved Mail folder is provided. 

To move a mail message from your Inbox to the Saved Mail folder: 

1. Click Inbox. The contents of your Inbox are shown. 

 
2. Select the message(s) to save. 

3. Click Save. 
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The message is removed from the Inbox and moved to the Saved Mail folder. 

 
4. Click Saved Mail to view the saved message. 

 

Viewing Sent Mail 
Once you have sent a message, the message is automatically saved in the Sent Items folder. 

To view sent mail: 

1. Click Sent Items. The Sent Items folder is displayed, listing all messages that you have sent. 

 
2. To delete a message from the Sent Items folder, check the checkbox next to the message and 

click Delete. 
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3. To save a message to the Saved Mail folder, check the checkbox next to the message and 
click Save. The message will be moved from the Sent Items folder to the Saved Mail folder. 

 

Viewing Saved Mail 
You have learned that messages from the Inbox and Sent Items folder can be saved to the Saved 
Mail folder. 

To view the Saved Mail folder: 

1. Click Saved Mail. All saved messages are displayed. 

 
2. To open a message, click either the name of the sender, the subject or the date of the 

message. 
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4. To delete a message, select the message to delete and click Delete. 

 

My Folder 
My Folder is your personal space on the LearnMate server where you can store your own files.  
My Folder enables you to upload work files (e.g., robotic programs, NC files, ladder diagrams, 
Word files) for use from any PC which has access to the LearnMate server. The space available to 
each user is defined by an administrator. 

Opening My Folder 
1. Click My Folder in the Main Menu. The My Folder page is displayed. 

 
By default, My Folder opens to the main folder (or directory), called My Folder. My Folder 
contains a subfolder for each module and assignment that you are enrolled in. The contents of 
the open directory in My Folder are displayed in the right panel. 
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2. To view the contents of a subfolder, simply click on the subfolder of interest. 

 

Adding a File to My Folder 
1. Click My Folder in the Main Menu. 

2. If you do not want to save the file in the default folder, select the subfolder to which you wish to 
save the file. 

 
3. Click Add. 

 
The Upload pop-up window is displayed. Up to three files can be uploaded at once. 
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4. Next to the File 1 field, click Browse. The Choose file dialog box is displayed. 

 
5. Select the file to upload from your hard disk or network drive and click Open.  

 
The file name and location is now displayed in the File 1 field. 

6. Repeat the process for Files 2 and 3, if required. 

7. Click Upload Files.  
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The files are uploaded and the Upload pop-up window is closed. The file you uploaded is now 
listed in the right panel of the My Folder page. 

 

Viewing a File in My Folder 
To open a file from My Folder: 

1. In the My Folder page, click the View File icon  to view the file.  

 
The file is opened by the relevant application in a separate browser window. For example, if 
the file is a Word file, the file will be displayed in Word, within a web browser window, as 
shown. 

 

LearnMate v3.2 User Manual  45 
0609  Navigation Bar and Main Menu 



  
 

Note: In order to view a file from My Folder, the software program required to view that file 
type (e.g., Microsoft Word for DOC files, Microsoft Excel for XLS files, Adobe Reader for PDF 
files) must be installed on your PC. 

Downloading a File from My Folder 
In some instances, you may wish to upload a file at school or work that you wish to work on at 
home, or vice versa. This requires you to upload the file from one location, and then download it 
onto another PC. 

To download a file from My Folder to your computer. 

1. In the My Folder page, click the View File icon  to view the file.  

 
The file is opened by the relevant application in a separate browser window.  

Note: In order to view a file from My Folder, the software program required to view that file 
type (e.g., Microsoft Word for DOC files, Microsoft Excel for XLS files, Adobe Reader for PDF 
files) must be installed on your PC. For example, if the file is a Word file, the file will be 
displayed in Word, within a web browser window, as shown. 

 
2. Click File in the Main Menu of the application. 

3. Select Save As from the drop-down menu. The Save As dialog box is displayed. 

4. Locate the folder on your hard drive where you would like to save the file, from the Save in 
drop-down menu. 

5. Enter the name you would like to save the file under in the File Name field. 
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6. Click Save. The file is saved to your computer.  

Deleting a File from My Folder 
To delete a file from My Folder: 

1. In the My Folder page, click the folder/subfolder from which you wish to delete files. 

2. Select the checkbox next to the file(s) to be deleted. 

3. Click Delete. 

 
4. Confirm the deletion of the file in the dialog box that opens. The file is deleted. 

Creating a New Subfolder 
LearnMate allows you to create subfolders within My Folder. This hierarchy can only extend to 
one level below the original folder, and it is not possible to create sub-subfolders. 

To create a new subfolder in My Folder: 

1. Click Create at the bottom of the left panel of the page.  

 
The Create New Folder pop-up dialog box is displayed. 
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2. Enter the name of the new folder you wish to create. 

 
3. Click Save. The new folder is displayed on the My Folder page. 

 
Note: If you are enrolled or teaching any classes that have assignments in them, a subfolder is 
automatically added to My Folder containing all of the User and Reference files required for that 
assignment. 

Moving a File to a Different Folder 
LearnMate allows you to move files from folder to folder within My Folder: 

1. In the My Folder page, select the checkbox next to the file to be moved. 

 
2. Click Move to folder. The Move to Folder dialog box is displayed. 
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3. Select the folder to which to move the file from the Folder Name drop-down menu. 

 
4. Click Save. After confirming the action, the file is moved to the selected folder. 

 

Deleting a Subfolder 
Folders can only be deleted if they are empty. If a folder is not empty, LearnMate will tell you that 
the folder cannot be deleted. 
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To delete an empty folder: 

1. Click the folder to be deleted. 

 
2. Click Delete. You will be asked to confirm your decision to delete the folder. 

 
3. Click OK. The folder is deleted. 
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Assignments and My Folder 
Assignment files uploaded by students and instructors are stored within My Folder (see 
Assignments on page 107). When a user uploads his or her first file for an assignment, a new 
folder is created (with the same name as the Assignment), and the file is saved there, as are all 
subsequent files uploaded for that Assignment. Assignment files count towards one’s allocated 
space on the server. 

 

My Profile 
My Profile is one of the options available from the Main Menu panel at the left of the page. My 
Profile contains all your personal details and contact information, and provides tools that enable 
you to edit your personal details, and change your system password.  

You will now use the Edit tool in the My Profile page to update the details that you entered when 
you registered (or were registered) with the system.  

Modifying My Profile and Changing your Password 
The LearnMate system allows you to edit all information about yourself in My Profile except your 
username, which cannot be changed at all, and your picture, which can only be changed by an 
instructor. 

1. Click My Profile in the Main Menu.  

 

LearnMate v3.2 User Manual  51 
0609  Navigation Bar and Main Menu 



  
 

The My Profile page is displayed, showing your personal details. 

 
2. Click Edit. Your My Profile page is refreshed to display text fields for each of the entries. 
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3. Enter or update your personal details.  

Note: Fields indicated with an asterisk (*) are mandatory and must be completed. 

4. When you have finished modifying the information, click Save. 

Note: Click Back to exit without saving your changes. 

5. To change your password, click Change Password.  

 
Note: This option may not be available for all students. Administrators have the option of 
disabling this option for their organizations. In this case, the password can only be changed by 
an administrator. 

In a new pop-up window, you will be prompted to enter your old password, and then your new 
password, which must be entered twice for confirmation purposes. 

 
6. After entering your new password, click Submit. The following message is displayed, indicating 

that you will now be logged out of the system and you must now log in with your new 
password. 

 
7. Click OK to submit the password change or Cancel to return to the Edit Profile page.  

If you clicked OK, you will receive a “Your password has changed.” confirmation and the 
LearnMate Login page is displayed.  

If you clicked Cancel, you are returned to the Edit Profile page. 
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My Grades 
My Grades is one of the options available from the Main Menu. My Grades enables you to track 
your progress through your enrolled classes and related grading activities. The grades that you 
have received for each class that is in progress, or that you have completed, are displayed. 

My Grades displays grades for different aspects of the learning experience, such as module 
grades, class tests, assignments, additional grades (e.g., homework, participation, projects), as 
well as a final grade. Most of these grades are automatically imported into the gradebook by the 
system, but some can also be modified manually. 

Until you have begun to actively study in LearnMate and have proceeded through a grading 
activity, your My Grades page will be empty.  

Note: My Grades is only active for LearnMate students. This menu option is disabled for 
instructors, who can instead access grades for the classes they are leading through other options 
mentioned later in this manual. 

Viewing My Grades 
1. Select My Grades from the Main Menu. The My Grades page is displayed, showing a list of 

the classes in which you are enrolled. 

2. Click the View icon  next to the class for which you wish to view your grades. 

 
The Grades page for that class is displayed. The Grades page lists the grades received for all 
modules, class tests, assignments and additional grades. Class tests and module tests are 
listed with their relevant details. For example, in the graphic below, the grades a student 
obtained for a class test called Math Test Basic are shown.  
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The following points can be seen: 

� The test was taken twice. On his first try, the student scored 0. On the second try, the 
student scored 100. 

� The final grade was 100, as the instructor specified that only the best score would count. 

� The weighting of this test in the calculation of the final class grade is 20%. 

 
Note the following: 

� Clicking the View icon  next to a test opens a preview page, which cycles through all the 
test questions, showing the question, your answer, the correct answer and feedback. 
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� Clicking the View icon  next to an assignment opens the View User Assignment page. 
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My Favorites 
My Favorites is one of the options available from the My Desktop menu. My Favorites enables 
you to add links to sites on the Web that interest you. These links are available for your use only, 
as opposed to system links that are available to all users. 

My Favorites is similar to the Favorites available to you in Internet Explorer. The advantage, 
however, of LearnMate My Favorites is their portability. Anywhere that you have access to 
LearnMate, you will have access to your favorite links, as opposed to Internet Explorer favorites 
that are only available from the PC on which they were saved. 

Adding Links to My Favorites 
You will now add a link to your LearnMate My Favorites. 

1. Select My Favorites from the Main Menu. As no links have been defined yet, this page is empty. 

 
2. Click Add. The Add New Favorite page is displayed. 

3. Enter a name for the link in the Name text field. 

4. Enter the URL (address of the site on the World Wide Web) in the URL text field. 

5. Enter a description of the link in the Description field. 

6. Click Save. 

 
Your link is added to your My Favorites page, and is now displayed. 
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7. Click on the name of the link to open that Web page in a new browser window. 

By opening the link in a new window, you can browse the linked site without interrupting the 
learning experience. When you have finished, you can close the browser window and return to 
your original place in LearnMate. 

Modifying Links in My Favorites 
To edit a favorite that you added: 

1. Select My Favorites from the Main Menu. All links that you have defined are displayed. 

2. Click the Edit icon  next to the link you wish to modify. The Edit page is displayed, with the 
same text fields as the Add New Favorite page. 

 
3. Make the necessary changes and click Save. 

4. To return to the My Favorites page without saving, click Back. 
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Deleting Links from My Favorites 
To delete a link from My Favorites: 

1. Select My Favorites from the Main Menu. All links that you have defined are displayed. 

2. Select the checkbox next to the link(s) that you want to delete. You can select multiple links for 
deletion by selecting multiple checkboxes. 

Note: Clicking the Select All checkbox in the upper left-hand corner of the header (to the left of 
the Link column head) selects all checkboxes in the list; alternatively de-selecting this 
checkbox de-selects all checkboxes in the list. This method can be used with all lists in 
LearnMate. 

 
3. Click Delete. The selected link(s) is deleted. 

Customer Support 
In the middle of the Main Menu are the mail address and the telephone number of your 
LearnMate Customer Support. 

Mail 
You can use the LearnMate system to send mail to Customer Support. This mail does not go 
through the internal LearnMate system, but out through the regular Internet. 

In the Main Menu, click on the mail address provided. This opens a new mail message using your 
own regular mail server. Compose and send your message the way you would compose any 
ordinary mail outside of the LearnMate environment. 
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Review 
In this chapter, you learned how to use the following features, accessible from the Main Menu: 

• LearnMate Navigation 

• My Calendar 

• My Inbox 

• My Folder 

• My Profile 

• My Grades 

• My Favorites 

Ask Yourself 
• Can you maintain a list of favorite URLs in My Favorites? 

• Can you add, remove, send and accept or decline events from My Calendar? 

• Can you use the Inbox function to communicate effectively with other LearnMate users? 

• Can you view your grades? 

• Can you manage files in My Folder? 

• Can you change information in your profile? 

• Do you know how to contact your Organization Administrator? 
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4 
My Desktop 

Review of Previous Chapter 
In the previous chapter, you learned about the options listed in the Main Menu panel at the left 
hand side of the My Desktop page. You will now be introduced to the main area of this page.  

In the previous chapters, you registered with LearnMate, and logged into the system for the first 
time. You saw that the Navigation Menu at the top of the page and the Main Menu at the side 
enable you to navigate the LearnMate environment. 

After learning how to navigate through LearnMate, you began exploring My Desktop, one of the 
options from the Navigation Menu. You then reviewed the various options available from the 
Main Menu, which is located on the left side of every LearnMate page.  

You saw that: 

• My Profile enables you to view and modify your personal details, and change your system 
password. 

• My Grades enables you to view your scores for LearnMate modules, assignments, tests and 
other graded activities. 

• My Favorites allows you to manage a list of your favorite websites from any location with 
access to your LearnMate server. 

• My Calendar allows you to schedule appointments, and to invite others to events. 

• My Inbox allows you to send messages to, and receive messages from, other users. 

• My Folder allows you to save files in a personal folder on the LearnMate server, and to 
access them at any time. 

Objectives 
In this chapter, we will explore the following topics: 

• The Header Section: Provides basic information about the class, including the instructor 
name and the schedule. See Header Panel on page 68. 

• Modules: Lists and provides access to the class modules, and provides access to module 
resource files. See Modules on page 70. 

• Students: Lists the class students, and enables you to send messages and event invitations 
to other students. See Students on page 77. 
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• Chats and Chat Management. See Chats on page 82. 

• Forums and Forums Management. See Forums on page 91. 

• Class Tests: Lists and provides access to the class tests that have been set. See Class 
Tests on page 102. 

• Assignments: Lists and provides access to class assignments. See Assignments on page 
107. 

• Class Resources: Lists and provides access to class resource files. 

My Desktop 
My Desktop is the main viewing area of the LearnMate environment. It is found to the right of the 
Main Menu and below the Navigation Menu. Unlike the Main Menu and Navigation Menu, 
which are permanent, this area changes depending on the activity you are currently working on. 

My Desktop is your personal learning organizer and the first page accessed upon successful 
login. You can return to this page at any time by clicking on the My Desktop tab in the Navigation 
Menu.  

The My Desktop page consists of the following four panels: 

• My Classes: This panel lists all the classes in which the student is enrolled or alternately, the 
instructor is teaching, depending upon the role of the user. Clicking on a class takes you to the 
Class Main Page for that class. See The Class Main Page on page 64. 
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• Organization Chats: Lists the chats that have been established for your organization. 

Organization Chats enable students and instructors from various classes to convene in one 
chat that is not dedicated to any particular class. This feature is particularly useful in providing 
a collaborative environment for all teachers in an organization, or students who participate in 
various extracurricular activities (e.g., FIRST, SkillsUSA). Organization Chats work the same 
way Class Chats work. To learn how to use chats, see Chats on page 82. 

 
• Organization Forums: Lists the forums that have been established for your organization. 

Organization Forums enable students and instructors from all classes within your organization 
to post and monitor a forum that is not dedicated to any particular class. Organization Forums 
work the same way Class Forums work. To learn how to use forums, see Forums on page 91. 

 
• My Calendar – Today’s Events: Lists events scheduled in your calendar for the current day. 

See My Calendar on page 23. 
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The Class Main Page 

Introduction 
All study in LearnMate is done in the framework of a class. A class can be defined as a group of 
students who are collectively managed by a single instructor, assigned the same or similar 
content (e.g., modules, assignments, tests), and are graded according to the same grading 
structure and requirements.  

Each class in LearnMate is accessed from its dedicated Class Main Page, which acts as the 
class “dashboard”. This page contains all the necessary tools for users to manage and navigate 
their learning experience. 

• For a student, the Class Main Page contains all the information and controls required to 
participate in the class.  

• For an instructor, the Class Main Page contains all the information and control required to 
manage the class. 

Important Note: The instructions in this chapter relate solely to student use of the Class Main 
page. More in-depth class management information for instructors can be found in the Class 
Management chapter, starting on page 253. 

Viewing the Class Main Page 
The Class Main Page for each class is accessible from My Desktop.  

To open the Class Main Page for a class: 

1. Click My Desktop. A list of all classes that you are enrolled in (student user), or all the classes 
that you are instructing (instructor/administrator user), is displayed in the My Classes panel. 

2. Click on the name of the class of interest. 

 
The Class Main Page for that class is displayed. 
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Page Layout 
The Class Main Page consists of the following panels: 

• Header: This panel lists the Instructor. It also provides access to your other classes, the 
Utility Check, the Schedule (for Laboratory classes) and a convenient link for sending mail to 
the instructor. See Header Panel on page 68. 

 
• Modules: This panel lists the modules that make up the class. From this panel, you can 

launch modules, define delivery options for both the module and its related quizzes and tests, 
view module resources and perform software checks. See Modules on page 70. 

 
• Students: This panel lists all the students taking this class, and provides functionality for 

interacting with other class students through class events and the Inbox. You can view 
student grades from this panel, as well as manage module enrollments on a per student basis. 
See Students on page 77. 
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• Chats: This panel lists all the chats that are available to the class, enabling users to launch 

chats. Chat Managers can also archive and manage chats from this panel. See Chats on 
page 82. 

 
• Forums: This panel lists all the forums available to the class, enabling all users to participate 

in the existing class forums. Forum Managers can also create, manage and delete forums, as 
well as edit particular threads in the forum, from this panel. See Forums on page 91. 

  
• Class Tests: This panel lists all the tests that have been scheduled for the class, including 

their current status for the logged-in user (In Progress, Expired, Completed). Students can 
launch tests that are currently “in progress”. Instructors can define delivery options for those 
tests. See Class Tests on page 102. 

 
• Assignments: This panel lists all the assignments that have been scheduled for the class, 

including their current status for you (In Progress, Expired, Completed). See Assignments on 
page 107. 
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• Class Resources: This panel lists all the class resource files that the instructor has uploaded 

for the class and made available. See Class Resources on page 124. 

 
You will learn about each of these panels in more detail in the following sections. 

Header Panel 
The Header panel is the panel at the top of the page with no title in its top bar. 

Viewing the Class Main Page of Another Class 
The Change Class drop-down list includes all classes in which you are enrolled or teaching. To 
switch to the Class Main Page of another class in which you are enrolled, select the class of 
interest from the Change Class drop-down list.  

 
The Class Main Page for that class is displayed. 

Contacting your Instructor 
If you need to contact your instructor outside of class hours, you can use the LearnMate internal 
mail system. Click on the Mail to Instructor icon  to the right of the instructor’s name. This takes 
you directly to the Mail page. Follow the procedure given in Composing a New Message on 
page 32. 
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Performing a Utility Check 
LearnMate requires three external programs – Macromedia Flash™, Acrobat Reader™, and 
Java™ Virtual Machine – to display various media types used by the system content. Utility 
Check enables you to check whether these programs are installed on your PC. 

In the top panel of any Class Main Page, click Utility Check. 

 
Refer to LearnMate Utility Check on page 6 to review how this feature works. As you may 
remember, this feature is also available from the Login page. 

Viewing a Schedule (Laboratory Classes Only) 
LearnMate includes two types of classes – Laboratory and Virtual classes, where the primary 
difference between the two is that lab classes can include a rotational schedule. A rotational 
schedule indicates when each student will study each of the class modules. 

Generated by the instructor, rotational schedules are created based on the following parameters:  

• Number of students in the class 

• Number of rotations per class (times that students will move from one module/hardware 
station to another) 

• Module prerequisites 

• Maximum number of students allowed per module 

• Student-to-student restrictions (preventing one named student to work with another named 
student) 

To view a class schedule: 

1. Click Schedule in the header panel of the Class Main Page. This option is only available for 
Laboratory classes. If the class is Virtual, the scheduling feature is not relevant and the 
hyperlink does not appear. 
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The Schedule page is shown. If the instructor has generated a schedule, it is displayed here.  

 
2. The Schedule can be sorted according to Module or according to Student. Make the 

appropriate selection in the Sort by drop-down list. 

3. Click Back to return to the Class Main Page. 

Modules 
The Modules panel lists all modules that make up the class. In this section you can: 

• Launch a module 

• View the Module Resources associated with a particular module 

• Perform a Software Check for the software required by each module 
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Launching a Module 
To launch a module: 

1. In the Modules panel of the Class Main Page, click the Launch icon  next to the relevant 
module.  

 
Note: If the module includes a pre-test, the Pre-Test icon  appears next to the name of the 
module in the Modules panel and the Launch icon  appears disabled . Before you can 
launch the module, you must first click the Pre-Test icon  and take the test. (See Tests and 
Questions on page 138.) After you complete the test, the Pre-Test icon disappears and the 
Launch icon  becomes active. 
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The module is launched in a new web browser window, known as the Content Viewer. To 
learn more about viewing LearnMate Content modules, see Viewing LearnMate Content, 
starting on page 127. 

 

Module Resources 
Instructors may upload files to be associated with a module. Examples of such files could include 
user manuals, solution files, PowerPoint presentations, worksheets and more. Students can open 
files directly from the Resources page, or download them to their own computers.  

Each module has its own Resources page, which lists available files associated with that 
particular module. 

Note: The class in general has its own resource page, which behaves in much the same way as 
the Module Resources page. Class Resources are designated to include files that relate to the 
class as a whole, such as safety rules, class regulations, syllabi and more. For more information, 
see Class Resources on page 124. If you have difficulty locating a particular resource, try the 
Class Resource page and the Resources page of each of the other modules in your class. 
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Viewing a Module Resource 
To view resources associated with a module: 

1. In the Modules panel of the Class Main Page, click the Module Resources icon  next to the 
relevant module. 

 
The Resources page is displayed, with all available resource files listed. 

 
2. Click the name of the resource file you would like to open. 

 
The resource file will be opened in a separate window, using the appropriate program, such as 
Microsoft Word. 

Note: In order to view a resource file, the software program required to view that file type (e.g., 
Microsoft Word for DOC files, Microsoft Excel for XLS files, Adobe Reader for PDF files) must 
be installed on your PC. 

3. To save the file, use the Save functionality in the software program used to view the resource. 
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Saving a Resource File 
As an alternative to saving a resource file from the software in which it opens, you have the option 
to save it to your own computer directly from LearnMate. 

To save a resource file: 

1. Right-click on the name of the resource file.  

2. Select Save Target As… from the right-click pop-up menu. 

 
The Windows Save As pop-up window is displayed. 

3. Browse to the folder in which you would like to store the file and click Save.  

 
The file is saved. 

4. Alternatively, once you have opened the file directly from LearnMate, you can save the file 
through the application used to open it.  
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Software Check 
Many LearnMate modules make use of software programs to provide the student with “virtual 
hands-on” simulated experience with software relevant to the technology taught by the module, or 
to provide students with a control interface with a hardware component used in the module. 
Examples include: 

• CAD 

• CAM 

• Computer Integrated Manufacturing (CIM) 

• CNC 

• Flexible Manufacturing Systems (FMS) 

• Hydraulics 

• Programmable Logical Control (PLC) 

• Pneumatics 

• Process Control 

• Robotics 

The LearnMate Software Check function enables you to check whether the correct version of the 
software required by the module is properly installed on your PC, and to install it, before even 
launching the module. 

Note: This procedure is similar to the Utility Check described in LearnMate Utility Check on 
page 6, but it checks for module-specific software.  

To perform a software check: 

1. In the Modules panel of the Class Main Page, click the Software Check icon  next to the 
relevant module. If the icon is disabled ( ), the module does not require specific software.  

 
Note: This check can be performed at any time, even if you have not yet taken the pre-test or 
are not yet allowed to launch the module due to prerequisites.  
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The LearnMate Software Check Wizard opens in a new window. A list of software programs 
required for the module is displayed in the Application Name column. The Current Version 
column indicates whether the required software is Installed or Not Installed, as well as the 
version of the software that is installed. 

 
2. If the Current Version column indicates that the required software programs are Installed, you 

do not need to install anything. Click Cancel to return to the Class Main Page. If the Current 
Version column indicates that one or more software programs are Not Installed, proceed to 
Step 3. 

3. Click Next. The LearnMate Check Wizard opens with a list of programs required by the 
module, indicating which are installed and if installed, the version that is installed. 

 
4. Click Next. The installation file is downloaded to your computer and the software setup 

program is launched. 
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5. Follow the instructions in the setup program to complete installation. To open printable 

installation instructions specific to each software application, click the Help button in the 
LearnMate Check Wizard. 

 
Note: If you launch a module which requires software that is not yet installed, you will be 
prompted to install it at the first page in the module.  

Students 
The Students panel allows you to view a list of your classmates and to interact with them via mail 
and the Calendar of Events. 

Scheduling an Event 
The Event hyperlink in the Students panel enables you to schedule an event for your class (or for 
specified students within the class). Such an event may be a study group meeting, a class lecture 
or an excursion, for example. When you schedule an event, the event will automatically be added 
to the My Calendar for each selected student. An event should not be resent to a user to whom 
the event has already been sent. 

To schedule an event: 

1. Check the checkboxes next to each of the students that you would like to invite to the event. 
To quickly select or deselect all students, click the Select All checkbox.  
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Note: The checkbox next to your own name is disabled. The event appears in your My 
Calendar page automatically. 

 
2. Click Event. The Send Event page is displayed. All students you selected appear in the Send 

to field. 

Note: To edit the list of names in this field, you must return to the Class Main Page and 
change your selection of checkboxes. You cannot edit this field directly. To send events to 
users outside of your class, you must do so via the My Calendar feature discussed in the 
Sending Events section of the previous chapter on page 27. 

 
3. Enter the name of the event in the Event field. This field is mandatory. 

4. Enter a description of the event in the Description field. This field is optional. 
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5. Select the event type from the Event Type drop-down menu. This field is optional. 

 
6. The Date field is mandatory. To enter data in this field, you must use the Calendar icon . 

It is not possible to edit this field directly. To set a date for the event: 

� Click on the Calendar icon  next to the Date field. A pop-up calendar is displayed. 

 
� Click the date on which the event will take place. The date is automatically entered in the 

Date field.  

 
7. Set the Start Time and End Time, using the drop-down menus. 
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Note: The default times are 12:00 AM (midnight). If you do not set the actual start and end 
times for the event, it will appear at midnight. Dates and times are set according to the location 
of the LearnMate server. Therefore, if the LearnMate server resides in a different time zone 
from the end user, the dates and times should be set for the class accordingly. 

8. Click Send. The event is automatically entered in the selected students’ calendars, as well as 
your own. The Class Main Page is displayed.  

Accepting or Declining an Event Invitation 
If an instructor or fellow classmate has invited you to an event, at the top of your My Calendar 
page, you will see the message, You have 1 pending event(s). To learn how to accept or decline 
such a request, see Approving/Declining an Event on page 30. 

Sending a Mail Message 
The Students panel enables you to easily send a mail message to your class or to specified 
students within the class.  

To send a mail message: 

1. Check the checkboxes next to all students that you would like receive the message. To quickly 
select all students, click the Select All checkbox.  

2. Click Mail.  
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The Mail page is displayed. The list of all students you selected appears in the To field. 

 
3. Complete the remaining fields. See Composing a New Message on page 32 for more 

information on composing a mail message in LearnMate. 

 
4. Click Send. The message is sent to the selected students’ Inboxes. The Class Main Page is 

displayed. 
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Chats 
Chats is one of the options available from My Desktop and from each of the Class Main Pages. 
Chats enable you to instantly communicate with other users in your organization or class. Chats 
may be used for the following: 

• To allow a student to obtain live help from a remote instructor. 

• To enable students to collaborate on assignments in real-time. 

• To facilitate a class discussion. 

• To enable students to submit questions to a guest moderator. 

When you join a chat, your name is added to the list of chat participants displayed in the left-pane 
of the chat window, and you can contribute messages to the chat, or simply read the messages 
being posted by other users. 

Note: A new chat may be set up by a Organization Administrator or a class instructor. This person 
can serve as the Chat Manager, or appoint a student to that role. See Chat Manager on page 87. 

Joining a Chat 
1. In the Organization Chats panel of the My Desktop page, or in the Class Chats panel of the 

Class Main Page, click the Launch Chat icon  next to the name of the chat that you would like 
to join. 

 

LearnMate v3.2 User Manual  82 
0609  My Desktop 



  
 

The selected chat is displayed, and your name is added to the Participants list on the left. 

 
2. Contribute messages to the chat by typing messages in the Type Here text field at the bottom 

of the chat window. Your text will appear in the Chat area. Text submitted by other users will 
also be displayed in the Chat area. Messages are shown in chronological order. The 
submitter’s name is shown in <brackets>. 
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Saving a Chat to a Local File 
A user can save the text of an open chat to a file on his computer. This is useful for a student who 
would like to save the contents of a chat for viewing later, after the chat has ended.  

To save a chat to a local file: 

1. Click Save to Local File at the bottom of the chat window. 

 
The Save Chat Log page is displayed. 

2. Make any changes to the text, if required. 

3. Click Save. 

 
The Windows Save HTML Document pop-up window is displayed. 

4. Locate the folder in which you would like to save the file. 

5. Change the file name in the File name field, if required. 
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6. Click Save. 

 
The Windows Save HTML Document pop-up window is closed. This file can then be opened 
using any word processor, or the Windows Notepad program. 

 

Viewing Archived Chat Sessions 
Chat sessions can be saved by the Chat Manager or the Instructor for later reference by any 
student in the class. 

To view a chat session that has been archived: 

1. Launch the chat of interest. 

 
The Chat window is displayed. 

2. Click View Archive at the bottom right of the chat window. 
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Note: The Chat Manager and the Instructor can also reach the View Archive page by clicking 
the Archive Chat icon  in the Chats panel of the Class Main Page. 

 
The View Archive page is displayed, listing all archived sessions that have been saved for 
that chat. 

 
The Chat Manager sees additional controls: the Edit icon , the Delete button and its 
associated checkboxes. 

 
3. Click the Print Preview icon  next to the name of the archived session you want to view. 

 
The chat session is displayed in a new pop-up window. 
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4. Click Print to print the chat, or Close to close the archive. 

Chat Manager 
Any member of the class can be appointed to serve as Chat Manager, including a student. The 
Chat Manager has certain rights and responsibilities. A student Chat Manager sees two additional 
icons adjacent to the name of the Chat: Edit Chat and Chat Archives. 

 

Editing a Chat (Chat Manager Only) 
To modify chat details: 

1. In the Class Chats panel of the Class Main Page, click the Edit Chat icon  next to the name 
of the chat whose details you want to edit. 

 
2. Make any necessary changes to the name or description of the chat. 

3. Click Save to save your changes.  
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Archiving Chat Sessions (Chat Manager Only) 
A Chat Manager or Instructor can archive a chat so that the contents can be accessed by any 
student at a later time. 

Note: The archive is only accessible when the chat’s status is Active. A student who would like to 
save a chat on his or her own computer can use the Save to Local File option (see Saving a Chat to 
a Local File on page 84). To make a chat archive available to students when the chat is not 
active, you must save it as a local file for the Instructor to upload as a Class Resource. 

Note: The Chat Manager can only archive the chat session from the moment the chat is joined. 
Therefore, it is a good idea for the Chat Manager to join the chat immediately after it is made 
active by the Instructor. He can then archive the chat at any time. He should also always archive 
the chat at the end of chat session. 

To archive sessions: 

1. Click Archive, found at the bottom of the active chat window.  

Note: This hyperlink is not available to students who are not Chat Manager. 

 
The Archive Chat page is displayed. 

2. Enter a name in the Archive Name field. 

3. Click Archive. 
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The chat is archived, and the Archive Chat page is closed. 

Editing a Chat Archive (Chat Manager Only) 
The chat manager may want to edit a chat archive. This may, for example, be required to remove 
inappropriate or irrelevant comments.  

1. Open the View Archive page. Click on View Archive from the active chat window. 

 
2. An alternative method of opening the View Archive page is to click on the Chat Archives icon  

next to the name of the chat in the Chats panel of the Class Main Page. 

 
3. From the View Archive page, click the Edit Archive icon  next to the archive to be edited. 

 
The Edit Archive page is displayed in a new pop-up window.  
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4. Make the required changes to the Archived Name field and the text. 

 
5. Click Save. The Edit Archive page is closed. 

Deactivating a Chat (Chat Manager Only) 
Class Chats can be deactivated to prevent students from being able to access them. This is useful 
when the instructor would like the chat to be available only at certain times, for example. 

Note: If the Chat Manager is a student, deactivation of the chat will make the chat disappear from 
the student’s Chats panel. In that case, the chat can only be reactivated by the class instructor. 

To deactivate a chat: 

1. In the Class Chats panel of the Class Main Page, click the Edit Chat icon  next to the name 
of the chat whose details you want to edit. 

 
2. Select Inactive from the Status drop-down menu. 
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3. Click Save. The chat disappears completely from the list of chats available to the students, 

including any student who is assigned to be the Chat Manager. The chat cannot be launched 
by any user. However, the Instructor can reactivate the Chat. 

Forums 
Forums is one of the options available from the Class Main Page. Like Chats, Forums allow 
students and instructors to interact. However, while Chats are synchronous, meaning means that 
they require all participants to be logged on at the same time, Forums are asynchronous, allowing 
users to interact at any convenient time. This option is also known as a bulletin board or threaded 
message forum tool. 

Any authorized user can post a message in a forum. All other users may reply to that message, 
and all messages related to the original posted message are connected together in a thread. A 
new message which is not connected to any previous threads starts a new topic. If left untended 
for a long time, a forum may become difficult to use because of messages which are silly or 
off-topic. For this reason, the forum is monitored by a Forum Manager. 

Forums may be set up for any purpose, including the following: 

• To enable students to request help on an assignment or project. 

• To enable students to collaborate on assignments or projects asynchronously. 

• To enable an instructor to moderate an asynchronous discussion on a targeted topic. 

• To enable students to share ideas. 
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Participating in a Forum 
Participating in a forum refers to reading and replying to messages. The LearnMate system also 
allows a user to print messages or save them to a local computer. 

To participate in a forum: 

1. In the Forums panel of the Class Main Page, click the Launch Forum icon  next to the forum 
in which you would like to participate. If this icon appears disabled, the Forum has been 
deactivated and cannot be accessed until the Instructor activates it. 

     
The View Forum page is displayed, providing a listing of all the topics available. Immediately 
below the Path Bar, you can read a description of the purpose of the Forum as defined by the 
Forum Manager. From this page, you can view any topic, which is the first message in any 
thread. You can also view any replies to the topic, or you can create an entirely new topic of 
your own. 
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Viewing Topics and Replies 
Once you have launched the Forum, you can browse through all posted messages and replies. 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

2. To view a topic, click on the subject which interests you. 

 
The message is displayed together with the name of the originator, the date and time of 
posting, the number of times the message has been read, and up to two links to sites on the 
Web. There are also hyperlinks that allow you to reply to the message, print it or save it to your 
own computer. 
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3. If there are replies to the topic, a  icon appears immediately to the left of the Subject. To view 

the replies, click the  icon. 

 
All replies to the message are displayed. 

 

Replying to Messages 
You can reply to any message, including both original topics and replies. 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

2. Open the topic that interests you according to the procedure in Viewing Topics and Replies 
on page 93. The message is displayed. 

3. To post a reply, click Reply in the panel containing the message to which you want to reply. The 
Reply page is displayed. 

4. Edit the Subject, Message and Homepage fields. 
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5. Click Submit. 

 
You are returned to the View Forum page. Your reply is displayed. 

Note: Once posted, a message cannot be deleted, except by the Forum Manager. 

Printing Messages 
You can print any message, including both original topics and replies. 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

2. Open the topic that interests you according to the procedure in Viewing Topics and Replies 
on page 93. The message is displayed. 

3. Click Print Preview in the panel containing the message you want to print.  

 
The Print Preview pop-up window is displayed. 
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4. Click Print. The message prints and the pop-up window closes. 

 

Saving Messages 
You can save any message to your own computer, including both original topics and replies. 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

2. Open the topic that interests you according to the procedure in Viewing Topics and Replies 
on page 93. The message is displayed. 

3. Click Save in the panel containing the message you want to save.  

 
The Save Forum Message pop-up window is displayed. 

4. Click Save. 

 
The Save HTML Document window is displayed. 
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5. Select the folder in which to save the message, and enter the name to be given to the file in 

the File name field. Click Save. 

 
The message will be saved as a text (txt) file, which can later be opened using Notepad or any 
other text editor or word processor. 

Creating a Topic 
Any authorized user can add a new topic to a forum. A new topic is basically just a new message 
that is not a reply to an existing thread. When you create a new topic, you are creating a new 
message thread in the forum, which other users can view, and to which they can respond. 

Note: Nothing physically blocks you from starting a new topic that is actually a reply, but if you do 
this, interested users will be less likely to find your message. When cleaning up the threads, the 
Forum Manager may decide to delete any such replies. 

To create a new topic in a Forum: 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

2. Click Create New Topic at the bottom of the panel. 
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The Add Message page is displayed. 

 
3. In the Sender Details panel, enter your name, and, if desired, your e-mail address and 

homepage in the appropriate fields. Note: http:// is already entered for you. 

4. Enter a subject for your topic in the Subject text field. 

5. Enter the body of your topic in the Message text field. 

6. If you wish, you can enter links to up to two websites in the Address fields, together with a 
description of each site in the Description fields. 

7. In the Picture Link field, you have the option of entering the URL of a picture to be displayed 
with your message.  

Note: Some websites with high volumes of traffic can take a long time to deliver your picture. 
This problem can be compounded if the picture is large.  
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8. Click Submit at the bottom of the page. 

 
The View Forum page is displayed, with the new topic listed. 
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Forum Manager 
Any member of the class can be appointed to serve as Forum Manager, including a student. The 
Forum Manager has certain rights and responsibilities. The Forum Manager sees an additional 
icon adjacent to the name of the Forum: Edit Forum. 

Editing Forum Details (Forum Manager Only) 
1. Click the Edit Forum icon  next to the forum to be edited in the Forums panel of the Class 

Main Page. 

 
The Edit Forum page is displayed. 

2. On the Edit Forum page, edit the Name and Description fields as needed.  

Note: Forums are identified by their name, which appears in the Forums panel of the Class 
Main Page or My Desktop page. The name must be unique; LearnMate does not support 
forums with the exact same name. The Description is the text that appears at the top of the 
View Forum page. 

3. Click Save. 

 

Deactivating a Forum (Forum Manager Only) 
Forums can be deactivated to prevent students from being able to access them. This is useful 
when the instructor would like the forum to be available only at certain times, such as after all 
students have taken a test that is the subject of the Forum. 
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To deactivate a forum: 

1. Click the Edit Forum icon  next to the forum to be edited in the Forums panel of the Class 
Main Page. 

 
2. On the Edit Forum page, select Inactive from the Status drop-down menu. 

3. Click Save. 

 
The Launch Forum icon  in the Forums panel appears disabled. Students cannot launch the 
forum. The forum can be reactivated by returning to the Edit Forum page and selecting Active 
from the Status drop-down list. 

 

Editing and Deleting Forum Entries (Forum Manager Only) 
At times, a forum manager may wish to either edit or delete forum entries posted by students. In 
the Forum Manager’s view only, there are two icons next to each thread and topic: Edit  and 
Delete . 

To delete a forum entry: 

1. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 
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2. Click the Delete icon  next to the message to be deleted. 

 
The message is deleted. 

To edit a message: 

3. Launch the Forum according to the procedure in Participating in a Forum on page 92. The 
View Forum page is displayed. 

4. Click the Edit icon  next to the message to be edited. The Edit Message page is displayed. 
This page is identical to the Reply page.  

5. Make the required changes and click Submit. The message is modified. See Replying to 
Messages on page 94 for more instruction. 

Class Tests 
From time to time throughout your course of study, your instructor may choose to give tests that 
are not related to a particular or single module. In LearnMate, these tests are known as Class 
Tests. Examples of class tests include a mid-term exam, final exam, safety test or a test on 
material that is not taught within the Learnmate environment. 

These tests are launched from the Class Tests panel of the Class Main Page. Adjacent to the 
name of the test is an indication of its status: Not Started, In Progress, Completed or Expired. 
There may also be entries in the columns for Start Date and End Date. 
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Start Date and End Date 
The instructor can designate the dates that a particular test can be taken. If a Start Date appears 
next to the name of the test, the test cannot be taken before that date. If an End Date appears, the 
test cannot be taken after that date. At the discretion of the instructor, either or both of these dates 
may be left open. If neither date appears, then the test can be taken at any time. 

Note: The exact time at which the test begins and ends is also shown. This time is specified 
according to the time at the location of the LearnMate server.  

Test Status 

Not Started 
The instructor can designate the earliest date that a particular test can be taken. Before that date, 
the status of the test is Not Started, and the student cannot launch the test. If you need to take the 
test at an earlier date, see your instructor. 

In Progress 
A test which is available for launching is noted as In Progress and a Launch Test icon  is 
displayed next to the name of the test. Once the allowed number of attempts for the test is 
exhausted and/or you have viewed your grade with the feedback showing the answers to the test, 
the status changes to Completed.  

Tip: Ask your instructor how many tries you are allowed for the test. 

Completed 
When a test has been taken the maximum number of times allowed or you have viewed the 
answers to the test via the gradebook or the feedback at the end of the test, the status changes to 
Completed and the Launch Test icon  disappears. 

Expired 
The instructor can designate the latest date that a particular test can be taken. After that date, the 
status of the test is Expired, and the student cannot launch the test. If you need to take the test at 
a later date, see your instructor. 

Launching a Test 
When the test status is given as In Progress, the Launch Test icon  is displayed next to the test 
name in the Class Tests panel of the Class Main Page. To take a test in LearnMate: 

1. Go to the Class Main Page.  

Reminder: To access the Class Main Page, click on the My Desktop tab of the Navigation 
Menu. Then click on the name of the class in the My Classes panel. 
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2. In the Class Tests panel, click the Launch Test icon  next to the name of the test you would like 

to take. 

 
The test is launched in a Test Viewer pop-up window. 

 
3. Follow the instructions for each question. The following icons become available during the 

test: 

� Next: Click Next to submit your answer. 

�  : Click the  icon to open the Test Navigation Bar. Each question is represented in 
the Test Navigation Bar by a numbered block.  

� Click a numbered block to jump to the question of that number. By the instructor’s 
choice, this option may be disabled.  
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� Note that all questions that have already been visited and answered are indicated in 
red, while all questions that have not yet been answered are indicated in blue. 

 
� Submit: This button is displayed when the last question in the test is displayed. After this 

button is pressed, the test will end and your score will be calculated. By the instructor’s 
choice, you may be presented with your score, or you may be presented with the correct 
answers and feedback. You may also submit your test results by clicking Submit in the Test 
Navigation Bar. 

Authentic Assessment Questions  
To accurately evaluate learning progress, assessment must examine not only theoretical 
knowledge but also the practical application of skills.This is what is meant by authentic 
assessment. Authentic assessments task students with real-world challenges that require them to 
apply acquired skills and knowledge. This question type requires an instructor to observe student 
performance of the tasked challenge, and then to grade the student based on pre-defined criteria 
for evaluation.  

In LearnMate, when a test contains an authentic assessment, you cannot navigate to other areas 
of the content until the instructor has entered a password and assigned you a grade. After the 
question has been graded, you may proceed to the next question in the test. 
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Different grading types are available for authentic assessments: Pass/Fail, 0 - 100% and 1 - 4. 
The instructor specifies which type is to be used for test. Grades are assigned as follows: 

• Pass/Fail: Pass = 100%; Fail = 0% 

• 1-4: 1 = 25%; 2 = 50%; 3 = 75%; 4 = 100% 

• 0 – 100%: Any grade from 0 to 100 can be assigned. 

Open/Essay Questions  
Open/Essay questions are not graded automatically, but are graded by the instructor after the test 
has been submitted. The grade on the Open/Essay question will affect your grade on the test as 
well as your overall class grade, as shown in the My Grades portion of the Main Menu. 
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Assignments 
An assignment is a project that students of a class must complete. The instructor can provide 
resources to help students do the assignment, including computer files, links and instructions. 
The instructor may perform a preliminary review of the assignment before it is submitted, and may 
also require it to be reviewed by the student’s own peers. When the assignment is complete, it is 
submitted through LearnMate to the instructor for grading.  

Grading for an assignment is based on pre-defined criteria that the instructor sets upon 
assignment creation; the student can review these criteria at all times as you progress. Grading is 
done rubric-style, where the evaluator indicates for each criterion whether it was fully met, partially 
met or not met at all. Additionally, the evaluator – peer or teacher – can include text remarks. 

Launching an Assignment 
During the period in which an assignment is in progress, the Launch Assignment icon  is 
displayed in the Assignments panel of the Class Main Page. 

To launch an assignment: 

1. Click the Launch Assignment icon  next to the name of the assignment. Note that the Start 
Date, End Date and Status are displayed just as for Class Tests. The assignment can only be 
launched when the icon is present and the status is indicated as In Progress. See Start Date 
and End Date and Test Status on page 103 for more information. 

 
The Assignment page is displayed. This page contains the following information: 

• Assignment Details: Lists the assignment’s name, topic and description. 
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• Grading Criteria: Outlines the criteria by which your assignment will be graded. The 
weighting of each criterion is displayed. 

 
• Links: Lists all web links that the instructor has indicated as relevant to the assignment. 

Click a link address to access the site. The website will open in a separate window. 

 
• Reference Files: Lists files that the instructor has uploaded for your use during the 

assignment. Either click the file name to open it directly from the LearnMate server, or 
right-click and select Save Target As..., to save it your computer for later access. 

 
• User Files: User Files are files that the student can work on in their use of the assignment, 

and submit when ready. A User File may consist of a worksheet to be used in completion 
of the assignment, or a template file for creating a research paper or diary. The User Files 
panel lists all User Files and provides various tools for working with them. See the next 
section, Working with User Files, for more information. 

 
2. Click Back to return to the Class Main Page. 
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Working with User Files 
Assignments are graded based on the User Files you have generated throughout the course of 
your work. User Files can be sent to a peer or instructor for a preliminary review or submitted to 
the instructor for a final grade. Further, you can keep working notes as you progress with each file. 
In this section, you will learn how to take full advantage of User Files. 

• You can upload files from your computer to your Assignment page using the Add File 
procedure. See Adding a New User File on page 109.  

• You can download files from the Assignment page to your computer. After doing so, the file 
on the Assignment page becomes locked, to prevent you from mistakenly working on 
different copies of the same file at different times. You may unlock the file if you need to. See 
Opening and Downloading a User File on page 111. 

• You can then upload a modified version of a file that was previously downloaded. See 
Uploading an Existing User File on page 112. 

• You can create a completely new version of a User File to act as a backup. In this case, both 
the new version and the old version will be listed on the Assignment page. See Creating a 
New Version of a User File on page 114. 

• You can delete unwanted User Files. See Deleting a User File on page 115. 

• You can keep Working Notes for each User File. These are short notes for your own use. See 
Creating and Viewing Working Notes on page 116. 

• You can submit your User Files to the instructor or to your peers for preliminary evaluation, to 
receive feedback that may help you complete the assignment. See Preliminary Evaluations 
on page 117. 

• When you submit your assignment for grading, all associated User Files are accessible to the 
instructor. See Submitting an Assignment for Grading on page 124. 

Adding a New User File 
After you have created a file on your computer, it can be uploaded to your Assignment page.  

To add a new User File: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. Click Add File in the User Files panel.  

 
The Upload pop-up window is displayed. 
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3. Click Browse next to the File 1 field.  

 
The Windows Choose File dialog box is displayed. 

4. Browse to select the file to add. Then click Open.  

 
The Upload pop-up window is displayed with the selected file shown in the File 1 field. 

 
5. If necessary, repeat steps 3 and 4 to add files in the File 2 and File 3 fields. 

6. Click Upload Files in the Upload pop-up window. The Upload pop-up window closes, and the 
selected files are listed in the User Files panel of the Assignment page. 

 
Note: LearnMate automatically replaces all spaces in the name of the uploaded file with 
underscore characters ( _ ). 
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Opening and Downloading a User File 
You can open and download any of your User Files to your computer, so that you can work on 
them offline. Once a file has been downloaded, the status of the file is indicated as Locked. This 
prevents you from downloading the file again and becoming confused over which copy of the file 
you are working on.  

To open and download a User File: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. Click the Download icon  next to the User File to be downloaded.  

 
The selected file is opened in a new browser window by the application required by the file. 
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3. Save the folder to your computer using the Save As function in the open application. Do not 

change the name of the file. 

 
The file is saved to your computer.  

4. Close the browser window. Do not attempt to make changes here. Instead, open the file from 
the location you saved it on your computer. You can now work on the file, editing and saving 
as you normally would. However, be sure to keep the file name exactly the same as it is saved 
on LearnMate. Each time you are finished editing your work, be sure to upload it to your 
Assignments page as described in the next section, Uploading an Existing User File. 

Note: The example graphics shown here are specific to Microsoft Word. Each software program 
will appear differently. 

Uploading an Existing User File 
After you have finished editing your User File, you should return it to LearnMate. The old version 
you changed is replaced with your latest version and the file’s status is changed back to Unlocked. 
Your Working Notes are preserved and you can download the file again whenever you need to. 
See Creating and Viewing Working Notes on page 116. 

Uploading an existing file to LearnMate involves basically the same procedure as adding a file, as 
described in Adding a New User File on page 109, except that you begin by clicking a different 
hyperlink. 

Note: In order to preserve the document version control provided by the User Files feature of 
LearnMate assignments, it is very important that you choose the correct hyperlink to start with. 
Use Add File only the first time you put a file into the system, and use Upload every time after that. 

To upload an existing User File: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 
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2. Click Upload at the bottom of the User Files panel of the Assignment page. 

 
The Upload pop-up window is displayed. 

3. Click Browse next to the File 1 field.  

 
The Choose File dialog box is displayed. 

4. Browse to select the file to add. Then click Open.  

 
The Upload pop-up window is displayed with the selected file shown in the File 1 field. 

5. Repeat steps 2 and 3 to add files in the File 2 and File 3 fields if necessary. 
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6. Click Upload Files.  

 
The files you selected are uploaded, replacing the old copies of the files. The file is now 
unlocked. 

 

Creating a New Version of a User File 
It is recommended that you create a backup copy of a User File before editing it. 

To create a new version of a User File: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. Click the Create New Version icon  next to the relevant file. 

 
The Assignments page is redisplayed. The new version of the file is shown in the User Files 
panel. The new file has the same name as the previous file, with a number added at the end, 
indicating the version number. The Created From column indicates which file it is based on. 
You can now download and edit the copy, leaving the original file as a backup. 
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Notes:  

� The Working Notes you created for the first version are not carried over into the new 
version. However, you can still access the original version at any time. 

� When creating new versions, it is usually a good idea to start with the latest version. If you 
go back to the original file, you start a new branch, which can easily lead to confusion. 
Refer to the Created From column to help identify the latest version. 

Deleting a User File 
To delete a User File: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. Click the Delete icon  next to the User File you would like to delete. 

 
You will be asked for confirmation. 

3. Click OK. 

 
The file is deleted and no longer appears in the User Files panel. 
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Creating and Viewing Working Notes 
LearnMate allows you to keep notes about your User Files. For example, you may want to keep a 
note as a reminder of work still required on a file, or record comments to add to your peer or 
teacher evaluation request. Several notes may be kept for each User File. 

To create and view Working Notes: 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. In the User Files panel, check the checkbox next to the name of the file for which you would 
like to add a note. 

3. Click Working Notes.  

 
The Working Notes page is displayed. 

4. Previously written notes are listed in the Saved Notes panel. They can be deleted by checking 
the checkboxes and clicking Delete. 

5. Write the new note in the Notes text field. 
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6. Click Save. The note is saved and the Working Notes page closes. When you reopen the 

Working Notes page for this file, the note you have entered will be displayed in the Saved 
Notes panel. 

 
Note: When you create a new version of a User File, the Working Notes you created for the 
first version are not carried over into the new version. However, you can still access the 
original version at any time. 

Preliminary Evaluations 
You can submit your User Files to the instructor or to your peers for preliminary evaluation, to 
receive feedback that may help you complete the assignment and/or better your chances of 
receiving a good grade. 

Submitting an Assignment for Evaluation 
If you need help with your assignment or wish to determine whether you are ready to submit your 
assignment for a final grade, you can request a preliminary evaluation from either an instructor or 
a peer. The instructor or peer will receive a message in his or her Inbox, requesting evaluation, 
together with a link to the User Files you want evaluated (see Evaluating an Assignment on 
page 119).  

The procedure for requesting an evaluation is a completely separate procedure from submission 
for final grade. Preliminary evaluations are not factored into the final grade – they are merely an 
indicator of how the peer or instructor would grade you at the time of the review request. If you 
request an evaluation but do not eventually submit the assignment for a grade, the assignment 
will end up with a grade of zero. See Submitting an Assignment for Grading on page 124. 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. In the User Files panel of the Assignment page, check the checkboxes next to the file to be 
submitted. 

3. Click Teacher Evaluation to submit the file to a teacher or Peer Evaluation to submit the files to a 
classmate. The View Evaluation page is displayed. 
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4. Add a note to the evaluator in the Notes to Evaluator field. 

5. Click Submit Teacher Evaluation or Submit Peer Evaluation.  

Note: This is the same hyperlink you will click to read the evaluation. 

 
3. If you request a teacher evaluation, the teacher is sent a message requesting the evaluation. 

LearnMate returns to the Assignment page. 

If you request a peer evaluation, the Students page is displayed so that you can select the 
classmates who will do the evaluation. Select the classmates you want to evaluate your work. 
Click the Add Students icon  to move them to the Selected Peers box. Then click Send. The 
Evaluation Request page is redisplayed. A message requesting evaluation is sent to each of 
the evaluators. 

 
Note: You can only submit one file at a time for review. If you wish to request a preliminary review 
on more than one file, repeat steps 2 to 5 for each file. 
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Evaluating an Assignment (Student and Instructor) 
If one of your classmates has requested that you evaluate his or her assignment, you will receive 
a message in your Inbox. The message will have the subject Evaluation request. To review 
Inbox procedures, see My Inbox on page 31. 

1. Click either the name of the requestor or the subject of the message. 

 
The View Message page is displayed and the student’s comments are shown.  

2. Click the link Evaluation Form, which is located at the end of the message body and above the 
bottom row of hyperlinks.  
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The View Evaluation page is displayed, listing the assignment details. 

 
3. To read the User File you are supposed to evaluate, you can either open it directly from the 

LearnMate environment or you can download it to your computer. To open the file directly, 
click the file name in the File row of the Assignment Details panel. The file opens for viewing.  

 
4. Alternatively, to save the file to your own computer, right-click on the name and select 

 Save Target As… from the pop-up box drop-down menu. 
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The Windows Save As pop-up window is displayed.  

5. Select the folder in which you wish to save the file and enter the file name in the File Name 
field. Click Save. 

 
4. Read the files the student sent and then formally evaluate them. 

6. Each of the grading criteria the instructor specified for the assignment is listed in the 
Evaluation panel, similar to a formal grading rubric. 

� Evaluate the student’s work according to each of these criteria, using the radio buttons 
provided. 

� Enter a qualitative evaluation in the Evaluation field.  

Note: The system does not notify the student as to whether the grade was calculated 
automatically via the criteria rubric or manually overwritten by the evaluator. This field can 
also be used to explain the grade you give, as well as to provide feedback on the student’s 
work. 

� Click Calculate Grade to calculate the grade automatically, or enter the grade manually in the 
Grade field. The numbers listed in the Weight column are used for automatic calculation, 
but you may accept or ignore them if you decide to manually grade. If you should calculate 
the grade automatically, full credit is given for Full, two-thirds credit for Partial, and 
one-third credit for Not Addressed.  
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The grade is calculated and placed in the Grade field. You can modify this number manually if 
you wish. Keep in mind that an evaluation “grade” is not the student’s actual grade, but a 
preliminary check to help the student perfect the work before submission. 

7. Click Send Evaluation to send your evaluation to the student. 

 
The following message will be displayed. 

 
8. Click OK to use the automatically calculated grade. If you entered a grade manually, click 

Cancel. A confirmation message is displayed, showing the grade to be assigned. 

Note: If you entered a grade manually and then click OK, it will be overwritten with the 
automatically calculated grade. 

9. Click OK to accept the grade. The evaluation is sent, and the My Inbox page is redisplayed. 

Note: While you are still in your Inbox, you may want to send the student a short mail that the 
evaluation is complete. The next section describes how a student can view previous 
evaluations. 
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Viewing Past Evaluations 
Once an assignment has been evaluated by the instructor or a peer, the evaluation is available for 
your review. 

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. In the User Files panel of the Assignment page, check the checkboxes next to the User File 
you sent for evaluation. 

3. Click Teacher Evaluation in the User Files panel to view evaluations performed by a teacher, or 
Peer Evaluation to view evaluations performed by peers.  

Note: These are the same buttons you used to send the original evaluation requests. 

 
The View Evaluation page is displayed. The evaluation is displayed, including the review 
according to the instructor’s grading criteria, the comments and the numeric grade.  
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4. If you wish, you can send the User File to the same evaluator again with additional comments 

in the Notes to Evaluator field. For example, once you have completed the suggestions noted 
in a previous evaluation, you may wish to submit the assignment for a re-review. To do so, 
click Submit Teacher Evaluation or Submit Peer Evaluation only if you want to send the file again. 

5. Click Back to return to the Assignment page. 

Submitting an Assignment for Grading 
Once you have completed the assignment, you must submit it to the instructor for final grading. In 
some cases, you may have had your User Files evaluated a number of times before final 
submission.  

Note: Once you have submitted the assignment for grading, you can no longer launch the 
assignment for further editing. Therefore, be sure that you are 100% ready to submit the 
assignment before following this procedure.  

1. Launch the assignment as described in Launching an Assignment on page 107. The 
Assignment page is displayed. 

2. In the Assignment page, click Submit, either at the top or bottom of the Assignments page. 

 
You will be asked whether you are ready to submit the files. This dialog box is the last warning 
for the student who intends to request a preliminary evaluation but has selected the Submit 
procedure by mistake. An assignment can only be submitted for final grade one time. 

 
3. If you are sure you have completed the assignment, click OK. The assignment is submitted 

and your Class Main Page is displayed. The instructor receives a message in his Inbox, 
indicating that the assignment has been submitted for final evaluation. After the assignment 
has been graded, you can view your grades in the My Grades page. See Viewing My Grades 
on page 54.  

Class Resources 
Class Resources are files that are relevant to the class as a whole, such as the course syllabus, 
calendar, class rules, safety procedures, lecture notes and so on. Unlike Module Resources (see 

LearnMate v3.2 User Manual  124 
0609  My Desktop 



  
 
Module Resources on page 72), they are not relevant to just one particular module but rather are 
intended to be more general and for the entire class.  

The class resource files are listed in the Resources panel of the Class Main Page. This list may 
change from time to time as determined by the instructor. Students can open files directly from 
this page, or download them to their own computers. The procedures for dealing with these files 
are identical to the procedures for Module Resources. 

Opening a Resource File 
Class Resources are opened in the same manner as Module Resources. See Viewing a Module 
Resource on page 73 for more information on this feature. 

Saving a Resource File 
Class Resources are saved in the same manner as Module Resources. See Saving a Resource 
File on page 74 for more information on this feature. 

Review 
In this chapter, we covered the following material: 

• The layout of the Class Main Page. 

• How Modules are launched. 

• How to view a Rotational Schedule. 

• How to perform a Software Check to determine that you have the correct version of the 
software required for a module installed on your PC. 

• How mail and events are sent to fellow classmates and the instructor. 

• How Chats are managed and used. 

• How Forums are managed and used. 

• How Class Tests are launched. 

• How to launch Assignments and submit them for preliminary reviews and final grading. 

• How Resource Files are managed. 
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Ask Yourself 
• Can you schedule a class event, and send messages to students? 

• Can you join a chat? 

• Can you join a forum? 

• Can you add a topic to a forum? 

• Can you respond to a message posted in a forum? 

• Can you launch a module? 

• Do you know where to install the software required for a module? 

• Can you launch a class test? 

• Can you launch an assignment? 

• Can you upload User Files and maintain them while you work on them? 

• Can you submit User Files for preliminary reviews and final grading? 

• Do you know the difference between the various status messages for class tests and 
assignments? 

• Can you read Resource Files for classes and modules? 

• Do you know how to contact your instructor through the LearnMate system? 
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5 
Viewing LearnMate Content 

Review of Previous Chapter 
In the previous chapter, you were introduced to the Class Main Page, which acts as the 
“dashboard” for each of a student’s or instructor’s classes. You learned that this page contains all 
the information and controls needed to study, or lead, a class.  

You covered the following: 

• The layout of the Class Main Page. 

• How Chats are managed and used. 

• How Forums are managed and used. 

• How to launch Modules and Class Tests. 

• How to install the software required by a module using the Software Check function. 

• How to launch Assignments and submit them for preliminary reviews and final grading. 

• How Resource Files are managed. 

Introduction 
In this chapter, we will explore the Content Viewer, the window in which LearnMate Content is 
presented. The Content Viewer opens in a separate pop-up window and the LearnMate 
environment remains open and accessible at all times. By the end of this chapter, you will be able 
to take full advantage of LearnMate Content by using all the functions available from the Content 
Viewer window. 

Objectives 
In this chapter, we will explore the following topics: 

• The layout of the Content Viewer 

• Content Viewer icons 

• Color-coded hyperlinks within the text 
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Overview of Content Viewer 
Each LearnMate Content module combines illustrative graphics, interactive animations and 
simulation software to create a unique learning experience. To facilitate learning, the same basic 
page structure, generic navigation tools and learning enrichment tools are used in each module. 

A typical LearnMate Content page is shown below.  

 
Each of the items specified will be discussed in one of the following sections: 

• Launching a Module, page 129, explains how to launch a module from the LearnMate 
interface. 

• Navigating a Module, page 130, demonstrates various methods for moving from section to 
section in a module, and describes the functionality of different types of hyperlinks that a 
module can include. 

• Exploring the LearnMate Toolbox, page 133, describes each of the six learning enrichment 
tools available in the LearnMate toolbox. 
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Launching a Module 
To launch a module: 

1. Click on the My Desktop tab in the Navigation Menu. Click on the name of the class of interest 
in the My Classes panel. In the Modules panel of the Class Main Page, click the Launch icon  
next to the module you wish to launch.  

 
The module is launched in a new Internet browser window. 
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Navigating a Module 
LearnMate offers a number of options for navigating content. Navigation links below the text on 
each page of LearnMate Content enable you to easily move through the module. You can move 
sequentially from page to page using the Previous and Next buttons, or jump to a specific section 
in the module using the Index. Additionally, color-coded links within the text enable you to: 

• Change the media object (graphic, animation, video) displayed in the Media Viewer 

• Open the Glossary pop-up window to a particular term 

• Open a software application 

• Open a resource file 

• Jump to another page within the current module or another module 

• Open a link to a related article or website on the Internet 

Moving from Page to Page 
 

• Click Prev to display the previous page in the current module. 

• Click Next to display the next page in the current module. 

• Click Index to display a Table of Contents of all the sections in the module. An arrow  marks 
the section that is currently open. Click the section to which you would like to jump to display it 
in the Content Viewer.  

Note: If you are only able to jump to sections that you have already read but not future 
sections, this means that Open Index Navigation has been disabled by your instructor. This 
function allows instructors to force students chronologically through the content. 
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• Click a red link to change the graphic displayed in the Media Viewer. 

• Click a pink link to change the animation displayed in the Media Viewer. 

• Click a green link to open the Glossary pop-up window to a specific term and definition. For 
more details on the glossary, see Glossary, page 135. 

• Click a blue link to do one of the following: 

� Open a software application. Note that the required application and the LM Agent must be 
installed on your computer. See LM Agent and Required Software on page 2 and 
Software Check on page 75. 

� Open a resource file. 

� Jump to another page within the current module or another module. 

� Open a link to the Internet. 

The Upper Icons 
Three commonly used icons are located at the top right of the Content Viewer. 

 

My Learning 

Clicking the My Learning icon  brings the Class Main Page window to the front, temporarily 
hiding the Content Viewer. The Content Viewer remains open at the page you were just viewing.  

Note: To return to the Content Viewer, click the Minimize icon in the upper right corner of the 
Class Main Page window or select the Content Viewer from the Windows taskbar. 
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Print 

Clicking the Print icon  opens the Print dialog box. Select the printer, make the required 
settings and click Print. The currently displayed page will be printed. 
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Help 

Clicking the Help icon  launches the LearnMate v3 Content Getting Started Guide, which 
introduces you to the basics of using the Content Viewer. 

 

Exploring the LearnMate Toolbox 
The LearnMate toolbox is displayed in the Content Viewer below the navigation links.  
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Audio Narration 

Many LearnMate Content pages are narrated. Clicking the Audio icon  in the LearnMate 
Toolbox opens an audio player on the bottom of the Content Viewer, to the right of the Toolbox. 
The narration of the current page begins playing automatically. You can stop, pause, fast forward, 
rewind, or restart the narration, or adjust the volume at which the narration is played, using the 
controls in the audio player.  

Note: If the audio appears to be playing but you don’t hear any sound, make sure your earphones 
are connected correctly and that they have not been muted in your computer’s Audio controls.  

 

Competencies 
LearnMate modules can be associated with competencies from state, national and industrial 
Skills Standards.  

Click the Competencies icon  in the LearnMate Toolbox. A pop-up window opens, displaying 
all associated Skills Standards and the specific competencies that have been associated with this 
module.  

Note: Reviewing this list can give you a better idea of what you are expected to learn from this 
module. 
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Safety Instructions 

LearnMate Content modules often require the use of hardware. Clicking the Safety icon  in 
the LearnMate Toolbox opens a pop-up window that displays a list of safety instructions for 
working with the module. If the module is a virtual module that does not require hardware, no 
safety instructions will be displayed when you click Safety. 

 

Glossary 

LearnMate modules are accompanied by glossaries. Clicking the Glossary icon  in the 
LearnMate Toolbox opens a pop-up window that displays the glossary for the currently active 
module. Whenever the Glossary window is open, you can search for any particular term using 
one of the following methods: 

• To locate a particular term, enter the term in the field indicated and click Search. 

• Click the letter with which the term begins from the alphabet at the top of the window. Then 
scroll through all terms beginning with the selected letter until you find the term you are 
seeking. 

 
The Glossary window can also be opened by clicking a glossary link (a green link) in the text 
of a module, in which case the Glossary window opens directly to that term.  
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Notes 
LearnMate provides you with a Virtual Notebook to enter any personal notes or comments on the 
material you are studying.  

Clicking Notes  in the LearnMate toolbox opens a pop-up window that displays your Virtual 
Notebook for the current module. You can then save the notes in the Virtual Notebook by clicking 
Update, or on your personal computer by clicking Save Notes to Local File. You can also print out your 
comments by clicking Print. Every user has one Virtual Notebook for each module.  

 

Links Library 
LearnMate modules may be accompanied by links to websites that provide additional information 
on the topics covered in the modules.  

Clicking Links  in the LearnMate toolbox opens a new pop-up window that displays the links 
library for the current module. Each link includes a short description. Clicking the link title (bold 
black text) opens a new browser window displaying the linked website.  
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Note: You must be connected to the Internet for these links to work. 
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Tests and Questions 
Questions typically appear throughout LearnMate modules. Usually they are part of tests 
consisting of multiple questions. These tests can be found in the module index. Sometimes, 
however, questions appear singularly, to help you clarify text you have just read or a task you just 
performed.  

A typical question page is shown below. 

 
LearnMate includes several different question types: Multiple Choice, Multiple Multiple Choice, 
Fill-in-the-Blank, True/False, Matching, Drag and Drop Ordered, Drag and Drop Non-ordered, 
Hotspot, Open/Essay and Authentic Asssessments. As such, it is critical that you follow the 
instructions displayed in red text at the top of the Question Viewer. They will explain how to 
answer the question type displayed. 

The following icons become available during the test: 

• Next: Click the Next button in the Question Viewer to submit your answer.  

Note: Do not click Next in the Navigation tools below the Question Viewer unless you want to 
skip the test. Tests should only be skipped on the advice of your instructor. 
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•  : Click the  icon to open the Test Navigation Bar. This option is disabled by the 

instructor for some tests, in which case the icon appears grayed out. Each question is 
represented in the Test Navigation Bar by a numbered block.  

 
� Click a numbered block to jump to the question of that number.  

� Note that all questions that have already been visited and answered are indicated in red, 
while all questions that have not yet been answered are indicated in blue. 

• Submit: This button is displayed when the last question in the test is displayed. After this 
button is pressed, the test will end and your score will be calculated. By the instructor’s choice, 
you may be presented with your score, and you may be presented with the correct answers 
and feedback. You may also submit your test results by clicking Submit in the Test Navigation 
Bar.  

Note: When using the Test Navigation Bar, be very careful not to accidentally click Submit instead 
of a numbered block in the first row. You can use the Test Navigation Bar to verify that you have 
answered all questions before submitting the test for grading. 

Reaching a Test in a Module 
As you reach a point in a module where you are about to be presented with a test, a message will 
display, informing you that you are about to take a test. Click OK to take the test, or Cancel to skip 
to the section after the test. (This message is not displayed before questions that appear singly, 
within content objects.) 
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Reviewing Answers to a Test 
When defining the test delivery options for a class, the instructor can specify whether a student 
will or won’t see the answers to the tests following submission of the test. 

There are three possibilities: 

• The student is shown only his or her score at the end of the test. 

• The student is shown his or her score, and the answers to each question in the test with 
feedback about each question. 

• The student is shown only a message indicating the test is being submitted for grading. 

In addition, the instructor can specify how many attempts at a test each student should be 
allowed. 

These two settings combine to determine whether the student will see the answers to a test after 
submitting it. Once a student has viewed the answers to a test, he or she is not permitted to take 
the test again. 

If the instructor has specified that the student can see the answers after submitting a test, the 
student will see the message below, provided that the student has not used up all permitted 
attempts at the test. 

 
Click OK to view the answers, or Cancel to advance to the next section. If you click OK and view the 
answers, you will not be permitted to take the test over. If you click Cancel, you will be allowed to 
take the test again.  

The message above is not displayed once the student has used up all permitted attempts at the 
test. Providing that the instructor allowed students to view test answers, the student will be shown 
the test answers automatically after submitting the test for the last permitted attempt. 
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If you elect to view the answers, you will be shown the answers in the format shown below. 

 
Note that the page displays the answer you provided, the correct answer, and feedback. If the 
student did not submit an answer to the question, the text “No answer was submitted for this 
question.” Is displayed in red at the top of the Test Viewer. 

Answering Test Questions 
LearnMate offers a range of question types. You will learn how to answer several types of 
LearnMate questions in this section.  

Multiple Choice Questions 
Select one of the options listed, and click Next. 
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The feedback page indicates the answer you selected and the correct answer. 

 

Matching Questions 
Drag your cursor from one item in the left column to the matching item in the right column. Repeat 
for all pairs. Click Next. 
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The feedback page shows the links that you entered in black and the correct links in red. Note that 
if you linked a pair correctly, that link is shown in red. (In other words, only your incorrect links are 
shown in black.) 

 

Hotspot Questions 
Hotspot questions require you to identify a point on a graphic specified by the question. In the 
example below, you are asked to click on the transistor. Click on the required spot. A red dot will 
display at the point that you click. Clicking elsewhere will move the red dot to a new location. Click 
Next. Note that in some hotspot questions, there may be more than one area that is correct. 
Clicking any of the correct areas will result in a correct answer. 
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The feedback page shows the location you clicked with a red dot. A green rectangle indicates the 
correct area. If the red dot is within the green rectangle, your answer is considered correct. 

 

Drag and Drop (Ordered) Questions 
A drag and drop question is designed to test your ability to rank a list of items, or place a series of 
steps in the correct order. The question presents up to four items in a list. Next to each item is a 
numeric label, from 1 to 4. To answer this question, you need to drag the label numbers into the 
correct order in the ordering box. To do so, first drag the label number corresponding to the item 
that should be first in the order, into the box. Then drag the label number corresponding to the 
second item in order, and so on. For example, in the question below, you are asked to order four 
Roman numbers, in ascending order.  
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To indicate that the Roman numeral I is first in the sequence, drag the label number 1 into the 
box. To inidicate that the Roman number V is the second in the sequence, drag the label 
number 3 into the box. To (incorrectly) indicate that the Roman number C is third in the 
sequence, drag the label number 2 into the box. To (incorrectly) indicate that the Roman 
number X is fourth in the sequence, drag the label number 4 into the box. Click Next. 

  
The feedback page indicates the order you specified, and the correct order. Note that the 
numbers shown in bold here are NOT the label numbers from the question page. Rather, 
these numbers indicate the correct ordering. 

For example, the page below indicates that you provided the following order: I, V, C, X. The 
correct order should have been: I, V, X, C. 
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Review 
In this chapter, we covered the following material: 

• The layout of the Content Viewer. 

• How to navigate through module content. 

• The significance of the colors of hyperlinks within the content. 

• How to print a page. 

• How return to the Class Main Page. 

• How to access help. 

• How to initiate audio narration. 

• How to view a list of competencies to be gained in a content object. 

• How to view the safety instructions. 

• How to access and search the glossary. 

• How to keep student notes. 

• How to access the links library. 

• How to answer tests. 

Ask Yourself 
• Can you access the index, and select a section to which to jump? 

• Can you list the functions performed by each color of hyperlink? 

• Can you print a page of LearnMate Content? 

• Can you operate the narration function? 

• Can you access the list of competencies, hardware safety instructions and the Internet links 
library? 

• Can you navigate between questions in a test? 
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6 
Catalog 

Review of Previous Chapter 
In the previous chapter, we reviewed the Content Viewer and the following features: 

• Returning to Class Main Page 

• Printing 

• Accessing Help 

• Audio Narration 

• Competencies 

• Safety Rules 

• Glossary 

• User Notes 

• Internet Links 

• Color-Coded links within the text 

• Tests and Questions 

Introduction 
In this chapter, we will explore how a student can locate and enroll in a particular class. 

Objectives 
In this chapter, we will cover the following: 

• What is the Catalog? 

• Enrolling in a Class 
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What is the Catalog? 
Catalog is one of the options available from the Navigation Menu. Catalog enables you to locate 
and enroll in a class that interests you. The Catalog is a comprehensive directory of all the 
classes that are available to LearnMate users. The Catalog lists all classes that have been 
created, together with the modules of which they are comprised. 

Class Enrollment 
In order to launch and study a class, you must enroll in that class. If you are interested in enrolling 
for a particular module, you must enroll in a class that includes that module. You cannot enroll in a 
module directly. 

Depending on the instructor’s specifications, classes can be categorized as follows: 

• Classes that can be enrolled in from catalog: After enrolling in a class that can be enrolled 
in from the catalog, the class will be listed in the My Classes area of the student’s My Desktop 
page. A student will be able to click on the class and access the Class Main Page. The 
student will automatically appear in the Students panel of the Class Main Page. 

• Classes that cannot be enrolled in from catalog: Although these classes are listed in the 
catalog, they cannot be selected for enrollment. The instructor must enroll the student directly. 
If you wish to enroll in such a class, contact the named instructor via My Inbox. 

Enrolling in a Class 
To enroll in a class: 

1. Select Catalog from the Navigation Menu. 

 
The Classes page is displayed. 

2. Enter your search criteria. You can search either by Class or by Module.  

Note: It is usually more effective to search for Class or Module but not both. 

3. Click Search. 
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A list of all classes matching your search criteria is shown. For each class, the list of its 
modules is shown, as well as enrollment dates that have been specified.  

 
If you specified a Class and Module in the search, but the module is not part of the selected 
class, you will receive the message No classes matched the search parameters. 

 
4. Check the checkboxes of all classes in which you want to enroll. 

Note: In some cases, the checkbox next to a class is inactive, thus preventing enrollment. 
Place your cursor over the inactivated checkbox to see the reason enrollment is prevented, 
including: 

� The class is full: The maximum number of students permitted in the class has been 
exceeded. 

 
� The class cannot be enrolled in from the catalog: The instructor has specified that 

students may not enroll in the class via the catalog. Enrollment must be done by the 
instructor. Contact the instructor. 
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� The student is already enrolled in the class: The student is already enrolled in the class 
and cannot re-enroll. 

 
� Enrollment period has expired: The class or module you searched for is unavailable for 

enrollment as a result of its period of enrollment having expired. 

 
5. Click Enroll. 

 
The Class Enrollment page is displayed, listing the classes in which you enrolled. 

 
6. Click Back to return to the Catalog page. 
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Launching the Class 
After completing enrollment in a class, you may immediately launch the class: 

1. Click My Desktop. 

 
The class is listed in the My Classes panel of the My Desktop page.  

2. Click on the class name to enter the Class Main Page. 

 
See The Class Main Page on page 64 for more information. 

Review 
In this chapter, we covered the following material: 

• You learned that the catalog is provided to enable students to search for and enroll in classes 
of interest. 

• You learned that students enroll in classes, and cannot enroll directly in modules. 

Ask Yourself… 
• Can you search for a class in the Catalog? 

• Can you enroll in a class? 

• Do you understand the reasons why you may not be able to enroll in a class/ 
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7 
Administration Quick-Start Guide 

Foreword 
The second portion of this manual is designed for non-students only, including instructors, 
Content Administrators and administrators. Most of the previous six chapters applies to 
non-students as well. However, certain features are available only to students, such as My 
Grades.  

In addition to the features discussed thus far, administrative users also have a much wider range 
of features available. Some of these features are accessible through two additional tabs on the 
Navigation Menu: Content and Administration. Others are accessible on pages normally 
visible to students under the My Desktop and Catalog tabs. The pages are laid out exactly like 
the student version, but you have a number of extra icons and hyperlinks that students do not see. 
Which tabs are visible to you on the Navigation Menu depends on the permissions that have 
been assigned to you as a user. See Roles on page 223 and Permissions on page 225. 

Because so much of the system is identical for the different types of users, you will be referred to 
parts of the student manual, where applicable. All cross-references in the electronic version of this 
manual are active hyperlinks. Clicking on a referenced section will take you directly to that section. 

Introduction 
This chapter is designed for administrative users who need to start working with LearnMate 
immediately. The manual is comprehensive and covers many details beyond the basics of 
running a class. By following the six-step process outlined here in this Quick-Start Guide, you will 
cover the most important LearnMate functions, and you can return to the manual at any time to 
explore LearnMate in greater depth. The six steps are: 

1. Set up an organization. 

2. Add users to the organization. 

3. Create a class. 

4. Add modules to a class. 

5. Enroll students in a class. 

6. Manage the class. 

This chapter also introduces the LearnMate interface as seen by administrators.  
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Step 1: Set Up an Organization 
The LearnMate system hierarchy is determined by organizations and their respective 
sub-organizations. Each organization is an independent entity, maintaining its own users, 
classes, reports, and modules. 

To learn how to set up an organization, see Organization Management on page 205. 

Step 2: Add Users to an Organization 
LearnMate users include students, instructors and administrators, where the latter two can be 
assigned various system roles and permissions. Additional users can be added at any time. 

To learn how to add users to an organization, see User Management on page 222. 

Step 3: Create a Class 
A class is defined as a group of students who are studying similar content (e.g., modules, 
assignments, tests) and who are managed by the same instructor.  

To learn how to create a class, see Class Management on page 234. 

Step 4: Add Modules to a Class 
’s modules cover a wide range of technology subjects. In addition, instructors can create 

their own modules. 

To learn how to add an existing module to a class, see Adding Modules to Class on page 269. 

To learn how to author a new module, see Modules on page 308.  

Step 5: Enroll Students in a Class 
Once a class has been created and modules have been added to it, students must be enrolled in 
the class. 

To learn how to enroll students in a class, see Enrollment Via Catalog on page 238 and 
Enrolling Students on page 277. 
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Step 6: Manage the Class 
Once a class has been assembled, together with students and modules, the instructor is ready to 
begin managing the class. The most common class management functions, together with their 
section and page references are listed below: 

Function Section Page 
Adding Resources to the Class Class Resources 301 

Creating a Chat Create a Class Chat 287 

Creating a Forum Class Forums 288 

Adding a Test Adding a Test to a Class 288 

Adding an Assignment Adding an Assignment 297 

Setting up the Class Gradebook Customize Gradebook 256 

The Administrator’s LearnMate Interface 
This section provides an overview of the LearnMate interface, as described previously in 
Navigation Bar and Main Menu starting on page 21, and highlights the differences between the 
student’s and administrator’s interfaces. 

The administrator’s Main Menu is identical to the student’s, with one exception: My Grades is 
inactive. The administrator’s Navigation Menu, however, may include one or two extra tabs, 
Content and Administration. Some administrative users, such as class instructors, do not need 
either Organization Administrator permissions or Content Administrator permissions, so their 
Navigation Menu appears identical to the student’s.  

Navigation 

Components 
Each page in LearnMate contains some or all of the following components: 

• Navigation Menu 

• Main Menu 

• Path Bar 

• Panels 

• Hyperlinks and Icons 
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Navigation Menu 
At the top of each page is the Navigation Menu, consisting of two tabs which take you to two 
different sections of the LearnMate system, My Desktop and Catalog. These tabs are always 
visible. In addition, users with Content Administrator permissions see the Content tab and users 
with Organization Administrator permissions see the Administration tab. 

 
• My Desktop: Provides access to your personal learning organizer, containing all the tools 

required to manage your learning experience. This is the default and LearnMate always opens 
into this page. See My Desktop on page 61. 

• Catalog: Provides access to all the classes in the LearnMate system, enabling users to see 
all classes available to their organization, the modules included in each class, and an 
enrollment start and end date, where relevant. Where permitted by the organization, students 
can self-enroll in the classes of their choice. See Catalog on page 147. 

• Content: Provides access to content editing and management tools, enabling you to add, edit 
and delete LearnMate modules, tests and assignments. This menu is only available to users 
who have been defined as content administrators. See Content Management on page 307, 
Content Authoring on page 373 and Test Authoring on page422. 

• Administration: Provides access to general administrative functions, such as managing 
users, assigning permissions and defining classes. This menu is only available to users who 
have been defined as system or organization administrators. See System Administration on 
page 159.  

Path Bar 
The Path Bar always appears immediately below the Navigation Menu. The Path Bar of each 
submenu and page is color-coded according to the color of the corresponding Navigation Menu 
tab. The text inside the Path Bar reflects your present position within the tree-structured 
organization of pages within the LearnMate system. This helps you maintain your orientation as 
you navigate around the system. 

Submenus 
Submenus are displayed just below the Navigation Menu, and provide access to the menu 
options. The submenus change, depending on the tab that has been selected on the Navigation 
Menu. Note that the current item on the submenu appears colored according to the color-code of 
the section. 
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• Content section (color code = purple): 

 
See Content Management on page 307, Content Authoring on page 373 and Test 
Authoring on page 422. 

• Administration section (color code = orange): 

 
See System Administration on page 159. 

Panels 
Most of the pages in the LearnMate system are divided into separate panels. Most panels are 
distinguished by a title in the top bar. The header panels at the top of the page sometimes do not 
have a title. 

Hyperlinks and Icons 
Located in appropriate places within the panels are text hyperlinks and pictorial icons which 
enable you to do many things within the LearnMate environment. Relocation hyperlinks are 
available to you at the top of many pages which are very long, enabling you to quickly jump to the 
panel you need. 

 
Because of the wide variety of tasks available to you, the system also provides Tooltip text to 
explain the function of the icons. Simply hold your mouse pointer over any icon for a second and 
the Tooltip text will appear in a little box by your mouse pointer. 
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Main Menu 
The Main Menu is displayed at the left side of the page, providing quick access to many 
commonly used LearnMate pages. Like the Navigation Menu, it is always visible. 

 

 

See the following sections: 

• My Calendar on page 23 

• My Inbox on page 31 

• My Folder on page 42 

• My Profile on page 51 

• My Grades: available only to students 

• My Favorites on page 57 

• Customer Support on page 59 

My Folder 
The number of megabytes of storage available to you in My Folder is set by the Organization 
Administrator. Storage space is allocated separately for Students, Instructors and Administrators. 
If you as instructor or administrator discover that you require more space than is currently 
permitted by the system, this setting can be changed from the Edit Organizations page. See 
Uploads on page 217. 

My Desktop 
There are two important differences between your My Desktop page and the student’s My 
Desktop page: 

• The classes listed are the classes for which you are the instructor. The Class Main Page for 
each class contains many new icons and hyperlinks that the students never see. 

Note: The LearnMate system enforces a rigid separation between students and 
administrators. The only way for an instructor to also serve as a student is to create a 
completely separate student user with its own username and password. See Creating a New 
User on page 226. It is highly recommended that instructors create a student user so that they 
can log in to LearnMate classes and see them from a student vantage point. 

• The Organization Chats and Organization Forums panels contain additional icons and 
hyperlinks which enable you to manage them. In addition, the Administration Chats panel lists 
all chats, including inactive chats which are normally invisible to the students.  
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Catalog 
There is one important difference between your Catalog page and the student’s Catalog page: 

Since a member of the administration cannot enroll in a class at all, the Enroll hyperlink does not 
appear and all its associated functions and pages are inaccessible to you. 

See Catalog on page 147. 

Review 
In this chapter, we covered the following material: 

• You learned how to navigate through the LearnMate system. 

• You learned about the distinctions between students and administrative users. 

Ask Yourself… 
• Can you find your way around the LearnMate system? 

• Do you know what to do if you do not see the tabs you require in the Navigation Menu? 

• Do you know how to enroll in a class? 
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8 
System Administration 

Review of Previous Chapter 
In Chapter 7: 

• You learned how to navigate through the LearnMate system. 

• You learned about the distinctions between students and administrative users. 

Introduction 
In this chapter, we will explore the System Administration tools available through the 
Administration tab on the Navigation Menu. The Administration submenu is only available to 
users who have been assigned Organization Administrator permissions. We will discuss 
permission levels later in this chapter. The Administration submenu provides access to functions 
such as report generation, organization management, user management and class management. 

By the end of the chapter, you will be able to modify user profiles, assign permissions, approve 
modules, manage organizations and generate reports. 

Note: If you discover that you require access to the options discussed in this chapter but you do 
not have an Administration tab on your Navigation Menu, contact your Organization 
Administrator. See Permissions on page 225. 

Objectives 
In this chapter, we will explore the following topics: 

• Reports 

• Organization Management 

• User Management 

• Replacements 

• Class Management 

• Organization Chats and Forums 
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Administration Overview 

 
See the following sections: 

• Reports on page 160 

• Organization Management on page 205 

• User Management on page 222 

• Replacements on page 234 

• Class Management on page 234 

Reports 

 
Reports is the first option available in the Administration submenu. Clicking on the 
Administration tab of the Navigation Menu opens to the Reports page by default. If you are 
already working in another part of the Administration section, you can also simply click on the 
Reports tab on the Administration submenu. 

From the Reports page, you can generate many useful reports that will provide metrics regarding 
class and student progress, enrollment, grades and more. Many different types of reports are 
available, but generally they can be classified into four general areas: 

• Competencies 

• Modules 

• System 

• User 

All reports are displayed on the user’s screen and may be printed out, if desired. Whether 
displayed or printed, all reports include the name of the user who has generated the report, 
together with the date and time of the report. Reports can be printed out from the Print Preview 
page or pop-up window. 

Tip: Reports, depending on the data requested, can often be quite length. In this case, you may 
prefer to print out just the first few pages. This can be done using the standard Windows Print 
interface. Right-click on the window and select Printfrom the Windows pop-up window, or select 
File > Print. Then select the number of pages desired in the Pages field in the Page Range panel. 

LearnMate v3.2 User Manual  160 
0609  System Administration 



  
 
List of Available Reports 
The following reports are available to all users who have Organization Administrator permissions, 
including both Instructor/Managers and Administrators. 

Note: The precise set of available reports may vary from organization to organization, as the 
Organization Administrator of a parent organization can control which reports are available to 
various sub-organizations. Similarly, users whose role is set to Administrator can access a wider 
range of reports than those whose role is set to Instructor/Manager. If you discover that you 
require access to a type of report that is not listed on your Reports page, contact your 
Organization Administrator or the Organization Administrator of your parent organization.  

Title Description 

Academic Progress Report, 
page 186 

Prints a listing of the grades of selected students on two tests given in the 
same class. 

Available Modules, 
page 170 

Prints a listing of all modules available in the selected Category(s). If All 
Categories is selected, the listing is sorted alphabetically according to 
Category. 

Class Grades, 
page 189 

Prints a listing of the grades of all students in a selected class, both the 
grade to date and the overall grade. Also permits printing detailed grade 
reports for selected students. 

Competencies per Module, 
page 163 

Prints a hierarchical representation of the competencies that have been 
mapped to a particular module(s). If multiple modules are selected, the 
report is organized module by module, arranged alphabetically according 
to the name of the module. 

Competencies per Skills 
Standard, 
page 166 

Prints the entire selected Skills Standard(s) in a hierarchical format. 

Enrollments, 
page 180 

Prints a listing of students who are enrolled in the selected class(es), with 
the following information: 

• First name 

• Last name 

• Username 

• Date of registration in the LearnMate system 
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Module Enrollments and 
Progress, 
page 172 

Prints a listing of all available modules in tabular format, together with: 

• The number of students enrolled in the module 

• The total number of times the module has been accessed 

• The average time spent in the module per login 

• The average number of logins per user 

• The average grade for students who have completed the module 

This report is a multi-level report. If generated for an Organization with 
multiple classes, clicking on the Organization name will open a new 
window displaying the data listed above, specifically for the classes 
selected. Clicking on a class name will then open an additional layer that 
will display the above information on a per student basis. 

Modules per Skills Standard, 
page 168 

Prints the entire selected Skills Standard(s) in hierarchical format. 
Folllowing each competency is a list of all modules mapped to it. 

Module Index, 
page 174 

Prints a listing of the Table of Contents of the selected module(s). 

Modules Studied per Day, 
page 177 

Prints a detailed listing of each launch of modules within a selected date 
range, sorted according to module. 

Test Grades, 
page 192 

Prints a detailed listing of grades of all students in a selected module in a 
selected class, sorted by the name of the test. 

User Competency Progress, 
page 194 

For each selected student, prints a listing of all competencies that have 
been mapped to modules that the student is enrolled in, organized by 
skills standard. For each competency, there is a notation of the degree of 
mastery: 

• Exposed: The student has completed a module that was mapped to 
the competency. Completion is defined as submitted the post-test, or 
if a module does not have a post-test then visited the last section of 
the module. 

• Understood: The student has answered questions that have been 
mapped to the Competency. 

• Mastered: The student has completed an Authentic Assessment(s) 
that was mapped to the Competency. 

User Details, 
page 199 

Prints a listing of the Personal Details and the Other Information 
contained in the LearnMate system about the selected user. 

User Logins 

Page 182 

Prints a detailed tabular listing of user logins for a specified time period, 
including the following information: 

• User’s real name and username 
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• Number of logins 

• Total time in the system 

• Average time in the system per login 

• Names of all classes in which the user is enrolled as a student or 
assigned as instructor 

Username and Password, 
page 202 

Provides a tabular listing of users in a selected class, including the 
following information: 

• User’s real name 

• Username 

• Password 

Reports – Competencies 

Competencies per Module 

 
Prints a hierarchical representation of the competencies that have been mapped to a particular 
module. If multiple modules are selected, the report is organized module by module, arranged 
alphabetically according to the name of the module. Under each module, all mapped Skills 
Standards are listed in hierarchical format.  

Skills standards are typically set up with the following hierarchy: 

• Content Standard 

• Skills Standard 
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• Standard 

• Strand 

• Competency 

In many skills standards, a competency is associated with a level (i.e. high school, middle school, 
K-6), as well as an identification  

This report is useful to Content Administrators who are preparing the mapping of content to Skills 
Standards. It is also useful to instructors who are designing curriculum for a particular class. 

This report can only be generated for the administrator’s own organization. 

 

To generate the Competencies per Module report: 

1. Select Administration > Reports List. The Reports List page is displayed. 

2. Click Competencies per Module, which is in the Competencies area. 

 
The Competencies per Module  page is displayed. 

3. Select the skills standards to be included in the report from the Skills Standards drop-down 
menu. Hold down the Ctrl key to select multiple skills standards. Select All Skills Standards to 
include all skills standards in the report. 

4. Select the modules to be included in the report from the Module drop-down menu. Hold down 
the Ctrl key to select multiple modules. Select All Modules to include all modules in the report. 
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5. Click Generate. The report is generated. 

 
On this page, there are a number of Expand  or Collapse  icons which you can use to 
control how much of the report is displayed.  

Tips:  

• If you intend to print out this report rather than just view it onscreen, select Print Preview first. 
When you get to the Print Preview page, you will find that the entire hierarchy is displayed in 
expanded form. Wait until you get to the Print Preview page before clicking on Expand  
and Collapse  icons to control how the report is printed out. 

• If the desired report is very long, you may prefer to print out just the first few pages. This can 
be done using the standard Windows Print interface. Right-click on the window and select 
Printfrom the Windows pop-up window, or select File > Print. Then select the number of pages 
desired in the Pages field in the Page Range panel. 
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Competencies per Skills Standard 

 
Prints the entire selected Skills Standard in hierarchical format. The entire text of each item is 
available at all four levels: 

• Skills Standard 

• Strand 

• Standard 

• Competency 
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Also shown are the ID number and Level of each individual Competency. 

This report is useful to Administrators who are preparing the mapping of content to Skills 
Standards. It is also useful to instructors who are designing curriculum for a particular class. 

This report can only be generated for the administrator’s own organization. 

To generate a Competencies per Skills Standard report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Competencies per Skills Standard in the Competencies area. 

 
The Competencies per Skils Standard page is displayed. 

3. Select a skills standard from the Skills Standard drop-down menu. 

4. Select content standards, strands and standards from the appropriate menus. Hold down the 
Ctrl key to make multiple selections. 

5. Click Generate. The report is generated.  

Tips:  

• On this page, there are a number of Expand  or Collapse  icons which you can use to 
control how much of the report is displayed. If you intend to print out this report rather than just 
view it onscreen, select Print Preview first. When you get to the Print Preview page, you will 
find that the entire hierarchy is displayed in expanded form. Wait until you get to the Print 
Preview page before clicking on Expand  and Collapse  icons to control how the report is 
printed out. 

• If the desired report is very long, you may prefer to print out just the first few pages. This can 
be done using the standard Windows Print interface. Right-click on the window and select 
Printfrom the Windows pop-up window, or select File > Print. Then select the number of pages 
desired in the Pages field in the Page Range panel. 
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Modules per Skills Standard 

 
Prints the entire selected Skills Standard in hierarchical format. After each Competency, there is a 
listing of modules which are mapped to it. 

This report is useful to Content Administrators who are preparing the mapping of content to Skills 
Standards. It is also useful to instructors who are designing curriculum for a particular class. 

This report can only be generated for the administrator’s own organization. 

 

To generate a Modules per Skills Standard report: 

1. Select Administration > Reports. The Reports List page is displayed. 

LearnMate v3.2 User Manual  168 
0609  System Administration 



  
 
2. Click Modules per Skills Standard in the Competencies area. 

 
The Modules per Skills Standard page is displayed. 

3. Select the skills standard to be reported on. Only one skills standard may be selected. 

 
4. Click Generate. The report is generated. 
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Tips:  

• When you generate this report, you are taken to the Modules per Skills Standard page. On 
this page, there are a number of Expand  or Collapse  icons which you can use to control 
how much of the report is displayed. If you intend to print out this report rather than just view it 
onscreen, select Print Preview first. When you get to the Print Preview page, you will find 
that the entire hierarchy is displayed in expanded form. Wait until you get to the Print Preview 
page before clicking on Expand  and Collapse  icons to control how the report is printed 
out. 

• If the desired report is very long, you may prefer to print out just the first few pages. This can 
be done using the standard Windows Print interface. Right-click on the window and select 
Printfrom the Windows pop-up window, or select File > Print. Then select the number of pages 
desired in the Pages field in the Page Range panel. 

Reports – Module 

Available Modules 

 
Prints a listing of all modules which are available in the selected Category. If All Categories is 
selected, the listing is sorted alphabetically according to Category. This report contains only 
modules whose status is set to Active. See Status on page 229. 

This report shows the name of the user who generated it, together with the date and time. It also 
displays the following information about the modules in tabular format: 

• Module name 

• Duration (hours) 

• Type 

This report is useful to Organization Administrators who do not have Content Administrator 
permissions. This information is available in a slightly different format on the Modules page under 
the Content tab of the Navigation Menu. 
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To generate the Available Modules report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Select Available Modules, which is in the Modules area. 

 
The Available Modules page is displayed. 

3. Select the categories to be included in the report, from the Category menu. To select multiple 
categories, hold down the Ctrl key. 

 
4. Click Generate. 

The report is generated. 

 
Tips: 

• An Index icon  is provided to allow you to view the module’s Table of Contents. Clicking on 
this icon brings up a new pop-up window displaying the entire Table of Contents in expanded 
form, together with a Print Preview hyperlink.  
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• On this pop-up page, there are a number of Expand  or Collapse  icons which you can use 

to control how much of the report is displayed.  

• If you intend to print out this report rather than just view it onscreen, select Print Preview first. 
When you get to the Print Preview page, you will find that the entire hierarchy is displayed in 
expanded form and that none of your modifications have carried over. Wait until you get to the 
Print Preview page before clicking on Expand  and Collapse  icons to control how the 
report is printed out. 

Module Enrollments and Progress 

 
Prints a listing of modules in tabular format, together with: 

• The number of students enrolled in the module 

• The total number of times the module has been accessed 

• The average time spent in the module per login 

• The average number of logins per user 

• The average grade for students who have completed the module 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. 
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The administrator may view and print Module Enrollments and Progress reports for his own 
organization and also for all sub-organizations. By selecting a combination of classes and 
modules, the administrator can tailor the report according to the needs of the moment. 

 

To generate a Module Enrollments and Progress report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Module Enrollments and Progress, which is in the Module area. 

 
The Module Enrollments and Progress page is displayed. 

3. Select an organization from the Organization menu. Only one organization menu may be 
selected. All classes in that organization are then listed in the Class menu. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. All 
modules that are included in the selected classes are then listed in the Module menu. 

5. Select a module from the Module menu. To select multiple modules, hold down the Ctrl key.  
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6. Click Generate. The report is generated. 

 

Module Index 
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Prints a listing of the Table of Contents of the selected module. The name of each content object 
is listed in hierarchical format. This report contains only modules whose status is set to Active 
(see Adding a Module on page 310). 

This report is useful to Organization Administrators who do not have Content Administrator 
permissions. This information is available to Content Administrators in a slightly different format 
on the Index page of the selected module, as it appears under the Content tab of the Navigation 
Menu. The information is also available to any user who is able to launch the selected module and 
press the Index hyperlink. 

 

To generate a Module Index report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Module Index, which is in the Module area. 

 
The Module Index page is displayed. 

3. Select the module to be included in the report from the Module menu. To select multiple 
modules, hold down the Ctrl key. 

 
4. Click Generate. The report is generated. 
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Tips: 

• When you generate this report, you are taken to the Module Index page. On this page, there 
are a number of Expand  or Collapse  icons which you can use to control how much of the 
report is displayed.  

• If you intend to print out this report rather than just view it onscreen, select Print Preview first. 
When you get to the Print Preview page, you will find that the entire hierarchy is displayed in 
collapsed form and that none of your modifications have carried over. Wait until you get to the 
Print Preview page before clicking on Expand  and Collapse  icons to control how the 
report is printed out. 

Note: The administrator may view and print Module Index reports for his own organization but not 
for any sub-organizations. The reason is that sub-organizations may not have released original, 
copyrighted content for distribution outside their own sphere of influence. If you require access to 
information about modules created within one of your sub-organizations, you must contact the 
following: 

• for authorization to copy copyrighted work, contact a Content Administrator in the appropriate 
sub-organization 

• for assistance in copying the data, contact  
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Modules Studied per Day 

 
Prints a detailed listing of each launch of modules within a selected date range, sorted according 
to module. The following information is provided: 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. 

Notes:  

• The administrator may view and print Modules Studied per Day reports for his own organization 
and also for all sub-organizations. By selecting a combination of classes and modules, the 
administrator can tailor the report according to the needs of the moment. 

• This report is only available to users whose role is set to Administrator. If you need to view or 
print this report, see Roles on page 223. 

 

To generate a Modules Studied per Day report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Modules Studied per Day, which is in the Module area. 
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The Modules Studied per Day page is displayed. 

3. Select an organization from the Organization menu. Only one organization may be selected. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. 

5. Select the dates to be included in the report, by clicking the Calendar icon  next to each of 
the Start Date and End Date fields. Select the dates from the calendar that is displayed. 
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6. Click Generate. The report is generated. It lists, for each module, the launch and logout times 

and dates for each user that studied the module during the specified time period. 

 
Tip: If the desired report is very long, the user may find it useful to print out just the first few pages, 
using the standard Windows interface. Right-click on the window and select Print from the 
Windows pop-up window. Then select the number of pages desired. 
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Reports – System 

Enrollments 

 
Prints a listing of students who are enrolled in the selected class, with the following information: 

• First name 

• Last name 

• User name 

• Date of registration in the LearnMate system 

This report is useful to instructors and administrators who wish to monitor the number of students 
currently enrolled in specified classes. Other than the registration date and the total count of 
students, this information is available to the class instructor from the Students panel of the Class 
Main Page. See Class Main Page on page 239. 

The top of the report shows the total number of students registered in the entire organization. 
Each class is then listed, showing the number of students currently enrolled in the class. 
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The administrator may view and print Enrollments reports for his own organization and also for all 
sub-organizations. 

 

To generate an Enrollments report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Enrollments, which is in the System area. 

 
The Enrollments page is displayed. 

3. Select an organization from the Organization menu. Only one organization may be selected. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. 

 
5. Click Generate. The report is generated. 

 

LearnMate v3.2 User Manual  181 
0609  System Administration 



  
 
User Logins 

 
Prints a detailed tabular listing of user logins for a specified time period, including the following 
information: 

• User’s real name and username 

• Number of logins 

• Total time in the system 

• Average time in the system per login 

• Names of all classes in which the user is enrolled as a student or assigned as instructor 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. It is also useful for administrators to monitor anomalous behavior, 
such as a user who is logged on too many hours in a day, or not enough hours in a specified week 
or month. 

The administrator may generate the report for individually selected users or all the members of a 
class. The administrator may view and print User Logins reports for his own organization and also 
for all sub-organizations. 
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Note: This report is only available to users whose role is set to Administrator. If you need to view 
or print this report, see Roles on page 223. 

 

To generate a User Login report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click User Login, which is in the System area. 

 
The User Login page is displayed. 

You have a choice either to generate the report for all users within a specified class (or 
classes), or to generate the report for specific users. 

To generate a report for all users within a specified class: 

3. Select an organization from the Organization drop-down menu. The list of classes in the 
selected organization are listed in the Class menu. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. 

5. Set the start and end dates for the reporting period, by clicking the Calendar icon  next to 
the Start Date and End Date fields. Select the dates from the calendars displayed. 
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The report is generated, detailing logins by all members of the selected classes. 

 
To generate a report for specified users only: 

3. Enter at least one of the following search criteria: 

� The student’s first name in the First name field. 

� The student’s last name in the Last name field. 

� Select an organization from the Organization drop-down menu. The list of classes in the 
selected organization are listed in the Class menu. 

� Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. 

 
4. Click Search. A list of all students that match the searach criteria is displayed. 
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5. Select the students to be included in the report.  

6. Set the start and end dates for the reporting period, by clicking the Calendar icon  next to 
the Start Date and End Date fields. Select the dates from the calendars displayed. 

 
7. Click Generate. The report is generated, detailing logins by the selected users. 

 
Tip: If the desired report is very long, the user may find it useful to print out just the first few pages, 
using the standard Windows interface. Right-click on the window and select Print from the 
Windows pop-up window. Then select the number of pages desired. 
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Reports – User 

Academic Progress Report 

 
Prints a listing of the grades of selected students on two tests given in the same class. If the tests 
are identical, the administrator is permitted to view a question-by-question comparison of the two 
tests. This is useful when the class post-test is also given as a pre-test. 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. The information is also available to instructors through the 
Gradebook. See Customize Gradebook on page 256. 

The administrator may view and print Academic Progress reports for his own organization and also 
for all sub-organizations. 

Note: This report is only available to users whose role is set to Administrator. If you need to view 
or print this report, see Roles on page 223. 

To generate an Academic Progress Report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Academic Progress Report, which is in the User area. 

 
The Academic Progress Report page is displayed. 

3. Select an organization from the Organization drop-down menu. 
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4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. In 

general though, you should only select one class, as this report is designed to measure 
progress made in a specific class. 

 
5. Click Generate. 

6. To select module tests for comparison, select a module from the Module drop-down menu, 
and two tests from the Tests menu. To select class tests, set the Module drop-down menu to 
Select a Module. The Tests menu will then list class tests. Select two class tests. 

 
7. Select students of interest from the list, or select all students using the top checkbox. 
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8. Click Generate. The report is generated. For each selected student, the results of the two tests 

are shown. 

 
9. If the tests selected contain an identical set of questions, you may click on any student’s 

name. 

 
The student’s Academic Progress Report is displayed in a new window. It compares the 
student’s grades for each test question. 
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Class Grades 

 
Prints a listing of the grades of all students in a selected class, both the grade to date and the 
overall grade. Also permits printing detailed grade reports for selected students. 

A student who has a Grade to Date of 100% has answered all questions correctly so far. 
However, the Overall Grade is the percentage of grade points which have been earned out of the 
total course. Thus, halfway through the course, that same student will have an Overall Grade of 
50%. 

The basic report provides the class average for both the Grade to Date and the Overall Grade. 
Below that information is a table giving the individual Grade to Date and Overall Grade alongside 
the students’ names. This report contains a number of hyperlinks which cause the generation of 
detailed reports. 

• Clicking on the Grade to Date next to a student’s name produces a report for that one student, 
showing all grades in the class, calculated on a Grade-to-Date basis. 

• Clicking on the Overall Grade next to a student’s name produces a report for that one student, 
showing all grades in the class, calculated on an Overall Grade basis. 

• Clicking on the Average Class Grade to Date produces a report for all students, sorted 
alphabetically by name, showing all grades in the class calculated on a Grade-to-Date basis. 

• Clicking on the Average Class Overall Grade produces a report for all students, sorted 
alphabetically by name, showing all grades in the class calculated on an Overall Grade basis. 

The information is also available to instructors through the Gradebook. See Customize 
Gradebook on page 256. Administrators may view and print Class Grades reports for his own 
organization and also for all sub-organizations. 

Note: This report is only available to users whose role is set to Administrator. If you need to view 
or print this report, see Roles on page 223. 

LearnMate v3.2 User Manual  189 
0609  System Administration 



  
 
To generate a Class Grades report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Class Grades, which is in the User area. 

 
The Class Grades page is displayed. 

3. Select an organization from the Organization drop-down menu. The organization classes are 
then listed in the Class menu. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. 

 
5. Click Generate. The report is generated. 
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6. As previously discussed, click on a student’s Grade-to-Date or Overall Grade to generate 

reports such as the one shown below. 

 
7. Click on the Average Class Grade-to-Date or Overall Grade values to generate a similar 

report, but for all class students, as discussed above. 

Tips: 

• When you generate either one of the Average Class reports, a new pop-up window opens 
containing the Print Preview. On this page, there are a number of Expand  or Collapse  
icons which you can use to control how much of the report is displayed.  

• If you intend to print out this report rather than just view it onscreen, select Print Preview first. 
When you get to the Print Preview page, you will find that the entire hierarchy is displayed in 
expanded form and that none of your modifications have carried over. Wait until you get to the 
Print Preview page before clicking on Expand  and Collapse  icons to control how the 
report is printed out. 

• If the desired report is very long, the user may find it useful to print out just the first few pages, 
using the standard Windows interface. Right-click on the window and select Print from the 
Windows pop-up window. Then select the number of pages desired. 
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Test Grades 

 
Prints a detailed listing of grades of all students in a selected module in a selected class, sorted by 
the name of the test. 

According to need, the administrator may select: 

• One class, several classes or all classes 

• One module, several modules or all modules 

• One test, several tests or all tests 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. The information is also available to instructors through the 
Gradebook. See Customize Gradebook on page 256. 

Note: This report is only available to users whose role is set to Administrator. An administrator 
may view and print Test Grades reports for his own organization and also for all sub-organizations. 

To generate a Test Grades report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Test Grades, which is in the User area. 

 
The Test Grades page is displayed. 
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3. Select an organization from the Organization drop-down menu. The Class menu then lists all 

classes in the selected organization. 

4. Select a class from the Class menu. To select multiple classes, hold down the Ctrl key. The 
Module menu then lists all modules in the selected class(es).  

5. Select a module from the Module menu. To select multiple modules, hold down the Ctrl key. 
The Test menu then lists all tests included in the select module(s). If you would like to generate 
a report for a class test, select All Modules from the Module menu. 

6. Select a test from the Test menu. To select multiple tests, hold down the Ctrl key. 

 
7. Click Generate. The report is generated. 
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User Competency Progress 

 
For each selected student, prints a listing of all individual Competencies which have been 
mapped to modules that the student is enrolled in. For each competency, there is a notation of the 
degree of exposure: 

• Exposed 

• Understood 

• Mastered 

According to need, the administrator may select the following: 

• One or more Skills Standards 

• One class or all classes 

• One selected student or all students 
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When you generate a User Competency Progress report, you are taken to the User Competency 
Progress page. The page is generated in expanded form and there are a number of Collapse  
icons at various nodes. However, these icons are inactive and cannot be used to collapse part of 
the tree. The report is organized student by student. After each student’s name are headings with 
the names of the selected Skills Standards. After each Skills Standard is a complete verbal 
description of the entire hierarchy of the Skills Standard, but only those specific Competencies 
that the student has been exposed to. Adjacent to each Competency are three columns, 
indicating Exposed, Understood and Mastered. 

• Exposed: a check mark here indicates that the student has completed one or more modules 
which have been mapped to the designated Competency. If the user viewed more than one 
module associated with the competency, the number of modules appears in parentheses next 
to the Exposed checkmark. 

• Understood: The first number in this column indicates the student’s cumulative average 
grade on questions which have been specifically mapped to the designated Competency. 
Following this number is a number in parentheses which indicates the number of questions 
which address the Competency. 

• Mastered: The numbers in this column relate ONLY to Authentic Assessment questions 
which have been specifically mapped to the designated Competency. The first number in this 
column indicates the student’s cumulative average grade, and the number in parentheses 
indicates the number of Authentic Assessment questions which address the Competency 
(see Question Types on page 423). 

This report is useful to instructors who wish to monitor the activity of their students in progressing 
through the assigned modules. It is also useful to members of the administration who wish to 
monitor the academic progress of the student body as a whole. 

Note: The skills standards available are those of the administrator’s own organization. A report for 
a sub-organization in relation to specific Skills Standards that are available to that 
sub-organization must be generated by an administrator in that sub-organization. If you are 
preparing a User Competency Progress report and you do not see the appropriate Skills Standard, 
contact an administrator in that sub-organization or create a new user. See Creating a New User 
on page 226. 

The administrator may view and print User Competency Progress reports for his own organization 
and also for all sub-organizations. 

 

To generate a User Competency Progress report: 

1. Select Administration > Reports. The Reports List page is displayed. 
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2. Click User Competency Progress, which is in the User area. 

 
The User Competency Progress page is displayed. 

3. Select the skills standards to be included in the report from the Skills Standard menu. To 
select multiple skill standards, hold down the Ctrl key. 

You have a choice either to generate the report for all users within a specified organization or 
class, or to generate the report for specific users. 

To generate a report for all users within a specified organization or class: 

4. Select the organization frm the Organization drop-down menu. The Class menu then shows all 
classes in the selected organization. 

5. Optionally, select a class from the Class menu. You may not select more than one class. If you 
select Select a Class, the report will be based on all classes. 
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6. Click Generate. The report is generated. 

 
 

To generate a report for specified users only: 

7. Enter at least one of the following search criteria: 

� The student’s first name in the First name field. 

� The student’s last name in the Last name field. 

� The student’s username in the Username field. 

� Select an organization from the Organization drop-down menu. The list of classes in the 
selected organization are listed in the Class menu. 

� Select a class from the Class menu. You may only select one class. If you select Select a 
Class, the report will be based on all classes. 
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8. Click Search. A list of all students that match the searach criteria is displayed. 

9. Select the students to be included in the report.  

 
10. Click Generate. The report is generated. 
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User Details 

 
Prints a listing of the Personal Details and the Other Information contained in the LearnMate 
system about the selected user. 

This report is useful to administrators or instructors who need to maintain contact information for 
students, instructors and other users. The information is also available to administrators under the 
Users tab in the Administration submenu. See Creating a New User on page 226.  

Tip: If the desired report is very long, the user may find it useful to print out just the first few pages, 
using the standard Windows interface. Right-click on the window and select Print from the 
Windows pop-up window. Then select the number of pages desired. 

The administrator may view and print User Details reports for his own organization and also for all 
sub-organizations. 

To generate a User Details report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click User Details, which is in the User area. 
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The User Details page is displayed. 

You have a choice either to generate the report for all users within a specified organization or 
class, or to generate the report for specific users. 

To generate a report for all users within a specified organization or class: 

3. Select the organization frm the Organization drop-down menu. The Class menu then shows all 
classes in the selected organization. 

4. Optionally, select a class from the Class menu. You may not select more than one class.  

 
5. Click Generate. The report is generated. 
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To generate a report for specified users only: 

3. Enter at least one of the following search criteria: 

� The student’s first name in the First name field. 

� The student’s last name in the Last name field. 

� The student’s username in the Username field. 

� User notes made about a student in the User Notes field. 

� Select an organization from the Organization drop-down menu. The list of classes in the 
selected organization are listed in the Class menu. 

� Select a class from the Class menu. You may only select one class. If you select Select a 
Class, the report will be based on all classes. 

 
4. Click Search. A list of all students that match the searach criteria is displayed. 

5. Select the students to be included in the report.  

 
6. Click Generate.  

The report is generated for all selected users. 
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Username and Password 

 
Provides a tabular listing of users, in tabular form, including the following information: 

• User’s Last and First Names 

• Username 

• Password 

The top part of this report lists all users who are not enrolled in any class, including all instructors 
and administrators. According to need, the administrator may generate this report in connection 
with a single class or all classes. 

The next portion of the report lists the selected class or classes. Under each class is a complete 
listing of all enrolled students  

This report is useful to administrators who wish to monitor users’ behavior.  

CAUTION: This report includes a plaintext printout of passwords. Any printed copies of this report 
must be handled with appropriate security procedures. 

Tip: If the desired report is very long, the user may find it useful to print out just the first few pages, 
using the standard Windows interface. Right-click on the window and select Print from the 
Windows pop-up window. Then select the number of pages desired. 
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The administrator may view and print Username and Password reports for his own organization and 
also for all sub-organizations. 

 

To generate a Username and Password report: 

1. Select Administration > Reports. The Reports List page is displayed. 

2. Click Username and Password, which is in the User area. 

 
The Username and Password page is displayed. 

You have a choice either to generate the report for all users within a specified organization or 
class, or to generate the report for specific users. 

To generate a report for all users within a specified organization or class: 

3. Select the organization frm the Organization drop-down menu. The Class menu then shows all 
classes in the selected organization. 

4. Optionally, select a class from the Class menu. You may not select more than one class. If you 
select Select a Class, the report will be based on all classes. 
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5. Click Generate. The report is generated. 

 
 

To generate a report for specified users only: 

6. Enter at least one of the following search criteria: 

� The student’s first name in the First name field. 

� The student’s last name in the Last name field. 

� The student’s username in the Username field. 

� Select an organization from the Organization drop-down menu. The list of classes in the 
selected organization are listed in the Class menu. 

� Select a class from the Class menu. You may only select one class. If you select Select a 
Class, the report will be based on all classes. 

 
7. Click Search. A list of all students that match the searach criteria is displayed. 
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8. Select the students to be included in the report.  

 
9. Click Generate. The report is generated for all selected users. 

 

Organization Management 

 
Organizations is the second option available on the Administration submenu. If you are already 
working in another part of the Administration Section, you can simply click on the Organizations 
tab on the Administration submenu. If you are working in another part of the LearnMate system, 
you must first click on the Administration tab of the Navigation Menu. 

The LearnMate system allows Organization Administrators to set up a hierarchy of 
sub-organizations, making users, classes, modules and related matters more manageable. All 
data connected with one sub-organization is completely insulated from every other 
sub-organization. This provides a measure of privacy and security.  

It may be convenient, for example, for a university which is comprised of several colleges to have 
a separate sub-organization for each college, and for each college to have a separate 
sub-organization for each department. A school district may want separate sub-organizations for 
its high schools, middle schools and elementary schools. Each individual school may then be its 
own sub-sub-organization. 
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Parent organizations have a variety of functions that they can perform on their sub-organizations, 
such as running reports on sub-organization data, creating users in the sub-organization, 
assigning modules and skills standards, and importing mappings between skills standards and 
modules from the sub-organization. However, organizations on the same level of the hierarchy 
have no access to one another, nor do they have access to information in organizations higher 
than them in the tree.  

 

For example, in the organizational hierarchy shown in the graphic: 

• Maryland State Department of Education can run reports on, add users to and see some data 
for all of the organizations below it in the hierarchy (Howard County Schools, Montgomery 
County Schools, Windwston Churchill High School and Thomas Wootton High School). 

• Howard County Schools and Montgomery County Schools are completely insulated from one 
another – they cannot see any information from each other’s database. Likewise, they cannot 
see any data in the Maryland State Department of Education organization.  

• The same model is true of Winston Churchill High School and Thomas Wootton High School – 
they cannot see or share information with one another, nor can they see their parent, 
Mongtomery County Schools. 

It is important to choose the right structure for your organization when setting up your system for 
the first time, as it is difficult and time-consuming to make changes later, after the system has filled 
up with data.  

Some of the properties of an organization can be set up and modified by an administrator within 
that organization, while others can only be managed by an administrator of the parent 
organization. If you discover that you require access to a function that is not listed on your 
Organizations page, contact the Organization Administrator of your parent organization. Other 
functions are only available to an administrator of a sub-organization. If you discover that you 
require access to a particular function to deal with a sub-organization, you can either contact an 
administrator of the sub-organization or create a new administrative user for yourself for use in 
dealing with that sub-organization. 
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The properties that you can define for your own organization include the following: 

• Name and Description 

• Password for enabling user self-enrollment 

• System of Measurements (Metric or Imperial) 

• Interface language 

• Logo 

• Format for date and time 

• Format for users’ Welcome Name 

• Form of display of the Glossary 

• Whether users are allowed to set their own passwords 

• Customer Support contact information 

• Data limits on server space for different types of users 

For each different sub-organization, you can define all of the above, and in addition, you can 
determine precisely which subsets of the following are available to the sub-organization: Skills 
Standards, Modules and Reports. 

Note: By default, sub-organizations generally inherit the settings of the creating organization 
upon creation, so you should set all your own settings before creating any sub-organizations. For 
each sub-organization, carefully verify that each setting has been inherited correctly. 

Adjusting Settings for Your Own Organization 
As an administrator, you have control over most settings available for your own organization. For 
certain things, however, you must contact the Organization Administrator of your parent 
organization. We will cover those topics in the next section. See Creating a New 
Sub-Organization on page 217. 

1. Select Administration > Organizations.The Organizations page is displayed, showing a tree of all 
the organizations in the system. The first time you access this page, the only entry will be your 
own organization, unless sub-organizations were set up at the time of installation. 

2. Click  next to the name of your Organization.  
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The Edit page is displayed, consisting of three panels.  

� At the top is the Organization panel. This panel contains two editable fields, Name and 
Description. It also contains the non-editable Organization ID number that was 
automatically assigned by the system when your organization was created. 

 
� The next panel is the Organization Definitions panel. All of the fields displayed here are 

editable. 
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� The bottom panel is the Uploads panel, containing three editable fields. 

 
3. Make the required modifications. Descriptions of the various fields follow below. 

4. Click Save to save all your changes. The details are changed. 

Note: All editable fields on this page can be changed at any time. If you find that your needs 
have changed, simply return to this page and make whatever changes are required. 

5. To return to the Organizations page, click Back.  

Name 
This field is for the name of your organization. It must be a unique name that does not occur 
anywhere else in the LearnMate system. If you accidentally choose a name which is already in 
use, the system will give you an error message.  

ID 
The number displayed here is set automatically at the time the organization is created. You may 
want to write it down in a convenient place because it will be useful in identifying modules, tests 
and other items of content. The organization’s ID number cannot be changed. 

Description 

 
Write a short description of your organization or important information for all Organization 
Administrators to see. This information is only accessible to users with Organization Administrator 
permissions. 
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Password 

 
The Password checkbox and text field are used to enable self-enrollment. If Password is checked, 
users can click New User on the Login page, enter the password indicated here, and LearnMate 
will enroll them to the organization as students. See Self-Registration on page 17. 

To enable self-enrollment: 

1. Check the Password checkbox if you wish to allow users to self-enroll in the organization.  

2. Enter a password in the text field. The password must be unique to your organization. When 
saving, you will receive an error message if another organization is currently using the 
password you entered. 

3. Click Save.  

 

To change a self-enrollment password: 

1. Modify the password displayed in the Password text field. 

2. Click Save. 

 

To deactivate self-enrollment: 

1. Uncheck the Password checkbox. 

2. Click Save. You will be prompted with the following message. 

 
3. Click OK to continue to enable self-enrollment with the selected password. Click Cancel to 

deactivate self-enrollment. 

Measurement Type 
LearnMate Content is available in either Metric or Imperial measurements. Based on the type 
selected from this drop-down box, LearnMate can display your intelitek LearnMate Content 
modules in your organization dynamically in the measurement type selected.  
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To set the measurement type for your organization: 

1. In the Measurement Type drop-down box, select the measurement system which is most 
appropriate for your organization.  

2. Click Save. 

Note: After changing the measurement type for your organization, you must log out of LearnMate 
and then log in again for the change to take effect on your computer. The change will become 
effective for other users in the organization as they log in. 

Language 
The language chosen here is the language of the LearnMate interface. All pages and dialog 
boxes in the system will be presented to your users in this language. Currently, LearnMate is 
available in the following languages:  

• Chinese 
• Japanese 
• Korean 
• Spanish 
• Turkish 

To set the LMS interface language for your organization: 

1. In the Language drop-down box, select the measurement system which is most appropriate for 
your organization.  

2. Click Save. The change will take effect immediately after you click Save.  

Note: This drop-down only changes the language of the LMS interface. It does not change the 
language of the text in the content modules. Content modules in other languages must be 
installed separately. It will, however, change the language of the Content Viewer interface, 
including the icon tooltips and the interface of the popup windows. 

Organization Logo 

 
At the top left of every page is space for up to two logos, either the LearnMate logo, your own logo, 
or both. The logo must be 140 wide by 40 pixels high, and in either *.jpg or *.gif format. To upload 
your logo, click on the Set Picture icon . To select which icon or icons will be displayed, click the 
appropriate boxes. 
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The logo is also displayed in the upper left corner of the Test Viewer. However, there is only room 
for one logo in the Test Viewer. If you have uploaded a logo for your organization, it takes 
precedence over the default LearnMate logo. 

 
 

To change the logo parameters for an organization: 

1. Click in the Show LearnMate logo checkbox to select or unselect this option. 

2. Click in the Show organization logo checkbox to select or unselect this option. If you wish to 
display your organization’s logo, once you have selected this checkbox: 

� Click the Set Picture  icon. A message displays, indicating the recommended size for your 
organization logo. Click OK. 

 
Tip: If your organization logo is not exactly 140x40 pixels, we recommend modifying the 
size such that either the width or the height is exactly this length and then adding white 
space in the remaining parameter to then save it with these dimensions. Otherwise, 
LearnMate will stretch the logo to this size and it may appear distorted. 

The Upload Logo popup window is displayed. 
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� Click Browse The Choose File dialog box is displayed. 

 
Tip: At the top, right corner of this dialog box, select the View Menu  icon and select 
Thumbnails from the menu that appers. This will preview all graphics in the selected 
directory in thumbnail format, making it easier for you to select the desired logo. 

 
� Select the file to upload from your hard disk or network drive and click Open. The file name 

and location is now displayed in the Select Picture field. 
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� Click Upload Picture. The popup window closes and the Edit Organization page refreshes. 
The filename is now indicated in the Show Organization Logo field and the logo is 
displayed to the right of that field. 

 
� Click Save at the bottom of the Edit Organization page. If you forget to click Save, the logo 

will not be saved and you will need to repeat this process. 

Note: If you have uploaded an organization logo and wish to deactivate that logo, you need to not 
only uncheck the Show Organization logo checkbox, but also delete the text in the text field. Then 
click Save. 

Date and Time Format 
Because LearnMate is used internationally, the system offers several commonly used date and 
time formats. The Date and Time Format fields allow you to select the appropriate format for date 
and time for your organization. All dates and times in the system (e.g., date of receipt of inbox 
message, test expiration date, assignment start date, events, etc.)  will be displayed in the formats 
you choose here.  

1. Available date formats are shown below. Select from the Date drop-down list the date format 
that best fits your organization’s needs.  

 
2. Available time formats are shown below. The options include a 12-hr. or a 24-hr. clock. Select 

the desired time format from the Time drop-down list. 

 
3. Click Save.  

4. Look at the Welcome message at the top of your screen to ensure that it matches the date 
format you selected.  
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Welcome Name 

 
This is the name that appears after the word “Welcome” in the permanent bar at the top of the 
viewer. 

1. Select First Name to show the the user’s first name in the welcome message. 

2. Select Surame to show the the user’s surname in the welcome message. 

If you select both checkboxes, the user’s first name will be shown in front of the surname. For 
example Welcome John Smith. 

Prefix Before Name 
This is a name, word or abbreviation that appears after the word “Welcome” and before the user’s 
name. It is the same for all users. Possible choices here might include Mr., Dr., Engineer, Dear or 
Right Honorable. It is automatically separated from the name by a space. 

Suffix After Name 
This is a name, word or abbreviation which appears after the user’s name. It is not separated from 
the name by a space so if you wish for a space to appear between the Welcome Name and the 
suffix, you must manually enter one in the field.  

This field can be useful for giving an additional indication of the organization name. For example, 
a Workforce Investment Act organization may enter a suffix of “-WIA” after each user’s Welcome 
Name. 

Show Glossary Letters 
When the Glossary is displayed, by default, the 26 letters of the Latin alphabet are displayed for 
the user’s convenience in accessing the terms, as shown below.  

 
See Glossary Management on page 358.If your system language uses a non-Latin writing 
system, deselect this option. 

Note: The display alphabet does not include accented characters or other special characters. 
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Allow Users to Change Password 
Many instructors prefer to prevent students from changing the password set at the time of user 
enrollment. This setting allows you to prevent student users from making changes to their 
password. This option can be turned on and off at will. 

• If Yes is selected here, users will be able to change their own password as desired from the My 
Profile page in the Main Menu.  

• If No is selected, the Change Password hyperlink is removed from the My Profile page. Users will 
only be able to use the password set at the time of registration and/or as assigned/modified by 
the instructor.  

Note: At any time, an instructor can overwrite a user’s password on the Edit User page. See 
Creating a New User on page 226. Further, an instructor can generate the Usernames and 
Password report, which displays the usernames and passwords for all users in the selected 
organization/class. See Username and Password on page 202.  

Allowing users to change their own passwords results in decreased security for individual users, 
as they may make poor choices of password, but there is also a decreased workload for the 
system administration in generating passwords and distributing them to the users. Make the 
choice that is appropriate for your needs. 

Customer Support 
Customer support details are shown below the Main Menu. 

 
By default, the system inserts contact information for . These settings can remain as is. 
Alternately, you may insert the Email address and telephone number of your own system 
administration office.  

Note: When a user clicks on the Email address under the Main Menu, the user’s own mail 
program is opened with the address inserted in the To field of a new message. (The Email is not 
sent using the LearnMate Email facility.) The Email address must be a valid Email address that 
can be accessed outside of the LearnMate environment. 
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Uploads 
Every LearnMate user is allowed space on the LearnMate server for the uploading of files and 
attachments. These three fields control the amount of storage space (in Mb) allotted to each user 
type. Different user types – Student, Instructor/Manager and Administrators – can be assigned 
different amounts of storage space. This space is used by the following files: 

• Mail attachments in My Inbox 

• Files in My Folder  

• User files in assignment 

Depending on your needs, you may find that instructors need more space than students, or that 
administrators need less. Change the default settings based on your own experience. 

Note: Module and Class Resources and media uploads (graphics, animations, logos, video, 
audio) do not count against an administrator/instructor’s allowed space. 

Creating a New Sub-Organization 
To create a new sub-organization: 

1. Select Administration > Organizations. The Organizations page is displayed, showing a tree of all 
organizations in the system. 

2. Click on the Add Sub-Organization icon  next to the name of the organization that will be the 
parent. 

 
Note: The Add Organization icon  is disabled for the top organization in your own 
hierarchy. This icon is only for creating a sibling organization, and you cannot create any other 
organization on the same level in the hierarchy as your own. 

3. If you already have sub-organizations in your organization hierarchy, you can also click on the 
Add Organization icon  next to the name of any sub-organization that will be the sibling of the 
new sub-organization, or the Add Sub-Organization icon  next to the name of the organization 
that will be the parent of a sub-sub-organization. 
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4. Edit all fields just as you did for your own organization, and click Save. See Adjusting 

Settings for Your Own Organization on page 207. All of the same fields appear again on the 
Edit page, and there are three new hyperlinks in the Organization panel: 

� Skills Standards 

� Modules 

� Reports 

 
5. Click on each of these hyperlinks as explained in the next section. 

Note: When an administrator creates a sub-organization, that sub-organization is assigned by 
default most of the attributes of the creating organization, including server space type per user 
type, customer service mail and telephone number, language, measurement type, and more. 

Changing Settings for Sub-Organization 
Three additional organization settings can only be changed by the administrator of a parent 
organization: 

• Skills Standards 

• Modules 

• Reports 

Note: Skills standards, modules or reports can be assigned by the administrator of the 
sub-organization to any of the sub-sub-organizations under his or her direct control. You may 
assign one of these directly to the sub-sub-organization, skipping over the sub-organization, and 
when you do this, the skipped sub-organization does not automatically gain access to the affected 
item. In this case, if administrators of the skipped sub-organization desire access, they must 
contact you, not the administrator of the sub-sub-organization. 

LearnMate v3.2 User Manual  218 
0609  System Administration 



  
 
Skills Standards 
States, school districts and professional organizations have published many Skills Standards 
against which academic performance is measured and for which curricula are designed. The 
Organization Administrator of the parent organization is the person responsible for determining 
which Skills Standards are available to the sub-organization.  

1. Select Administration > Organizations.The Organizations page is displayed, showing a tree of all 
the organizations in the system. 

2. Click on the Edit icon  next to the name of the organization. The Edit page is displayed. 

3. Click on Skills Standards in the Organization panel. The Assign Skills Standards page is 
displayed. 

 
3. Select the Skills Standards you want to make available to the sub-organization and click Save.  

To check that these skills standards were properly assigned to the sub-organization: 

4. Log in to the sub-organization with a username assigned to that suborganization. 

5. Select Content > Competencies. The Competencies page is displayed, showing a list of all skills 
standards available to the organization. 

Modules 
The Module is the basic unit of content in the LearnMate system. Modules are assigned to a 
sub-organization by an administrator in the parent organization. Modules are added to a class by 
the assigned class instructor. Modules may be copied and edited, or new modules may be 
created, but only by Content Administrators.  

When a module is assigned to a sub-organization, the sub-organization is also automatically 
assigned the Category to which the module belongs. See Category Management on page 333. 

1. Select Administration > Organizations. The Organizations page is displayed, showing a tree of all 
the organizations in the system. 

2. Click on the Edit icon  next to the name of the organization. The Edit page is displayed. 
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3. Click on Modules. The Assign Modules to Organization page is displayed. 

 
4. Select the modules you want to make available to the sub-organization and click Save. 

 

To check that the modules were properly assigned to the sub-organization: 

6. Log in to the sub-organization with a username assigned to that suborganization. 

7. Select Content > Modules. The Modules page is displayed, showing a list of all modules 
available to the organization. The list of modules should include those which have been 
assigned by a parent organization, plus any that have been created from within the 
sub-organization.  

Reports 
There are many different types of reports available in LearnMate. See Reports on page 160. 
However, the precise set of reports available is determined by the parent organization. 

1. Select Administration > Organizations. The Organizations page is displayed, showing a tree of all 
the organizations in the system. 

2. Click on the Edit icon  next to the name of the organization. The Edit page is displayed. 

3. Click on Reports. The Assign Reports to Organization page is displayed. 
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4. Select the reports you want to make available to the sub-organization and click Save. 

Note: If your role is set to Instructor/Manager, this list may include the names of reports which do 
not appear on your own Reports page. These reports are accessible only by users whose role is 
set to Administrator. See List of Available Reports on page 161 and Roles on page 223.  

Editing an Organization 
All of the information about an organization that was editable at the time of creation can be edited 
later. 

1. Select Administration > Organizations. The Organizations page is displayed, showing a tree of all 
the organizations in the system. 

2. Click on the Edit icon  next to the name of the organization. The Edit page is displayed, 
showing all the same editable fields that were available when the organization was created. 

3. Edit all fields that require changes, and click Save. 

See Adjusting Settings for Your Own Organization on page 207 and Changing Settings for 
Sub-Organization on page 218. 
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Deleting an Organization 
An organization can only be deleted by a user with administrative permissions. In order to delete 
an organization, an additional safeguard has been implemented – requiring the administrator to 
enter his/her password to ensure that he is absolutely sure that he wishes to delete the 
organization and is aware that he will lose all data related to that organization.  

A parent organization can only be deleted once all of its sub-organizations have already been 
deleted. 

1. Select Administration > Organizations. The Organizations page is displayed, showing a tree of all 
the organizations in the system. 

2. Click the Delete icon  next to the organization to be deleted. 

 
The Delete Confirmation message is displayed. 

3. Enter your password and click Delete. 

 
The organization is deleted. 

Critical Warning: By deleting an organization, you will lose ALL date related to that 
organization, including users, classes, grades, skills standards, content created by the 
organization and more. You must be absolutely sure before you perform this operation as 
there is no undelete function. 

User Management 

 
Users is the third option available on the Administration submenu. If you are already working in 
another part of the Administration Section, you can also simply click on the Users tab on the 
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Administration submenu. If you are working in another part of the LearnMate system, you must 
first click on the Administration tab of the Navigation Menu. From the Users page, you can do 
the following and more: 

• Create new users and manage their passwords, roles and permissions, as well as current 
status and identifying information.  

• Search for existing users to view their class enrollments and add them to new classes.  

• Move users from one organization to another, but only between organizations which are 
accessible to you.  

• Edit a user’s personal details, such as address or phone number. While student users can edit 
their own personal details, there are several parameters only available to instructors and 
administructors, such as uploading users’ pictures, overwriting users’ passwords, and 
assigning users to organizations and classes. 

You can search for, view and edit user profiles for any user in your organization and all of your 
sub-organizations. However, you have no access to users in your parent organization or any of 
your sibling organizations.  

Note: For security reasons, your ability to edit yourself as user is limited, no matter what your role 
or assigned permissions. You cannot edit any of the attributes listed in the Administrative Details 
panel of the Edit User page, including role, permissions, status, registration expiration, or 
organization. See Administration Details Panel on page 229. If you attempt to edit yourself from 
within the Administration section, you will be taken to the My Profile page. See My Profile on 
page 51. To return to the Administration section, click Back at the bottom of the page. 

Roles 
Each user is assigned a role in the system. Three roles are available: Student, Instructor/Manager 
and Administrator. The choice of role determines the options available to the user, as well as 
aspects of the LearnMate interface. For example, Student users can only see the My Desktop 
and Catalog menus, while Instructors and Administrators have the options of also seeing the 
Content and Administration menus.  

Role also determines the interface of pages available to all user types, as exemplified in the 
Modules panel in the Main Class Page. Student users have only the following options in this 
panel: take a pre-test, launch modules, view module resources and run software checks.  
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Student Interface 

Instructors and administrators are afforded of the student options, as well as the ability to add and 
delete modules from the class, define delivery options for the modules and the tests in those 
modules, add and delete modules to the class, upload and restrict module resources, and more. 

 
Instructor/Administrator Interface 

A user can have only one role. In some circumstances, a user may wish to teach one class and 
enroll in another as a student. In this case, two distinct users must be created in the system, one 
for each role. 

Note: Since each username must be unique, think about what names you wish to assign here. If 
the usernames differ by one final digit, they will come up together in searches for usernames, 
which may be more convenient for Organization Administrators. For example, brenda2t and 
brenda2s. If the usernames differ in their first letter, it may be more convenient for the user, since 
many browsers have an auto-complete feature. If the usernames are sbrenda and tbrenda, the 
user may be able to log on simply by typing “sb” or “tb”, though this method is less secure. 

Student 
Every new user is created as a Student. Once created, the user can be edited and the role can be 
changed. Students are the only users who are allowed to enroll in classes. They have a 
Gradebook that shows their academic progress, and they are not allowed any system 
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permissions for editing content or accessing system resources. They also may not be assigned as 
instructor for a class. 

Instructor/Manager 
This is the normal role for teachers and staff in the administrative office. Instructor/Managers are 
not allowed to enroll in classes and they do not have a personal gradebook. However, they may 
be assigned as instructor of any class, and may be assigned permissions for Content Editing and 
System Administration. 

Note: Instructor/Managers have somewhat limited Administrative permissions. They may not edit 
or delete any user whose role is Instructor/Manager or Administrator, and they may not access 
certain reports. While they may create their own Organization Forums and Organization Chats, 
they may not edit or delete Organization Forums and Organization Chats created by other users. 
If you are both primary LearnMate administrator and instructor, you would be better off being an 
Administrator rather than an Instructor/Manager.  

Administrator 
An Administrator is just like an Instructor/Manager, except that there are no restrictions on the 
available Administrative permissions. Administrators may edit or delete any user including one 
whose role is Instructor/Manager or Administrator, and they may access all reports which are 
available to your organization. An Administrator also has unrestricted rights to edit and delete 
Organization Forums and Organization Chats. See Organization Chats and Forums on page 245 
on page . 

Notes: Because of the great power of Administrators, it is wise to limit the number of users with 
this role. Your sub-organizations may not even need any users with this role, as long as there is 
someone in the parent organization who is always available to handle problems. 

Permissions 
Instructor/Managers and Administrators may be assigned Content Administrator permissions or = 
Organization Administrator permissions or both, depending on their needs. The presence of 
permissions is very obvious to the user, as color-coded tabs appear on the Navigation Menu 
indicating which permissions have been granted. See Navigation Menu on page 155. 

Content Administrator 
A Content Administrator has full, unrestricted rights to edit existing content and author new 
content within the system. See Permissions on page 225. A Content Administrator also has full 
editorial rights to the Media Bank and the system of assigned Categories. Further, content 
administrators can upload skills standards, map them to content and import mapped standards 
from sub-organizations. 

LearnMate Content consists of modules that the student reads in the Content Viewer, as well as 
tests and assignments which must be completed for a grade. LearnMate Content can include 
glossaries and libraries of URLs that are relevant to the modules. 
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See Content Management on page 307, Content Authoring on page 373 and Test Authoring 
on page 422. 

Organization Administrator 
An Organization Administrator has rights to manage organizations, users, classes and reports, as 
described in this chapter.  

Although the instructor assigned to a class has sole rights to control most features in the class, 
there are certain things which can be done only by a Organization Administrator, such as naming 
the class, assigning the instructor and copying the class.  

Creating a New User 
1. Select Administration > Users. The Users page is displayed. 
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2. Click Add. The Add User page is displayed. 

 
This page consists of three panels: 

� Personal Details 

� Account Information 

� Other Information 

Personal Details Panel 

 
1. Fill in the First Name and Last Name fields. These fields are mandatory. 

2. Fill in the Middle Name and Mail fields, if desired. The Mail field is for the user’s external 
e-mail address outside of the LearnMate system. The Mail field is not mandatory. However, if 
supplied, the user will be able to use the Forgot Your Password? link on the LearnMate login 
screen. This feature sends the user his or her username and password to the e-mail address 
entered. 

3. Fill in the ID field, if desired. This field must consist only of numbers, and may not be longer 
than 10 digits. 
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Account Information Panel 

 

Username 

1. Choose a unique username of four to nine characters. If you have requested a username that 
is already in use in the LearnMate database (even if it is in a different organization), you will be 
prompted to select a different one. Usernames may include numbers, but not accented 
characters or characters from non-Latin character sets. This field is mandatory. 

Important Note: A username cannot be changed once it has been registered in LearnMate. 

Password 
2. Enter a password in the Password and Verify Password fields. When choosing the password, 

consider the tips and tricks listed at Password Tips and Tricks on page 19. These fields are 
mandatory. This password can be edited by administrators and instructors. 

Other Information Panel 

 
1. Optionally, complete all desired fields in the Other Information panel.  

2. When all fields are completed correctly, click Save. 

3. The Add User page is refreshed and the following new items appear: 

� A new Administration Details panel at the top 

� A new Picture field at the bottom of the Other Information panel and  
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� A User Notes field in the Personal Details panel.  

The page is now called the Edit User page. 

Administration Details Panel 

 

Status 

The default Status setting is Active. If the user will no longer be a participating member of the 
class and/or organization, change this setting to Inactive. A student who is enrolled in a class 
cannot be changed from Active to Inactive. First, the user must be unenrolled from the class by 
the class instructor, and then the student’s status can be changed. See Unenrolling Students on 
page 279 and Assigning Instructor on page 237. A user who is Inactive is blocked from entering 
the system entirely. 

Note: When a user’s status is changed to Inactive, all data associated with the Main Menu (e.g., 
files in My Folder, messages in My Inbox) is preserved. However, Gradebook information and 
Assignments are lost when the student is unenrolled from classes. 

Role 

The default Role setting is Student. If desired, change this setting by selecting the appropriate 
role in the Role drop-down box. See Roles on page 223. 

Registration Expiration 

Registration Expiration allows you to set a date on which a user’s access to the system will be 
denied. This feature is particularly useful for instructors who wish to prevent students from 
accessing the system once the grading period/school year/etc. has ended. It is also an excellent 
tool for allowing users trial access to the system for a set period of time.  

To set a registration expiration for a user, click on the Calendar icon  and select the desired 
date from the pop-up window. This field cannot be filled in directly. When this date passes, the 
student will no longer be able to log in to the system. 
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Organization 

If this user will be reassigned to a sub-organization, make the selection from the Organization 
drop-down box. The default for this field is the organization of the creating user. If you are in a 
parent organization but are adding users to a sub-organization, be sure to change this selection. 

Classes 

1. To enroll the student in existing classes, click on Classes. The Classes page is displayed. 

 
2. In the Enroll User in Classes panel, select all desired classes. To select more than one class at 

a time, hold down your Ctrl key to select individual items, or your Shift key to select a range of 
adjacent items. When all classes have been selected, click Enroll. The page is refreshed, and 
the selected classes appear in the Class Enrollments panel. 

 
Adjacent to the name of each class is a View Grades icon. If you are not the instructor for the 
class, this icon is inactive and the tooltip text will read: Only the Class Instructor can 
view/modify grades. If you are the instructor of the class, the icon will be active and the tooltip 
text will read: View Grades. When you click on this icon, you will be taken to this student’s 
gradebook. See Grades on page 281. 
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Note: You cannot remove the student from classes from this page. Only the instructor of the 
affected class has this power. See Unenrolling Students on page 279 and Assigning 
Instructor on page 237. 

Permissions 

1. If you have changed the user’s Role from Student to Instructor/Manager or Administrator, the 
Classes hyperlink and associated text label are replaced with two checkboxes for selection of 
assigned permissions. See Roles on page 223. 

 
2. Select the permissions required by this user. See Permissions on page 225. 

Note: If you are the only instructor using LearnMate at your institution, it is recommended that 
you have both permissions. 

3. When all settings have been chosen, click Save. 

Personal Details Panel 
This panel contains additional fields that are not shown on the Add User page. 

 
� The Username field cannot be edited. 

� The User Notes field allows an instructor to enter text comments on a per user basis, which 
enables easier searching and reporting on users who meet specific criteria. This text field 
is unlimited. Text entered in this field is not viewable by the student. Hence this field is 
ideal for entering notes about the user that only the instructor or administrators should see, 
such as behavioral issues, special needs, sports teams, etc. 
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� The Password field can be edited, allowing a user’s password to be reset.  

Searching for a User 
1. Select Administration > Users. The Users page is displayed. 

 
2. Enter search criteria in one or more of the fields and click Search. You must enter at least one 

search parameter. It is not possible to search for All Users in All Organizations. The Users 
page is refreshed with a new Search Results panel at the bottom: 
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This page provides checkboxes for selection of users for deletion, and also icons for editing 
the users. 

Editing a User 
From time to time, it may be necessary to change certain aspects about a user. Some things are 
merely informational, such as address or telephone number. Other things affect the behavior of 
the entire LearnMate system.  

All user details can be changed except for the username. If a username absolutely must be 
changed, such as where a user is allowed to self-register but has chosen an inappropriate 
username, the user must be deleted and created again. To avoid loss of valuable data, this should 
be done at the earliest possible time. See Deleting a User on page 233. You can monitor the 
usernames students choose for themselves by running a Username and Password Report. See 
Username and Password on page 202. Then edit any of the required fields as described in 
Creating a New User on page 226. 

Note: If your Role is Instructor/Manager, Edit icons  appear only next to the names of students, 
not Instructor/Managers or Administrators. You are only allowed to edit students.  

Deleting a User 
When a user is no longer connected with your organization, the associated user in LearnMate 
should be deleted from the system. This action is not reversible and there is no Undo function. 
Deleting a user also deletes all data associated with that user, including grades, data saved in the 
user’s My Folder, saved mails and so on. 

Once a user has been deleted, that username can be reused in future. A new user assigned a 
previously deleted username is treated as a new user in all respects. 

Users cannot be deleted from the system until they are removed from all classes. This is true of 
both students and instructors. All classes that a student is currently enrolled in are listed in the 
Classes column. Likewise, all classes an instructor/administrator is teaching are also listed in this 
column.  

Students may only be removed from a class by the assigned instructor. See Unenrolling 
Students on page 279 and Assigning Instructor on page 237. The Delete checkbox will only 
become active when the student is no longer enrolled in any classes.This is a safety check to 
ensure that you do not delete data that you will later regret and need. 

Only a user whose role is Administrator may delete a user who is an Administrator or 
Instructor/Manager. If you see that the selection box to the left of the person’s name is grayed out 
and inactive and that there are no classes listed in the Classes column, you may not have the role 
required to delete the user. See Roles on page 223. 

Note: If the user has simply moved to a new organization, the user should not be deleted. Instead, 
the administrator of an organization that is sufficiently high in the organization hierarchy should 
move the user from one organization to another. See Organization on page 230. 
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To delete a user: 

1. Find the user as described in Searching for a User on page 232.  

2. Check the checkbox next to the user’s name and click Delete. 

 

 
You will be shown a warning dialog box. 

 
3. Confirm the deletion by clicking OK. 

Replacements 
Replacements is the fourth option available in the Administration submenu. It allows you to view 
and change the dynamic replacements within LearnMate modules. If you are curious, you may 
view the list of replacements, but any changes will have a drastic impact on the display of text 
within the content. Therefore: 

This option is for  use only, and must not be used by other users. 

Class Management 

 
Classes is the fifth option available in the Administration submenu. If you are already working in 
another part of the Administration Section, you can simply click on the Classes tab on the 
Administration submenu. If you are working in another part of the LearnMate system, you must 
first click on the Administration tab of the Navigation Menu. 
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A class is defined as a group of students who are studying a specific content set with an 
instructor. The content set includes modules, tests and assignments. Once a class has been 
created, an Organization Administrator can copy the class, together with all its associated data. 
This might be done, for example, when there are substantially identical classes being taught at 
different times or by different instructors. For instance, if an instructor teaches a class that is 
identical except for the student roster, he may wish to copy that class and rename it according to 
the period in which it is taught (e.g.,Engineering Technology – Period 1, Engineering Technology 
– Period 2) . Likewise, if an instructor is teaching a class first semester and wants to carry over the 
student roster and some of the grades and/or content to the second semester, this feature is ideal. 

Each class is generally managed by its own instructor. See Class Management on page 253. 
However, only a Organization Administrator can rename the class, assign the class instructor or 
copy the class. The Organization Administrator also can view the Class Main Page and the 
modules associated with the class and, like the assigned instructor, can edit the following basic 
information: 

• Class description 

• Type (Laboratory or Virtual) 

• Whether students can enroll themselves in the class via the catalog 

• Room 

• Minimum and maximum limits on number of enrolled students 

• Start and end dates for enrolling 

• Number of Lab rotations (for Laboratory classes only) 

• Date and time of class meetings (for Laboratory classes only) 

All other matters related to setup of the class can only be done by the assigned instructor. See 
Class Details (Instructor) on page 256. If you discover that a particular class requires a change 
which you cannot make as administrator, contact the instructor.  

You can only view and edit classes within your own organization, not any of your 
sub-organizations. If you discover that you require access to a particular class in a 
sub-organization, you can either contact an administrator of the sub-organization or create a new 
administrative user for yourself to be used for dealing with that sub-organization. 

Administrators assign modules to a class based on the modules available to the organization. 
Once a class is set up, the administrator enrolls students in the class and the students can be 
enrolled in the modules assigned to that class. 

Creating a New Class 
To add a new class: 

1. Select Administration > Classes. The Classes page is displayed. 
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2. On the Classes page, click on Add at the bottom of the page. 

 
The Add Class page is displayed.  

3. Complete all required fields and click Save. 

 

Class Name 
Assign the class a name. Note that the system allows for multiple classes with the same name, 
however this can become confusing on the My Desktop page.  
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The system does not care how you distinguish them, so it is up to you to decide what naming 
convention works best for you. The class name can include numerals, punctuation and accented 
characters. The first character can be a numeral, if desired. The following are valid class names: 

• Basic Math, section A 

• Basic Math {A} 

• Math 100 

• Basic Math - 9:00 

• Basic Math (Möbius) 

• 101A: Basic Math 

 
Tip: A great deal of time and effort can be saved by taking advantage of the Class Copy function. 
See Copying a Class on page 241. If you have to set up five Basic Math classes, you should 
create one first. Then, when all modules, tests, assignments and related matters have been set 
up, make copies for the remainder of the class sections. The instructors assigned at that point will 
have a fully set up class, which they can modify according to their own needs and preferences. 

Assigning Instructor 
Every class must have an assigned instructor. Select an instructor from the drop-down list. 

 
Note: If the instructor you are searching for does not appear, it means one of the following things: 

• The user has not yet been created in the system. See Creating a New User on page 226. 

• The user’s status has been set to Inactive. See Status on page 229. 

• The user’s Role has not been changed from Student to Instructor/Manager. See Role on page 
229. 

• The user has been assigned to the wrong organization. See Organization on page 230. 
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Class Details (Administrator) 
The other attributes that may be set at the time of creation of a class are discussed below. These 
attributes may also be set by the assigned class instructor. 

1. Make all necessary changes and click Save.  

2. After you save the new class, several new fields appear for limiting the class size and limiting 
the dates that students may enroll themselves in the class via the Catalog. See Enrollment 
on page 239 and Enrollment Dates on page 240. Complete the relevant fields and click Save 
again. 

Note: This is the same page as the Edit Class page. It is identical in every respect except that it 
is called Add Class instead of Edit Class. See Editing a Class on page 242. 

Description 
The description is only seen by the class instructor and the Organization Administrators. Enter an 
appropriate, brief description. This does not appear in the Catalog, so it is not a place for an 
exhaustive syllabus of materials to be covered in the class. This field is optional and may be left 
blank. 

Type 
Classes are either Virtual or Laboratory. A Virtual class is not dependent on any lab equipment, 
and thus the students do not need to share resources. Virtual classes can be online classes 
where the students never meet face to face, or are scattered at locations throughout the world.  

Laboratory classes contain one or more modules which require the students to use certain 
equipment in the classroom. If there are two machines which the students must use in shifts, each 
machine should have its own module, and the system will take care of scheduling the rotations. 
See Rotational Schedules on page 262. 

 
Note: Regardless of whether the class uses shared equipment, you may find it convenient to set 
the class type to Laboratory anyway, so that the dates and times the class meets will show on the 
My Desktop page of all students and the instructor. 

Enrollment Via Catalog 
When checked, the Allow enrollment to class via catalog checkbox permits all interested students to 
enroll themselves in the class from the Catalog. See Enrolling in a Class on page 148. If the 
Allow enrollment to class via catalog checkbox is deselected, enrollment in the class can only be 
done by the instructor. This feature may be disabled on a class-by-class basis so that instructors 
can approve enrollments on the basis of completed prerequisites, administrative assignments, 
personal interviews or any other appropriate reason. See Enrolling Students on page 277. 
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Note: The Administrator does not have any permissions to place students in a class unless the 
Administrator is also the assigned class instructor.  

Room 
This field is for informational purposes only, and is viewed only by the class instructor and the 
Organization Administrators. This field is optional and may be left blank. 

Laboratory Details Panel 

 

Rotations 

This number must equal the number of modules in the class. It is only relevant to Laboratory 
classes, and the Laboratory Details panel does not appear at all for Virtual classes. This number 
is critical to generating a rotational schedule. 

Times 

Set the start and end time of the Laboratory class using the drop-down boxes. The start time must 
be before the end time. This field is only relevant to Laboratory classes, and the Laboratory 
Details panel does not appear at all for Virtual classes. 

Days 

Check the days that the class meets by checking the appropriate days of the week. This field is 
only relevant to Laboratory classes, and the Laboratory Details panel does not appear at all for 
Virtual classes. 

Class Main Page  

Click Class Main Page to view the Class Main Page. If you are the assigned instructor, you have full 
rights to edit this page. If you are not the assigned instructor, you may only view this page. The 
administrator may not enroll any students and may not add any content to the class, such as 
Modules, Assignments, Class Tests, Chats or Forums.  

Enrollment 
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After you save the new class, two new fields appear for setting the minimum and maximum 
number of students in the class. The default numbers are 0 and 30. You can choose whatever 
numbers are appropriate for the class, but they must be set. These numbers are advisory. If the 
instructor reduces the class enrollment below the minimum number, a warning dialog box is 
presented. However, if the instructor attempts to add more students than are allowed by the Max 
Enrollment field, that action is blocked. Likewise, students will not be allowed to enroll in a class 
via the Catalog once the enrollment maximum has been reached. If desired, the instructor can get 
around this obstacle by changing the Max Enrollment field. 

Enrollment Dates 

After you save the new class, two new fields appear for setting the earliest and latest dates for 
students to enroll themselves in the class via the Catalog. These limits are only applicable to 
self-enrolling students. The instructor can enroll students at any time. 

Viewing Modules 
To view a list of the modules included in any class: 

1. Select Administration > Classes. The Classes page is displayed. 

2. On the Classes page, click on the View Class Modules icon  for the class of interest.  

 
The Class Modules popup window is displayed. 

 
If the class has been assigned modules, the modules are listed.. If the class does not yet have 
modules, a message indicates as such. 
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Copying a Class 
This function allows you, as Administrator, to make a copy of a class, complete with all modules, 
assignments, tests, chats, forums and the Class Gradebook, or a selection of thereof. This is 
beneficial to instructors who are teaching the same class either multiple times a week or over the 
course of several semesters.  

To copy a class: 

1. Select Administration > Classes. The Classes page is displayed. 

2. From the Classes page, click on the Copy Class icon  for the class of interest. 

 
The Copy Class pop-up window is displayed. 

3. Enter the name you wish to be assigned to the new class in the Name field. 

4. Select the features of the selected class that you want to be copied into the new class, and 
click Create Class. 

 
The Classes page refreshes. The new module is listed. 
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Note: 

• The class instructor is automatically copied with the class.  

• If you wish to change the class instructor, or other administrative class details (name, 
instructor, type, meeting times, etc.), you will need to edit the class from the Administration 
menu. See Editing a Class on page 242.  

• If you require changes to the contents of the class (modules, students, gradebook setup, 
assignments, chats, forums, resources), see Class Management on page 234.  

Editing a Class 
At any time, you may edit any of the administrative attributes of a class. The assigned instructor 
can also change all of these attributes from the Class Details page, except for the class name 
and the choice of assigned instructor. See Class Details (Instructor) on page 256. If you as 
administrator also happen to be the assigned instructor and wish to change the class name or 
assigned instructor, you must do it from the Edit Class page and not the Class Details page. 

To edit a class: 

1. Select Administration > Classes. The Classes page is displayed. 

2. On the Classes page, click on the Edit Class icon  for the class of interest. 

 
The Edit Class page is displayed. This page is identical to the Add Class page in every 
respect except the name of the page. See Class Details (Administrator) on page 238. 

3. Make the required changes and click Save. 

Note: Changes to classes that have been copied are only made to the class currently being 
edited. To make the same change to each of the copies of the class, you must either edit each of 
the copies separately or re-copy the class.  

Deleting a Class 
A user with administrative permissions can delete any class that is no longer needed. This 
procedure should be used sparingly. If a class will be taught by a different instructor next term, the 
modules, assignments, gradebook and all other associated data may still be useful. If the class is 
deleted and then re-created, all these settings will have to be done again. 
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In such a case, you may wish to instead archive your class. LearnMate offers an informal 
procedure for archiving classes. See Archiving a Class on page 244.  

Note: You cannot delete a class that has students enrolled in it. The class instructor must first 
unenroll all students. See Unenrolling Students on page 279. If necessary, you as administrator 
can temporarily assign yourself to be the class instructor. See Assigning Instructor on page 
237. It is not necessary to remove modules from the class before deletion, and it is not possible to 
remove the assigned instructor without putting another one in the position. 

To delete a class: 

1. Select Administration > Classes. The Classes page is displayed. 

2. On the Classes page, select the checkbox to the left of the class name, and click the Delete 
hyperlink at the very bottom of the page. 

 
You will be presented with the Delete Confirmation warning dialog box that asks for a 
password. 

 
The password required is your own personal password.  

3. Enter your password and click Delete. The class is completely removed from your organization. 

Note: Deletion of a class does not affect any classes that were created as copies of that class. 
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Archiving a Class 
While LearnMate does not have an official archiving feature, the following procedure will enable 
you to archive classes. All data will be retained for later reference, but you will not have to sort 
through all archived classes in your My Classes list each time you log in to the system.  

To archive a class: 

1. Select Administration > Users. The Users page opens. 

2. Add a new user in the system to be used for the purpose of archiving. Examples could include 
a username of Archive-2006 or Archive-Fall2005. The user should be assigned to the same 
organization as the classes you wish to archive. To review how to add new users to the 
system, see Creating a New User on page 226.  

 
3. Now select Administration > Classes. The Classes page is displayed. 

4. On the Classes page, click on the Edit Class icon  for the class you wish to archive.  

 
The Edit Class page opens. 

5. Select the new user you just created from the Instructor drop-down list. 

6. Optionally, change the name of the class to indicate that it is archived. For example, Robotics 
Engineering could become Robotics Engineering – Pd.1, 2005, Sem. 1.  

LearnMate v3.2 User Manual  244 
0609  System Administration 



  
 

 
7. Click Save once you have completed all required changes. 

8. Go to My Desktop. Note that the class no longer appears in your My Classes list. 

9. Logout of the system. 

10. Login as the new archive user. Note that the archived class now appears in this user’s My 
Classes list. 

Notes:  

• Any time you wish to access archived classes, you will need to log in to LearnMate with the 
archive username. You may wish to create a username per period of time you wish to archive 
(e.g. school year, semester, grading period). 

• When using this archiving procedure, note that you will not be able to delete or change the 
status of users who are enrolled in the archived classes. Users can only be deleted or 
changed to inactive once they are unenrolled from a class, even if it is an archived class. 

Organization Chats and Forums 
If your role is set as Administrator, you have unlimited rights to create, edit and delete chats and 
forums, which are available to your entire organization from the My Desktop page of every user. 

If your role is set as Instructor/Manager, you can create a new organization chat or forum, and you 
can modify or delete it. However, you can only view chats and forums created by other 
administrative users. 

Organization Chats and Forums can be used by all users in the system, regardless of their 
assigned role or permissions. They function exactly like the Class Chats and Forums, which are 
accessible only to the assigned instructor and the enrolled students of a particular class. To learn 
how to participate in chats and forums, see Chats on page 82 and Forums on page 91. 

Organization Chats and Forums should be set up to cover topics of interest to all students.  

Creating an Organization Chat 
An Organization chat may be created by users with either Instructor/Manager or Administrator 
roles. Instructor/Managers may only edit or delete Organization Chats that they have created 
themselves, while Administrators may edit or delete any chat. The set of icons next to the names 
of Organization Chats reflects the difference in roles. If you see that there are no Edit icons and no 
checkboxes for deletion, you may not have the role required to perform this function. Likewise, if 
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you see that the Edit icons, Archive icons and deletion checkboxes are grayed out (inactive). See 
Roles on page 223. 

 
11. Click on the My Desktop tab of the Navigation Menu.  

12. In the Organization Chats panel of the My Desktop page, click on Add. The Add 
Organization Chat page is displayed.. 

 
13. Fill in the required fields and click Save. 

Name 
This field is required. The text entered here will appear to all users. 

Description 
This field is optional. The information entered here is visible only to Administrators, the person 
who created the chat, and the Chat Manager. 

Selection of Chat Manager 
The person who created the chat is the default Chat Manager. To appoint a different Chat 
Manager: 

1. Click Chat Manager. This brings up the Search for User pop-up window. 
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2. Enter search criteria in one or more of the fields and click Search. 

Note: You must enter at least one search parameter. It is not possible to search for All Users 
in All Organizations. 

The Search for User window is refreshed with a new Search Results panel at the bottom: 

 
3. Click on the Select Chat Manager icon  next to the user you wish to appoint to the role.  

Note: You may appoint any user in the system as Organization Chat Manager, including a 
student. To learn more about the rights and responsibilities of a Chat Manager, see Chat 
Manager on page 87. Note that an Instructor/Manager who is appointed as Chat Manager has 
the additional ability of changing the Chat Manager or deleting the chat entirely. 
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Deactivating an Organization Chat 
A Chat requires the active involvement of the Chat Manager. When the time allotted for the chat 
has expired, the Chat Manager must deactivate the chat so that students cannot use it 
unsupervised. 

To deactivate a chat: 

1. Click on the My Desktop tab of the Navigation Menu.  

2. In the Organization Chats panel of the My Desktop page, click on the Edit Chat icon . The 
Edit Chat page is displayed. 

 
3. Select Inactive from the Status drop-down list. 

4. Click Save. The chat disappears from the My Desktop page of all students. On the My 
Desktop page of Instructor/Managers and Administrators, the Launch Chat icon  changes 
from Active to Inactive . 

 

Reactivating an Organization Chat 
1. Click on the My Desktop tab of the Navigation Menu.  
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2. In the Organization Chats panel of the My Desktop page, click on the Edit Chat icon . The 

Edit Chat page is displayed. 

3. Set the Status to Active and click Save. The Launch Chat icon should now be active for 
instructors and administrators, and the chat name should appear in the Chats list for students. 
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Deleting an Organization Chat 
You may wish to completely remove a chat from the system. In this case, you can delete the chat. 
Note that the difference between Deleting and Deactivating a chat is that when you delete a chat, 
all archives are lost, while when you deactivate a chat, the chat archives are retained and can be 
accessed at a later date once the chat is reactivated (see Deactivating an Organization Chat on 
page 248).  

1. Click on the My Desktop tab of the Navigation Menu.  

2. In the Organization Chats panel of the My Desktop page, select the checkbox next to the chat 
you wish to delete, and then click on Delete. 

 
3. Confirm the deletion. The chat is deleted from the list. 

Creating an Organization Forum 
Organization Forums are created in the same fashion as Organization Chats. Whereas class 
forums are only accessable by members of that class, organization forums are accessable by all 
an organization’s users. Organization forums should therefore be set up to cover topics of interest 
to all the organization’s users.  

1. Click on the My Desktop tab of the Navigation Menu.  

2. In the Organization Forums panel of the My Desktop page, click on Add. This brings you to the 
Add Organization Forum page.  
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3. Complete all fields. 

 
Note that the text entered in the Description field appears to all users at the top of the View 
Forum page when the Forum is accessed. 

 
14. Click Save. The chat is added to the list. 

Deactivating an Organization Forum 
The Forum Manager may deactivate the Forum at any time to prevent access by all users. 

To deactivate a Forum: 

1. Click on the My Desktop tab of the Navigation Menu.  

2. In the Organization Forums panel of the My Desktop page, click on Edit. This brings you to the 
Edit Organization Forum page. 

3. Select Inactive from the Status drop-down list. 

4. Click Save. On the My Desktop page of all users, the Launch Forum icon  changes from 
Active to Inactive . 

Deleting an Organization Forum 
Organization Forums are deleted in the same fashion as Organization Chats. 

1. Click on the My Desktop tab of the Navigation Menu.  

2. In the Organization Forums panel of the My Desktop page, select the checkbox next to the 
Forum you wish to delete and then click on Delete. 
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3. Confirm the deletion. The forum is removed from the list. 

Review 
In this chapter, we covered the following material: 

• Reports 

• Organization Management 

• User Management 

• Replacements 

• Class Management 

• Organization Chats and Forums 

Ask Yourself… 
• Can you generate reports? 

• Can you create sub-organizations and configure their settings? 

• Can you create new users? 

• Can you modify user profiles? 

• Can you move a user from one organization to another? 

• Can you set up a new class? 

• Can you copy an existing class? 

• Can you set up a chat or forum for your whole organization? 
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9 
Class Management 

Review of Previous Chapter 
In Chapter 9 we covered the following material: 

• Reports 

• Organization Management 

• User Management 

• Replacements 

• The Administrative Aspect of Class Management 

Introduction 
The class instructor is the primary person responsible for setting up the class. The class instructor 
makes all decisions about content and grading, as well as resources and tools available to 
students of the class. An Organization Administrator must create the class and assign the 
instructor, and may set or modify some of the initial settings, but everything else is controlled by 
the instructor. In many implementations, they may be one and the same. 

In this chapter, we will explore the Class Main Page of the assigned class instructor. We will learn 
how to add modules, tests, assignments and resources to the class. We will set up class chats 
and forums. Finally, we will learn how to set up the Gradebook, including all related functions. 

Note: For most functions, the class instructor does not need permissions for administration or 
content editing. For this reason, the Administration and Content tabs may not appear on your 
Navigation Menu. However, if you wish to create your own tests or assignments, you must have 
Content Administrator permissions. Likewise, if you are teaching two classes which are 
substantially identical, you must have Organization Administrator permissions to make a copy of 
the first class, once you have completely set it up. 

Objectives 
In this chapter, we will explore the following topics: 

• Average Class Grade 

• Utility Check 
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• Class Details 

• Customize Gradebook 

• Schedule 

• Modules 

• Students 

• Class Chats 

• Class Forums 

• Class Tests 

• Assignments 

• Class Resources 

 

For quick reference, consult or click on the desired item in this chart: 

 

TOPIC Page
Average Class Grade 255 

Utility Check 256 

Class Details 238 

Customize Gradebook 256 

Rotational Schedules 262 

Modules (Instructor) 269 

Students 277 

Grades 281 

Class Chats 287 

Class Forums 288 

Class Tests 288 

Assignments 297 

Class Resources 301 

Setting Up the Class – Class Main Page 
To set up a class, you must open the Class Main Page for that class. To open the Class Main 
Page for a class: 
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1. Click the My Desktop tab on the Navigation Menu. 

2. Find the name of your class in the My Classes panel at the top of the page.  

3. Click on the name of your class. This will bring you to the Class Main Page. If your class is not 
listed in the My Classes panel of My Desktop, contact an administrator.  

Header Panel 

 
The header panel is the unnamed panel at the top of the Class Main Page. At the top is your own 
name as instructor, and a convenient drop-down box that allows you to switch from one class to 
another without having to go back to the My Desktop page. It also contains the following items: 

• Average Class Grade 

• Utility Check 

• Class Details 

• Customize Gradebook 

• Schedule 

Average Class Grade 
LearnMate includes two different grade formats – Grade-to-Date and Overall Grade.  

• Grade-to-Date is based on the weighted grading activities currently taken by the student, 
without factoring in the grading activities that have not yet been taken. To simplify this 
concept, the grade-to-date is the grade the student would get if the instructor suddenly 
decided to end the class and base the grades only on activities completed so far. For 
example, if a student has two grades – an 80% for a grading activity weighted at 25% and a 
100% for a second graded activity weighted at 25% - the student’s grade-to-date is 90%, 
calculated as: ((80* .25)+(100* .25))* (100/(25+25)).  

• Overall Grade takes into consideration the grades that have not yet been completed from the 
student. To simplify this concept, the overall grade is the grade the student would get if he/she 
received a 0% on all remaining graded activities. In the same example above, the overall 
grade for the student would be 45%, calculated as (80*.25)+(100*.25). 

At the top of the Main Class Page, the Average Class Grade for the class is displayed.  This 
displays the average grade in Overall grade format. Therefore, until all grading activities for the 
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class are completed, this number may seem low as it is factoring in zeroes for all grading activities 
not yet completed. This number will increase throughout the course.  

Note: This number does not update automatically. You must click on Update Grades in the Students 
panel to update the Average Class Grade. See Updating All Students’ Grades on page 281. 

Utility Check 
This convenient hyperlink allows you to easily check whether your computer has all the required 
components for LearnMate to function correctly. You will probably use this most often when 
logging into the system from someone else’s computer, as the computers in your LearnMate 
laboratory are probably pre-loaded with the required software. 

See LearnMate Utility Check on page 6. 

Class Details (Instructor) 
The Class Details may be edited by the class instructor and also by any Organization 
Administrator. See Class Details (Administrator) on page 238. 

Customize Gradebook 
LearnMate offers a fully customizable gradebook. The LearnMate gradebook contains references 
to all activities in the class that contribute to the student’s final grade, including: 

• Module Tests 

• Class Tests 

• Assignments 

• Other Graded Activities (e.g., participation, homework, presentations, attendance, 
worksheets, research projects) 

You have complete control over the grade weights in your class. From the Customize 
Gradebook page, you can weight any of the above items based on the level of difficulty or 
importance they have to the class. 

If you see a Flag icon  here, it is a notification to you that the sum of all grading activities is less 
than 100%, which means that all grades reported throughout the system will be incorrect. The 
Tooltip text on this icon reads: Weights for class grading activities do not equal 100%. When you 
see it, you must click Customized Gradebook and adjust the values in your Gradebook. 

 
By default, when you initially add modules to a class, they are each given equal weightings, 
totaling 100%. If you subsequently remove modules from a class, the weightings of the remaining 
modules will be adjusted automatically. Note however that this is only remains true if you do not 
manually adjust the weightings in the gradebook. Once you have manually adjusted the 
weightings, the gradebook will not be automatically adjusted again – instead you will be warned 
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that the totals do not equal 100% and will be asked to adjust the gradebook accordingly. This is 
because LearnMate cannot assume how you wish to weight new grading activities and adjust 
existing activities once you have made changes. 

To customize the Gradebook: 

1. Click Customize Gradebook in the header panel of the Class Main Page 

 
The Customize Gradebook page is displayed. This page consists of multiple panels: 

� Module Grades: Lists each module in the class, with all the tests contained in that module 
(e.g., reviews, pre-test, post-test). 

 
� Class Test Grades: Lists all class tests that have been defined for the class. See Class 

Tests on page 288. 

 
� Assignment Grades: Lists all assignments that have been defined for the class. See 

Assignments on page 297. 

 
� Additional Grades: Additional grades are defined in the Additional Grades panel. See 

Defining Additional Grades on page 260. 

 
Note: You must always ensure that the Top Level Grades always total 100%, and that the 
lower-level grades in each module also always total 100%. 
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Defining Module Grades 

When a module is added to the class according to the procedure outlined in Adding Modules to 
Class on page 270, the corresponding Module Grades become part of the Gradebook. To 
customize the Module Grade weights, you must first attend to the tests that comprise the final 
module grade. The weights of all lower-level grades in the module must always total 100%. You 
will define the weight for the complete module later. 

As previously stated, if you have not made changes to the gradebook page and previously clicked 
Save, the module grades will default to 100 divided by the number of graded activities in the 
module. If, however, you have already clicked Save on this page, the module grades will be 0 by 
default. 

To define weights for the tests that comprise a module: 

1. Open the tree for a module, if it is not already open. 

2. Enter a weight for each test in the list, making sure that they all add up to 100%. Weights must 
always be entered as whole numbers. Fractions and decimals are not valid. 

Alternatively, click Average Module Grade Weights immediately below the name of the module to 
have the computer average the weights. 

 
Notes:  

� While many instructors may wish to see the students’ results for the various reviews 
(quizzes) at the end of each activity in a LearnMate module, they may also wish to exclude 
these grades from the students’ final grade. To prevent the review grades from being 
factored into the final grade for a module, leave their weight at the default 0%. If you 
choose this strategy, be sure to explain to students that they may see their test grades in 
their My Grades page, but that there will be no visible change to their cumulative grade. 

� If you have enabled a pre-test for the module (see Enabling Pre-Test on page 271), the 
pre-test is not included in the Customize Gradebook page as pre-tests are always 
weighted at 0%. The pre-test will, however, appear in the student gradebook – both in the 
instructor and student view. 

� The tests appear in the order in which they are given within the module. As such, the 
post-test is typically listed last. 

Note:  

3. Click Save Module Grade Weights below the module name. 
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4. Repeat steps 2 and 3 for all remaining modules. Later you will assign weights for each module 

in the gradebook. 

Tip: It is easier to concentrate on a particular module when you close the trees of all other 
modules in the gradebook. 

Defining Class Test Grades 

When the instructor manually adds Class Tests to the class according to the procedure outlined in 
Class Tests on page 288, the corresponding Class Test grades become part of Gradebook. Like 
with Module Grades, if the gradebook has already been modified from the default, the weights of 
a new class test are not automatically updated and are given the default value of zero.  

1. Define the weights of each Class Test by filling in the weights manually. 

 
2. Each individual Class Test is considered a Top Level Grade and alternatively can be changed 

by clicking the Average Top-Level Grades hyperlink at the top of this page. This hyperlink will 
average each of the top line items in the gradebook (e.g. module grade – not the grading 
activities within the module, class tests, assignments, other grades).  

 
Tip: Click Save often as you systematically weight the various components of the gradebook. 
Customizing the gradebook can be time consuming and you do not want to risk losing this 
valuable work.  

Defining Assignment Grades 

When the instructor manually adds Assignments to the class according to the procedure outlined 
in Assignments on page 297, the corresponding Assignment grades become part of 
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Gradebook. If the gradebook has already been modified from the default, the weights of new 
assignments are not automatically updated and are given the default value of zero.  

1. Define the weights of each Assignment by filling in the weights manually. 

 
2. Each individual Assignment is considered a Top Level Grade and alternatively can be 

changed by clicking the Average Top-Level Grades.  

Defining Additional Grades 

Additional Grades are grades for activities that are factored into the student’s final grade, but 
that are not automatically graded by the LearnMate system. The grades for these items may be 
calculated mathematically in an external spreadsheet or may be the teacher’s subjective 
assessment. They must be manually entered into LearnMate, as opposed to modules or tests, 
where LearnMate automatically grades each of the grading activities. 

Examples of Additional Grades could include (but are not limited to): 

� Attendance (Tardies) 

� Teamwork 

� Attitude 

� Citizenship 

� Lab Safety 

� Participation 

� Presentations 

� Research Projects 

These grades are defined in the Additional Grades panel of the Gradebook. Once an Additional 
Grade has been defined in the system, it is available to all instructors in the organization. 

To add an additional grade: 

1. Click Add in the Additional Grades panel.  

 
The Add Additional Grade pop-up window is displayed.  
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2. If the grading activity you want is listed in the Type drop-down menu, select it and click Add.  

3. If not, select Other. If you select Other, the New Type field is displayed. Enter in the name of 
the new activity in the New Type field and click Add. 

 
If you have previously changed the weights in the gradebook from the default (clicked Save in 
this page), a warning dialog box is displayed. 

 
3. Click OK. The pop-up window is refreshed. Repeat steps 1 through 3 as many times as 

needed, then click Close. The Customize Gradebook page is redisplayed, with the new grading 
activities listed in the Additional Grades panel.  

4. Manually enter the values in the fields next to the name of each item in this panel. Each of 
these grades is considered a Top-Level grade and is affected when you click Average Top-Level 
Grades.  

Adjusting Top-Level Grades 

Each line item in the gradebook (e.g., module, class test, assignment, additional grade) is 
considered a “top-level grade” in LearnMate. In the case of modules, the combined values of all 
the tests in a module constitute a single Top-Level grade. 

Tip: Before assigning weights to Top-Level grades it may help to collapse the modules by clicking 
the Collapse icon  next to each module name. 
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1. If you want LearnMate to assign average values to all of the Top-Level grades, now is the time 

to click the Average Top-Level Grades hyperlink at the top of the page.  

  
2. When you are satisfied with the values of your Top-Level grades and you are sure that these 

values total 100%, click Save Top-Level Grades at the top of the page. 

 
Your Gradebook is now complete.  

3. Click Back to return to the Class Main Page. 

 
You may return to the Gradebook at any time. Reweighting the grades is done according to the 
same procedure. 

Rotational Schedules 
A class may be designed to use two or more different kinds of equipment, each with its own 
instructional module. In this case, it is useful to split the students up into rotational groups so that 
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the equipment is used to maximum efficiency. LearnMate can generate the rotational schedules 
automatically. The resulting schedule can be displayed sorted by module or by student. 

This feature is applicable only to Laboratory classes. It is not available to Virtual classes because 
in a Virtual class, there is no physical equipment to be shared among different modules. 
Accordingly, the hyperlink does not appear for Virtual classes at all. See Type on page 238. 

Whether to use rotational schedule is optional. It is possible to run your laboratory without any 
rotational schedule at all – the choice is yours. Even if you use the system to generate a rotational 
schedule, you do not have to use it. 

Note: The number of rotations must be equal to the number of modules in the class. Make the 
required setting in the Class Details page. See Class Details (Instructor) at page 256. It is not 
possible to generate a rotational schedule before modules have been assigned to the class. See 
Adding Modules to Class on page 269. It is likewise impossible to generate a rotational 
schedule before students have been assigned to the class. See Enrolling Students on page 
277. 

Generating a Rotational Schedule 

To automatically generate a rotational schedule: 

1. Click Schedule at the bottom of the header panel of the Class Main Page. 

 
The Schedule page is shown. If a schedule has already been generated, it is displayed here. 
This is the same hyperlink that appears on the student’s Class Main Page. See Viewing a 
Schedule (Laboratory Classes Only) at page 69. 

2. Click Generate Rotational Schedule. 

 
The automatically generated schedule is shown, sorted by module. 
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3. To sort the rotational schedule by student, select Student from the Sort by drop-down list. The 

rotational schedule is displayed, now sorted by student.  

 
4. Click Back to return to the Class Main Page. 
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Note: It is not possible to erase a rotational schedule once it has been generated. It is possible 
though to generate a new schedule to replace the existing one. 

Restricting Students in Rotational Assignments 

You can flag certain students to prevent them from being assigned to the same rotational group. 
Perhaps two students do not get along, or the computer has broken up study groups that you 
have carefully put together. 

Tip: You can use this feature to preserve your study groups. Go through each of the students in 
Group 1, one at a time. Restrict each of these students from working with all students outside of 
Group 1. Repeat the procedure for each successive group until you achieve the result you want. 

To restrict student rotational assignments: 

1. Click Schedule Requirements at the bottom of the Schedule page. 

 
2. The Schedule Requirements page is displayed, listing all the students in the class. Click 

Student Restrictions next to the name of the student you are concerned with. 

 
3. The Student Restrictions page is displayed. Note: The name of the student you are working 

on appears in the Path Bar and does not appear in the list of names in the Enrolled Students 
panel. 
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4. Select all students who you do not wish to work with the selected student. To select multiple 

students, hold Ctrl while you click. When all affected students have been selected, click the Add 
Students icon  to move them from the Enrolled Students panel to the Restricted Students panel. 

 
5. Click Save. You are returned to the Schedule Requirements page. 

6. Repeat steps 2 through 5 as many times as necessary. Note: After you have restricted 
Student A from working with Student B, the change is reflected on the Student Restrictions 
page of both students. If you are trying to enforce study groups, this will save you a lot of time. 

Note: You can change these restrictions at any time using the same procedure. Remove 
students from the restricted list by clicking on their names in the Restricted Students panel and 
then clicking on the Remove Student icon . 
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Manually Adjusting an Automatically Generated Rotational Schedule 

You may find that the automatically generated schedule is unsuitable, even after taking your 
restrictions into account. You can override any part of the assignments, even putting two students 
in the same group after you have restricted them from working together.  

To manually adjust an automatically generated schedule: 

1. Click Manual Override.  

 
The Manual Schedule Override page is displayed. 

 
2. Select the student whose schedule you would like to adjust from the Student drop-down list. 

 
A list of all the class modules is shown, as well as the rotation number for each module. 

 
3. Select the desired rotation numbers for each module from the Rotation Number drop-down 

lists. Make sure that each module is assigned a unique rotation number. 
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4. Click Save. The Manual Override page is redisplayed. Other students are moved around to 

balance the modules. 

Note: If one module is a pre-requisite for another module, the schedule will be adjusted so 
that students will be forced to complete the first module before the second. (See Adding a 
Module 310 to learn how prerequisites are defined.) In order to change module pre-requisites, 
you must have Content Administrator permissions. If you do not have these permissions, you 
will not see a Content tab on your Navigation Menu. Contact your Organization 
Administrator. See Permissions on page 225. 

5. Click Back to return to the Schedule page. The schedule now reflects the manual change you 
made. 

 
7. Repeat steps 1 through 6 for as many students as necessary. 

8. Click Back to return to the Class Main Page. 
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Printing Rotational Schedules 

Rotational schedules must be printed using Windows Print interface. Open the rotational 
schedule of interest. Right-click anywhere in the browser window and select Print from the pop-up 
window, or select File > Print. 

Modules (Instructor) 
Modules are the basic unit of content in the LearnMate system. As class instructor, you must add 
modules to your class so that the subject matter materials may be delivered to your students. 

If you do not have Content Administrator permissions, you may not edit or create modules for 
inclusion in your own class, but you can include any modules which are available to your 
organization. If you do not have Content Administrator permissions, you do not have a Content 
tab on your Navigation Menu. If you need to edit or create modules but do not see this tab, 
contact your Organization Administrator. See Permissions on page 225. 

The creation and editing of modules and tests that are included in modules is discussed in detail in 
the chapters Content Management on page 307 and Test Authoring on page 422 

Note: Once you have added modules to your class, you must define how module tests are used in 
the class (see Defining Module Delivery Options on page 270), adjust the gradebook (see 
Defining Module Grades on page 258), and, in Laboratory classes, adjust the rotational 
schedule (see Rotational Schedules on page 262). 

Adding Modules to Class 
To add a module to a class: 

1. Click Add in the Modules panel of the Class Main Page. The Add Module page is displayed. 

 

Select Modules for Addition 

2. Select the modules to be studied in this class from the large scrollable list in the Add Module 
panel. To select multiple modules, hold the Ctrl key when you click.  

Note: It is more time-efficient to add multiple modules to the class at the same time. Addition 
of modules affects the Gradebook, and in Laboratory classes, it also affects the rotational 
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schedule. See Defining Module Grades on page 258 and Rotational Schedules on page 
262. 

Specify Open Index Navigation 

3. If this checkbox is selected, the student will be able to view the entire module index (table of 
contents), and will be able to jump to any content within the module at any time. If it is not 
selected, the student will be forced to advance through the module serially, and will only be 
able to jump backwards to sections they are have already visited. 

4. Click Add. The modules are added to the Modules panel of the Class Main Page. 

Note: The addition of modules to the class causes changes in the Gradebook. See Defining 
Module Grades on page 258. You must also define how the modules are to be used in class. 
See the next section. 

Defining Module Delivery Options 
While the index of a module and its contents are the same for all classes, you can specify several 
ways in which the module is used in your particular class: 

1. In the Modules panel of the Class Main Page, click the Define Delivery Options icon  next to the 
module whose usage you wish to define.  

 
The Define Delivery Options page is displayed. 

 
The first item under the path bar is the Open Index Navigation checkbox. Here, you may 
review and change the setting that was specified when the module was added to the class. 
See Specify Open Index Navigation on page 270. 
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Enabling Pre-Test 

2. If you want the students to take a pre-test before launching the module, check the Enable 
Pre-Test checkbox. A new Pre-Test icon  appears next to the name of the module in the 
Modules panel for both student and instructor. 

 
In the Modules panel of the students’ Class Main Page the Launch icon  appears disabled 

. After the student completes the test, the Pre-Test icon vanishes and the Launch icon 
becomes active. The Pre-Test icon  remains on the instructor’s Modules panel. 

 
The default pre-test is the post-test that has been created for the module, but you can specify 
any other test in the system. (See Adding/Creating a Post-test on page 314.) 

Tip: Using the post-test as a pre-test enables you to create a question-by-question report 
showing the students’ improvement over the course of the module. See Academic Progress 
Report on page 186. 

Selecting Pre-Test 

To select a test to use as the pre-test: 

3. Click on the Add icon  to the right of the blank field. This takes you to the Add Pre-Test 
page. 

 
4. Enter at least one search parameter and click Search. This causes the page to refresh, with a 

new Search Results panel at the bottom. 
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Each test is listed with the following information: 

� Test ID number: The first number is the number of the test. After the hyphen, there is the 
ID number of the organization which created the test. 

� Title: This is the actual Name of the test 

� View Test icon : Clicking on this icon calls up the Test Viewer, enabling you to preview 
the entire test to make sure it is the one you want. 

� Add Test icon : Clicking on this icon adds the selected test as the Pre-Test for the 
module you are working on. You are returned to the Define Delivery Options page. 

Test List Panel 

The bottom panel on the Define Delivery Options page is the Test List panel. At the top is a 
drop-down box for selection of the Module Tests. The options below can be set individually for 
each test, or the same settings can be applied to all tests. The choice of option sometimes causes 
new choices to appear in this panel, as explained below. 
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Select Test 

5. Select the test whose delivery options you want to set. Click on the arrow on the drop-down list 
and click on your selection. Note that the tests are listed in the order in which they appear in 
the module. If you would like to set the same settings for all tests simultaneously, select All 
Tests from the drop-down menu. 

 

Preview Test 

6. To preview the test you have selected, click View Test at the bottom of the panel.  

 
This action calls up the Test Viewer, enabling you to preview the entire test to determine the 
most appropriate Test Delivery settings. 
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Note: The View Test function does not work if All Tests is selected from the Test drop-down 
menu. 

Test Navigation 

7. Test Navigation is similar to Module Navigation but it is a separate setting. Your choice here 
determines whether the student is forced to proceed serially through the test (Locked) or may 
jump around through the test using the Test Navigation Bar (Open). See Launching a Test 
on page 103. 

 

Number of Retakes 

8. Specify the number of times you want to allow the students to take this particular test. If you 
enter zero, the number is unlimited. If you enter any number other than 1, a new drop-down 
box appears, allowing you to specify how the final test grade is calculated. Choose the option 
that is most suitable for this test. 

� Best: The best grade of all tries 

� Last: The grade on the last attempt 

� Average: The average of all tries 
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Time Limit 

9. Enter the amount of time you wish to allow for this test, measured in minutes. Entering zero or 
leaving the box blank indicates unlimited. 

Availability Dates 

10. Select the dates you wish to allow access to this test. These dates can only be set by clicking 
on the Calendar icon . To clear the dates, click on the Clear Dates icon  to the far right. 

Authentic Assessment Questions 

Authentic Assessment Questions are used to determine the student’s mastery of the Competency 
which is associated with the question. See Competencies on page 337. If the test does not 
contain any Authentic Assessment Questions, this parameter is irrelevant and can be ignored. 

11. If there are any Authentic Assessment Questions, you should choose which of three methods 
will be used to rate the student’s mastery. The default setting is 0-100%. 

� 0-100%: This allows you the most flexibility, but you need clear guidelines for selecting the 
number 

� Pass/Fail: Pass = 100%; Fail = 0% 

� 1-4: This allows a four-step scale from 1 (worst) to 4 (best). The system automatically 
converts the choices 1-4 to a number, as follows: 

1 = 25%; 2 = 50%; 3 = 75%; 4 = 100% 

 
Tip: You should use the same setting for all Authentic Assessment questions in your class. 

Feedback and Results 

 
12. Use the Feedback and Results drop-down menu to specify what level of feedback the student is 

given upon completion of the test. 

� End notice only: The student is told only that the test has ended and their score is being 
submitted; the score is not shown.  

� Results only: The student is given his score at the end of the test.  

� Feedback and Results: After answering all the questions, the student is given his score, 
and each question is redisplayed together with the student’s answer, the correct answer 
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and an explanation of the correct answer. Note that LearnMate ensures that students can 
not take a test again after seeing the correct answers. See Reviewing Answers to a Test 
on page 140. 

Randomize Questions 

13. Select the Randomize Questions checkbox if you wish the questions to be presented to the 
students in random order. Note: The answer choices within each question are not 
randomized. If the answer to question 12 is C, it will be C for all students. If Randomize 
Questions has been enabled, one student in your class might see Question 12 as the first 
question, and another as the fourth. 

Save 

14. When you are satisfied with your choices, click Save. 

15. Repeat the foregoing procedure for all the tests in the module. These settings can be changed 
at any time. 

Deleting Modules from Class 
When a module is deleted from the class, all student data related to that module (e.g., grades, 
login information, progress tracking) is deleted as well. Before deleting, you must be very sure that 
you have no further use for any of this information. There is no undo function. 

To delete a module from a class: 

1. In the Modules panel of the Class Main Page, select the checkboxes next to each module to 
be deleted from the class. 

2. Click Delete.  

 
3. Click OK to confirm the module’s deletion. The module is deleted from the class. 

Note: This action will have serious consequences to the Gradebook and (in Laboratory classes) 
your rotational schedule. Whenever you delete a module, be sure to update your Gradebook and 
rotational schedule. See Defining Module Grades on page 258 and Rotational Schedules on 
page 262. 
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Students 
All users, including students, can send mail or schedule events from the Students panel of the 
Class Main Page. See Scheduling an Event on page 77 and Sending a Mail Message on page 
80. However, instructors have several additional capabilities: 

• Enrolling and Unenrolling students 

• Viewing and Assigning students’ module enrollments 

• Viewing, editing and updating students’ grades 

Enrolling Students 
If permitted by the instructor, students may enroll themselves in a class from the Catalog during 
the dates specified on the Class Details page. You also have the option of manually enrolling 
students at any time from the Students panel of the Class Main Page. 

To enroll students in a class: 

1. Click Enroll in the Students panel on the Class Main Page.  

 
The Students page is displayed. 

2. Select the students to add to the class from the Available Students panel on the left side of the 
page. Hold down the Ctrl key to select multiple students. 

3. Click the Add Students icon  to move the selected students to Enrolled Students panel.  
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To select multiple students, hold the Ctrl key when you click. The selected students are moved 
from the Available Students panel to the Enrolled Students panel. 

Note: The students are not actually added to the class until you click Save. 

 
4. To remove a student from a class, make your selection in the Enrolled Students panel and click 

the Remove Student icon .  

 
The selected students are moved from the Enrolled Students list to the Available Students list. 

5. Click Save to save your choices, or click Back to return to the Class Main Page without any 
changes. 

The Class Main Page is displayed, with the updated list of students in the Students panel. 
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Unenrolling Students 
There are two ways to remove a student from the class roster. 

• Use the Students page, as detailed above in Enrolling Students on page 277. 

• Use the Students panel of the Class Main Page, as follows: 

1. Click the checkbox next to the name of each student to be removed. If you wish to remove all 
students, such as after the end of the term, click in the Select All checkbox at the top of the 
panel. 

 
2. Click Unenroll. 

3. Confirm the deletion. 

Modifying a Student’s Module Enrollments 
All of the modules in a class are automatically assigned to all students. The instructor can remove 
modules from any given student. When the module is removed, the student does not see it in the 
Modules panel of the Class Main Page. You can use this procedure to control the dates that 
modules are available to the students. 

To modify the module enrollments of a student: 

1. In the Students panel of the Class Main Page, click the View Student’s Modules icon  next to 
the relevant student’s name.  
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The Modules page is displayed. 

 
The Class Modules panel lists all modules which the student is not enrolled in.  

The Module Enrollments panel lists all modules which the student is currently enrolled in.  

The Completed Modules panel lists all modules which the student has completed. A module is 
considered to be complete only once the post-test at the end of that module has been 
completed. 

16. To unenroll a student from a module, select a module in the Module Enrollments area, and 
click Unenroll. The module will be moved to the Class Modules area. 

17. To enroll a student in a module, select a module in the Class Modules area and click Enroll. The 
module will be moved to the Module Enrollments area. 
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Note: If a rotational schedule has been established for the class, you will not be able to enroll 
students in additional modules, or unenroll them from modules. The page will appear without 
checkboxes. 

 

Updating All Students’ Grades 
In the Students panel of the Class Main Page, click on Update Grades. The system then begins 
updating all students’ grades. This process can take a long time, particularly toward the end of the 
term. 

Note: Although test grades are calculated automatically when the student finishes a test, the 
grades are not transferred into the student’s gradebook until the instructor updates the grades 
using this procedure. It is good practice to click on this hyperlink at the end of every test, so that 
the grades will be immediately visible to the students on their own My Grades page. See My 
Grades on page 54. 

Grades 
The instructor has the ability to modify the grades of any student. The student’s gradebook shows 
all of the tests and other grading activities in the class, organized hierarchically. You can control 
how much of the gradebook is displayed by clicking on the expand and collapse icons. 

Test Grades can be calculated automatically by the system and entered into the students’ 
gradebooks by clicking on Update Grades in the Students panel of the Class Main Page. See 
Updating All Students’ Grades on page 281. 

Assignment Grades must be entered by the instructor individually using the procedures detailed 
here. See Changing Assignment Grades on page 284. 

Additional Grades must be entered by the instructor individually using the procedures detailed 
here. See Defining Additional Grades on page 260. 
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Grades on a test can be changed either on a question-by-question basis or on the test as a whole. 

Note: The grade on a test cannot be modified until after the student has actually gone through the 
test. 

Opening a Student’s Gradebook 
To open a particular student’s Gradebook: 

1. Click on the number under the Grade column, next to the student of interest. 

 
The student’s Gradebook is opened. 

Changing Overall Test Grades 
To change the overall grade on a given test: 

1. Find the name of the test in the appropriate panel. Click on the name of the test. 

 
A pop-up window opens which allows you to enter the new grade. 

2. Enter the new grade and click Update. Note that these grades may be decimals, down to the 
tenths’ place. 

 
The Grades page is refreshed. The modified test grade is shown. 
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Changing Individual Question Grades 
To change the grade on an individual question: 

1. Click on the Edit Grade icon  to the right of the name of the test. The Test Viewer opens. 

 
2. Click on the Navigate Questions icon  to open the Test Navigation Bar. 

 
3. Click on the number of the question to be modified, or page through the test until you reach the 

question of interest. 

 
4. Enter the new grade in the Question Grade field at the bottom center of the Test Viewer and 

click Update. If you do not click Update, the new grade will not be saved into the system. 

 
5. Repeat the foregoing procedure for all questions which require modification. 

6. Close the Test Viewer. 

The Grades page refreshes, and the adjusted test grade is shown. 
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Changing Assignment Grades 
The section below discusses how an assignment grade can be changed after it has been 
previously graded. To learn how assignments are graded initially, see Evaluating an Assignment 
(Student and Instructor) on page 119. 

1. Click on the Edit Grade icon  to the right of the name of the assignment. The View User 
Assignment page opens. 

 
2. Any links the student has attached to the assignment are listed in the Links panel. 

3. To open a reference file listed in the Reference Files panel, click on its name. 

4. The user files which the student has submitted for grading appear in the User Files panel. You 
can view the files themselves from this page by clicking on them. Also, you can view the 
following items by selecting the file of interest and clicking on the associated hyperlink: 

� Working Notes 

� Teacher Evaluation 

� Peer Evaluation 

 
5. The criteria which you established for evaluation are all listed in the Assignment Criteria panel. 

This is for your reference. 

6. In the Final Grade panel, you can insert the final numeric grade, an integer between 0 and 100. 
You can also include any comments for the student to read in the student’s gradebook. 

7. Click Save. Your changes are saved and the page refreshes. 

 
8. Repeat this procedure for each Assignment. 

9. Click Back. You are returned to the student’s Grades page. 
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Changing Additional Grades 
1. Click on the name of the Additional Grade activity. 

 
2. The Set Additional Grade pop-up window opens. 

 
3. Enter the grade in the Enter Grade field and click Save. The pop-up window closes and the 

student’s Grades page is refreshed with the new grade. 

 
4. Repeat this procedure for each Additional Grade. 

Grading Open/Essay Questions 
Although the instructor does not need to review automatically graded questions, he does have to 
assign grades to open/essay questions, as they are not graded automatically by the system. 

The instructions that follow apply to review tests within modules, pre-tests, post-tests at the end of 
modules and class tests.  

After a student has completed a test that included an open/essay question, the instructor is 
notified that he has to grade the test by the presence of a Flag icon  next to the student’s name 
in the Students area of the Main Class Page. 

1. If a Flag icon  is displayed, click it to go to the student’s Grades page. 
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OR 

Click the number in the Grade column to go to the student’s Grades page. 

The student’s Grades page is displayed. A red ! next to a test indicates that the test requires 
manual grading. This icon disappears after all such questions have been graded. 

2. Click the Edit Grade icon  to grade the test.  

 
The Test Viewer opens in a new browser window and the first question is displayed. 

� The question is displayed, together with the correct answer, the student’s answer and the 
question feedback. 

� The question grade is displayed beneath the question viewer. The grade shown is the 
automatically assigned grade. The instructor can change this grade. After changing the 
grade, click Update to save the change. 

� The grade for Open/Essay questions is not automatically assigned, and the instructor is 
required to enter it. 

Printing a Student’s Gradebook 
To print an individual student’s gradebook: 

1. In the student’s Grades page, click Print Preview. 

 
The student’s grades are shown in printable form. 

2. Click Print. 
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The page is printed. 

3. Click Back to return to the Grades page. 

Class Chats 
All users, including students, can participate in Class Chats. Unlike Organization Chats, which 
can be accessed by any user in the system, a Class Chat is only open to members of the class 
(instructor and students). 

A student who has been appointed as Chat Manager has additional rights to edit or deactivate the 
chat. See Chat Manager on page 87. However, only the Class Instructor may do the following: 

• Create a Class Chat 

• Appoint a Chat Manager 

• Reactivate a Chat 

When a Class Chat is created, the default Chat Manager is the instructor who created it. Even 
when someone else has been assigned as Chat Manager, the instructor still retains all the powers 
of the Chat Manager, though the instructor’s name does not appear when the chat is accessed. 

Create a Class Chat 
Creation of a Class Chat is basically the same as creation of an Organization Chat. The main 
difference is that only the class instructor can create a Class Chat. See  

Creating an Organization Chat on page 245. 

To create a class chat: 

1. In the Chats panel of the Class Main Page, click Add. 

2. Follow the rest of the procedure set out at  

3. Creating an Organization Chat on page 245. 
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Appoint a Chat Manager 
The Class Chat Manager is appointed the same way as an Organization Chat Manager. Only a 
member of the class is available for this purpose. See Selection of Chat Manager on page 246. 

Reactivate a Chat 
A class chat which has been deactivated does not appear in the Chats panel of the students’ 
Class Main Page. To reactivate the chat, follow the same procedure as reactivating an 
Organization Chat. See Reactivating an Organization Chat on page 248. 

Class Forums 
All users, including students, can participate in Class Forums. 

Unlike Organization Forums, which can be accessed by any user in the system, a Class Forum is 
only open to members of the class (instructor and students). 

A student who has been appointed as Forum Manager has additional rights to edit or deactivate 
the Forum. See Forum Manager on page 100. However, only the Class Instructor may do the 
following: 

• Create a Class Forum 

• Appoint a Forum Manager 

• Reactivate a Forum 

These procedures are essentially the same as for Class Chats. See Class Chats on page 287. 

When a Class Forum is created, the default Forum Manager is the instructor who created it. Even 
when someone else has been assigned as Forum Manager, the instructor still retains all the 
powers of the Forum Manager, though the instructor’s name does not appear when the Forum is 
accessed. 

Class Tests 
If you do not have Content Administrator permissions, you may not edit or create Class Tests for 
inclusion in your own class, but you can include any Class Tests which are available to your 
organization. If you do not have Content Administrator permissions, you do not have a Content 
tab on your Navigation Menu. If you need to edit or create Class Tests but do not see the 
Content tab on your Navigation Menu, contact your Organization Administrator. See 
Permissions on page 225. 

Adding a Test to a Class 
To add a test to a class: 

1. Click Add in the Tests area of the Class Main Page.  
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The Add Test page is displayed, enabling you to search for an existing test in the LearnMate 
test bank and to schedule the class for that test. 

2. To search for a test in the test bank: 

� Enter either the name you gave the test in the Name field, part of the test’s description in 
the Description field, or the test ID number in the Test ID field. 

3. Click Search.  

 
A list of all tests that meet the search criteria you specified is displayed. 

4. Check the checkbox next to the test(s) you would like to schedule for your class. 

5. Click Add. 

 
The Class Main Page is redisplayed, with the test you selected listed in the Tests area. In the 
sections that follow, you will learn how to set availability dates and times for the test, as well as 
test delivery details. 
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Removing a Test from a Class 
Once a test has been scheduled for a class, it can be unscheduled. Doing so does not delete the 
test from the LearnMate test bank – only from the class. It does, however, delete any student 
grades submitted for that test. 

To remove a test from a class: 

1. Select the checkbox next to the test you would like to remove. 

2. Click Delete in the Tests area. 

 
3. Confirm deletion of the test.  

The Class Main Page is redisplayed, without the test you have removed. The gradebook is 
altered automatically. 

Note on Test Status 
The status of each test is indicated in the Status column of the Tests area. 

The instructor can specify the dates and times in which the test should be available to students 
(see Setting Availability Dates for a Test on page 291). He can also specify the number of 
attempts permitted (see Define Test Delivery Options on page 292). 

The status of a test in a student’s Class Main Page is based on the test dates and times, and on 
the number of attempts he has left. The status of a test in the Instructor’s Class Main Page is 
based only on the test dates. 

Student Statuses: 

Expired: The End date and time for the test has passed. Students may no longer take the test. 

In Progress: The current date and time lies between the Start and End dates and times, and the 
student has at least one attempt at the test remaining. The student may take the test. 

Not Started: The Start date and time has not yet arrived. Students may not take the test yet. 

Completed: The student has completed the test and has no attempts left. 
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Instructor Statuses: 

Expired: The End date and time for the test has passed. Students may no longer take the test. 

In Progress: The current date and time lies between the Start and End dates and times. 

Not Started: The Start date and time has not yet arrived. Students may not take the test yet. 

Setting Availability Dates for a Test  
To set the date for a test listed in the Tests area of the Class Main Page: 

1. Click the Set Date icon  next to the relevant test in the Tests area. The Set Test Dates 
pop-up window is displayed. 

 
2. Set the Start and End dates and times by clicking the Calendar icon  and choosing the date 

from the calendar that is displayed. 

 
3. Set the Start and End times using the drop-down menus. 

 

LearnMate v3.2 User Manual  291 
0609  Class Management 



  
 

Note: Dates and times are set according to the location of the LearnMate server. Therefore, if 
the LearnMate server resides in a different time zone from the end user, the dates and times 
should be set for the class accordingly. 

4. Click Save. The Class Main Page is redisplayed, and the Start and End dates are shown next 
to the test in the Tests area. 

 

Define Test Delivery Options 
The instructor can specify a number of parameters that control how the test should operate within 
the class. 

To edit class test details: 

1. Click the Edit Test icon  next to the test name in the Tests area of the Class Main Page. 

 
The Class Test Details page is displayed. 

 

LearnMate v3.2 User Manual  292 
0609  Class Management 



  
 

 
 

2. Make the required changes in the Class Test Details area, as follows: 

• Navigation: 

� Open: Students are not forced chronologically through the text questions, and instead can 
move around the test, skipping from question to question. 

� Locked: Students must answer each question in chronological order. 

• Repeat: The number of times each student may repeat the test. Enter 0 to indicate that the 
student may take the test an unlimited number of times. 

• Determine Final Grade by:  

� Best: Only the student’s best score on the test is used to calculate the final grade.  

� Last: Only the student’s last score on the test is used to calculate the final grade.  

� Average: The average of all the student’s attempts at the test is used to calculate the final 
grade. 

• Time Limit: Sets the time allowed to the student to complete the test, in minutes. If you do not 
wish to impose a time limit, set this field to 0. 

• Start Time and End Time: Specifies the time period during which the test can be taken. 

• Grade Type for Authentic Assessment Questions: Specifies how authentic assessment 
questions are graded: 

� Pass/Fail: The instructor can assign only a passing or failing grade. 

� 0-100%: The instructor can assign any grade from 0% to 100%. 
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� 1-4: The instructor grades the question on a scale of 1 to 4, where 1 corresponds to 25%, 
2 to 50%, 3 to 75% and 4 to 100%. 

• Feedback/Results: Specifies what level of feedback the student is given.  

� End notice only: The student is told only that the test has ended and their score is being 
submitted; the score is not shown.  

� Results only: The student is given his score at the end of the test.  

� Feedback/Results: After answering all the questions, the student is given his score, and 
each question is redisplayed together with the student’s answer, the correct answer and 
an explanation of the correct answer. 

• Randomize Questions: If selected, the test questions are delivered to the student in a random 
order. If not selected, the test questions are shown in the order they were specified when the 
test was created. 

3. To preview a test question: 

� Click the  icon in the Questions area. The list of questions is shown. 

 
� Select the question you would like to preview. 

� Click Preview.  

 
The Test Viewer is displayed. 
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� Answer the question and click Next.  

 
The answer is shown, together with a hint and/or feedback (if they exist). 
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� Close the Test Viewer window. 

4. Click Save. 

5. Click Back to return to the Class Main Page. 

Viewing Test Questions 
To display all test questions in an easy-to-view format, from the Class Main Page: 

1. In the Click the View Test icon  next to the test you would like to view. 

 
2. The View Test page is displayed. Each question is displayed, together with the possible 

answers and the question type. The number of the correct answer is bolded. 
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3. Click Back to return to the Class Main Page. 

To display all test questions in an easy-to-view format, from the Edit Test page: 

4. Click View Test. 

 
The View Test page is displayed. Each question is displayed, together with the possible 
answers and the question type. The number of the correct answer is bolded. 

Assignments 
If you do not have Content Administrator permissions, you may not edit or create Assignments for 
inclusion in your own class, but you can include any Assignments which are available to your 
organization. If you do not have Content Administrator permissions, you do not have a Content 
tab on your Navigation Menu. If you need to edit or create Assignments but do not see the 
Content tab on your Navigation Menu, contact your Organization Administrator. See 
Permissions on page 225 and Assignments on page 362. 

Adding an Assignment 
To add an assignment to a class: 
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1. Click Add in the Assignments area of the Class Main Page. 

 
The Add Assignment page is displayed. In this page, you will specify the search criteria to 
search for the assignment you would like to set. 

2. Enter the name of the assignment in the Name field, the topic of the assignment in the Topic 
field or a description of the assignment in the Description field. 

3. Click Search.  

 
A list of assignments that match your search criteria is displayed. 

4. To view the details of the assignment, click the View Assignment icon .  

 
The View Assignment page for the selected assignment is displayed.  

5. Click Back to return to the Add Assignment page. 

6. To add an assignment to the class, click the Add Assignment icon  next to the assignment you 
would like to add. 

 
The Class Main Page is displayed, with the selected assignment listed in the Assignments 
area. The Gradebook is automatically updated. 
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Removing an Assignment from a Class 
Once an assignment has been set for a class, it can be removed. Deleting an assignment from a 
class does not delete the assignment from the assignment bank.  

Important Note: When an assignment is deleted from a class, all grades and data associated 
with that assignment are also deleted. If you do not wish to lose this information but no longer 
want the assignment “active” as part of the class contents, we recommend that you instead 
change the availability dates of the assignment such that it is expired. As such, students will no 
longer be able to launch the assignment but all previous data is retained. The next section will 
instruct you on changing an assignment’s availability dates. 

To remove an assignment from a class: 

1. Check the checkbox next to the assignment you would like to remove. 

2. Click Delete in the Assignments area. 

 
You are requested to confirm deletion of the assignment. The Class Main Page is 
redisplayed, without the assignment you have removed. 

Setting the Dates for an Assignment 
The instructor can specify the dates between which the students may perform the assignment. 
The Status column in the Assignments area indicates the current status of the assignment: 

• Expired: The End date for the assignment has passed. Students may no longer submit the 
assignment. 

• In Progress: The current date lies between the Start and End dates and times. The students 
may access the assignment. 

• Not Started: The Start date has not yet been reached. Students may not access the 
assignment yet. 

To set the date for an assignment listed in the Assignments area of the Class Main Page: 

1. Click the Set Date icon  next to the relevant assignment in the Assignments area.  
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The Set Assignment Dates pop-up window is displayed. 

2. Set the Start and End dates and times by clicking the Calendar icon  next to each field and 
selecting a date from the calendar that is displayed. 

 
Note: Dates and times are set according to the location of the LearnMate server. Therefore, if 
the LearnMate server resides in a different time zone from the end user, the dates and times 
should be set for the class accordingly. 

3. Click Save. The Class Main Page is redisplayed, and the Start and End dates are shown next 
to the assignment in the Assignments area. 

 
The instructor can change the availability dates at any time by repeating the process 
described in this section. 

Editing an Assignment 
You can edit an assignment only if you created the assignment yourself. If you are adding an 
assignment that you did not create, you cannot edit the assignment. From the Content menu, you 
can create a copy of the assignment and adjust it to fit your needs. For more information on 
copying an assignment, see Copying an Assignment on page 369. 

To edit an assignment: 

1. Click the Edit Assignment icon  next to the assignment name in the Assignments area of the 
Class Main Page. The Edit Assignment page is displayed. 

LearnMate v3.2 User Manual  300 
0609  Class Management 



  
 

 
Refer to Editing an Assignment on page 369, for instructions on editing an assignment. 

Class Resources 
Class resources are files that are relevant to the class as a whole, such as the course syllabus, 
calendar, class rules, safety procedures and so on. Unlike Module Resources (see Module 

 on page 72), they are not relevant to just one particular module.  Resources

ing a Module Resource

• 

The class resource files are listed in the Resources panel of the Class Main Page. This list may 
change from time to time as determined by the instructor. Students can open files directly from 
this page, or download them to their own computers. The procedures for dealing with these files 
are identical to the procedures for Module Resources. 

The Class Instructor has the same rights to open and save Resource Files that students have. 
See View  on page 73 and Saving a Resource File on page 74. 
However, the Class Instructor may also: 

• Restrict or Unrestrict resources for viewing 

• Upload new resources 

Import resources from modules or other classes 

Resource Restrictions 
Once a resource file is in the system and associated with the class, the instructor can control 
whether it is available for the students to view. This setting can be changed at any time. This is 
quite useful, as in the following situations: 

• Answers to a test, available for discussion after the test is completed 

• Supplementary reading material, available only when the class is covering that specific topic 

• Videos, Web links, photographs, charts and any other electronic resource when the material is 
relevant to the current topic – not before and not after. 

To restrict a class resource: 

1. Select Restricted from the Restricted drop-down menu next to the resource to be restricted, in 
the Class Resource area of the Class Main Page. 
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2. Click Save Restrictions. 

 
The page is refreshed, and the file is restricted for use. 

 
To unrestrict the use of a class resource file, select Unrestricted from the Restricted drop-down 
menu, and click Save Restrictions. 

3. 

Uploading Resources 
This procedure is used to add a new resource file into the system. 

1. Click Upload in the Class Resources area of the Class Main Page. 

 
The Upload Resource pop-up window is displayed. 

2. Click Browse. 
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The Choose file pop-up window is displayed. 

3. Select the file to be uploaded and click Open. 

 
The file name is entered in the Upload Resources pop-up. 

4. Enter the name to be given to the file in the File field. This does not have to be the same as the 
file name as it is on your computer. 

5. Enter a description of the file in the Description field. 

6. Check the Restrict checkbox if you wish for the file to be restricted. 

7. Click Upload. 
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The Class Main Page is refreshed, and the uploaded resource is listed. 

 

Importing Resources  
This procedure is used to add an existing resource to the class, when that resource is already in 
the system, attached either to a module or some other class. 

1. Click Import in the Class Resources area of the Class Main Page. 

 
The Import Resource pop-up window is displayed. 

2. Select a module or class from which to import a resource file, using the drop-down menus. 
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After a class or module has been selected, all the resource files owned by that class or module 
are listed. 

3. Select a file to import, and click Import. 

 
The Class Main Page is refreshed, and the selected file is listed in the Class Resources area. 

 

Review 
In this chapter, we covered the following material: 

• Average Class Grade 

• Utility Check 

• Class Details 

• Customize Gradebook 

• Schedule 

• Modules 

• Students 

• Class Chats 

• Class Forums 

• Class Tests 

• Assignments 
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• Class Resources 

Ask Yourself… 
• Can you customize the gradebook? 

• Can you add additional grades to the gradebook? 

• Can you explain the difference between the overall grade and the grade-to-date? 

• Can you edit students’ grades? 

• Can you set up a rotational schedule? 

• Can you ensure that specific students are not grouped together in an automatically generated 
rotational schedule? 

• Can you add modules to a class? 

• Can you define how module tests are to function? 

• Can you enroll students in a class? 

• Can you set up, manage and archive class chats? 

• Can you set up and manage class forums? 

• Can you schedule class tests? 

• Can you set class assignments? 

• Can you upload class resources and restrict/unrestrict their use? 
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10 
Content Management 

Review of Previous Chapter 
In chapter 10, we covered the following material: 

• Average Class Grade 

• Utility Check 

• Class Details 

• Customize Gradebook 

• Schedule 

• Modules 

• Students 

• Class Chats 

• Class Forums 

• Class Tests 

• Assignments 

• Class Resources 

Introduction 
This section explores the Content tab on the Navigation Menu. It is only accessible to 
Instructor/Managers or Administrators who have Content Organization Administrator 
permissions. If you do not see the Content tab on your Navigation Menu, contact your 
Organization Administrator. See P  on page 225. ermissions

In the Content section of the LearnMate system, you can create and edit all types of content 
available for inclusion in classes. You can also manage the Media Bank and the mapping of 
content to Skills Standards. 

Objectives 
In this chapter, we will explore the following topics: 

• Modules 
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• Content Objects 

• Uploading Media 

• Categories 

• Competencies 

• Links 

• Glossary 

• Assignments 

Modules 

 
The Module is the basic unit of content in the LearnMate system. The module is viewed in the 
Content Viewer. Each page of content consists of text and the Media Viewer. The Media Viewer 
may display still graphics or photographs, but may also present videos, animations and all manner 
of interactive graphics. 

An instructor may see a list of all available modules when adding modules to the class, and may 
also preview any module without personally completing prerequisites and without any restrictions 
on navigation through the index. An administrator may likewise see a list of available modules 
when preparing certain reports. See Reports – Module on page 170. An administrator may 
preview a module by launching it from the Class Main Page of any class that includes the 
module. See Launching a Module on page 71. 

However, the best way to view modules is from the Modules page itself. It is the default page for 
the Content section. When you click on the Content tab of the Navigation Menu, you are 
immediately taken to this page. If you are already within the Content section of the system, you 
can also click on the Modules tab of the Content submenu. 

While instructors can preview the entire module, including all of its tests and its index, only a 
Content Administrator may edit the text of a module or change the tests and their questions. If you 
find that you need either of these capabilities and you do not see a Content tab on your 
Navigation Menu, contact your Organization Administrator. See P  on page 225. ermissions
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Viewing the List of Modules 
To view the list of modules available to the organization of the current user: 

1. Select Content from the Navigation Menu. The Content options are displayed. 

 
2. Click Modules. The list of modules is displayed. 

Note: The Modules page is displayed by default whenever the Content option is selected 
from the navigation menu. Step 2 is only required when accessing the Modules page from 
another submenu option in the Content section of the system. 

 
The list of modules is displayed. 
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3. To show only the modules belonging to a particular category, select the required category 

from the Category drop-down menu. (See Category Management on page 3 .) 33

 
The Modules page is refreshed, showing only the modules assigned to the selected category. 

 

Adding a Module 
To add a new module to the system: 

1. Select Content > Modules. The list of modules is displayed. 

2. Click Add.  
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The Add New Module page is displayed. 

3. Complete the Module Name, Catalog #, Author, Vendor and Description fields.  

Note: All fields marked with an * are mandatory. 

 
4. Enter the number of activities the module will contain in the No. of Activities field.  

5. Enter the duration of the module in terms of hours in the Duration field 

 
6. Select the applicable type of module from the Type field. This field is mandatory. 

 
7. Select the language of instruction from the Language field. 

8. Enter relevant keywords in the Keywords area. Use commas to separate them. These 
keywords enable students to search the catalog for classes containing relevant modules. See 
Catalog on page 147. 

 
9. Select the relevant Category for the new module. The module will share web links and glossary 

terms with other modules in the category. This field is mandatory. 
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To learn more about categories, see Category Management on page 3 . 33

10. Click Save to save the module you have created. 

The Edit page is displayed. This page includes all fields and options that are present in the 
Add page, as well as a number of others. The additional fields and options are explained in 
the steps that follow. 

11. LearnMate automatically assigns a Module ID to the new module. This number cannot be 
edited. 

Note: The second number in the sequence shown is the organization ID  
(e.g., [module ID]-[organization ID].) 

 
12. Select the status of the module in the Status drop-down menu. A module that is Inactive 

cannot be launched, and students cannot be enrolled. 

Note: We recommend modules be defined as Inactive if their content is currently undergoing 
modifications.  

 
13.  offers a range of software programs for use in its modules. To use such software in 

your module and ensure that a software check is available for this module from the Class 
Main Page: 

� Click Applications. 

 
The Software Check page is displayed. All available software programs are listed. 

� Check the application(s) required for your module. 
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� Click Save. The selected program will be listed next to Applications on the Edit page. Once 

this module is added to a class, click the Software Check icon  next to the module name in 
the Modules area to check for the proper installation of this program.  

 

For more information on the Software Check feature, see Software Check on page 75. 

14. To add a post-test to the module, see Adding/Creating a Post-test on page 314. 

15. Click Save to save any changes you make in the Module Details section of the page. 

16. Prerequisites are modules that the student must have completed before taking the new 
module. Students who do not have the required prerequisites will not be permitted to launch 
the module.  

To assign prerequisites to a module: 

� Select the first prerequisite module from the Prerequisites drop-down menu.  

 
� Click Add. 

 
� The selected module is added to the prerequisites list. 
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� Repeat this process to add as many prerequisites as are required. 

� To remove a prerequisite, click the Delete icon  next to the prerequisite to be deleted. 

Note: Changes in the Prerequisite area are saved by clicking Add. Changes to the Module Details 
area must be saved by clicking Save.  

17. To return to the list of modules, click Back.  

 

Adding/Creating a Post-test 
The post-test is the test that students are given after completing a module.  

You may create a post-test manually using the LearnMate Test Authoring Tool (see Tests on 
page 437.)  

Alternately, LearnMate can automatically generate a post-test for you. An automatically 
generated post-test will consist of 40 questions that are randomly selected from the generic 
questions available in the module’s question bank. Links to LearnMate-generated post-tests are 
added automatically to the last content object of each module, and accessed by clicking on the  
icon on the bottom of that page.  

Note: We recommend that LearnMate automatically generate most post-tests. If you wish, you 
may then edit or change questions chosen by LearnMate after the test has been generated. 

To automatically generate a post-test: 

1. Click Create Post-test.  

 
� The Edit Test page is displayed. The questions that were automatically selected for the 

post-test are listed. See Adding Questions to a Test on page 4  to learn how to modify 
the test. 

38
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2. After making any changes, click Save. 

 
3. Click Back. 

 
4. The Edit Module page is redisplayed. The name of the post-test is displayed in the Post-test 

field. 

 
Note: Clicking Create Post-test if a post-test already exists, will result in a new test being created 
that will replace the existing test. 
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To specify a manually created test as a post-test: 

5. Click Add/Change Post-test. 

 
The Add Test page is displayed. 

6. Enter the Name, Description, or Test ID of the test you would like to specify as the post-test. 

7. Click Search. 

 
All tests that match your search criteria are listed. 

8. Click the Add Test icon  next to the test to be specified as the post-test. 

 
The Add New Module page is redisplayed, with the selected test shown in the Post-test field. 

 
 

Removing a Post-test from a Module 
To remove a post-test from a module: 

1. Click Remove Post-test. 

 
You will be warned that if a test is removed from a module, all grades associated with that test 
will be deleted. 
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2. Click OK to continue, or Cancel to return to the Edit Module page, without removing the 

post-test. 

The Edit Module page is redisplayed. The Post-test field is blank. The student will not be 
presented with a post-test at the completion of the module. 

 

Deleting a Module 
Important Note: Once a module has been deleted, it cannot be restored. Further, all student data 
related to that module will also be lost. Be very careful when performing this function. 

A module that is currently in use in a class cannot be deleted. 

To delete a module: 

1. Select Content > Modules.The list of modules is displayed. 

2. Click  next to the module that you would like to delete.  

The Delete icon  will only be active for modules that originated in your organization. You 
cannot delete modules created by other organizations. 

 
You will be asked if you are sure that you want to delete the selected module. 

 
3. Click OK when you are asked for confirmation. 
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Note: You cannot delete a module that is currently in use in a class (either in your current 
organization or any sub-organization). If you attempt to delete such as class, you will receive 
the message shown below. The message also indicates in which organizations and classes 
the module is being used. 

 
 

Editing Module Details 
To edit the module details: 

1. Select Content > Modules. The list of modules is displayed. 

2. To edit the module details, click the Edit icon .The Modules Edit page is displayed.  

Note: The Edit icon  will only be active for modules that originated in your organization. You 
cannot edit modules created by other organizations. The icon will only be active for modules 
that were created by members of your organization.  

 
3. The Modules Edit page is displayed. This page is identical to the To show only the modules 

belonging to a particular category, select the required category from the Category drop-down 
menu. (See Category Management on page 3 .) 33

 
The Modules page is refreshed, showing only the modules assigned to the selected category. 
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Adding a Module page, as described on page 3 . 10

Editing Module Content 
To edit the module content: 

1. Select Content > Modules. The list of modules is displayed. 

2. To edit the module content, click the Index icon . The module index (table of contents) is 
displayed. To learn how content objects are edited, see Content Authori  on page 3 . ng 73

 

Copying a Module 
You may want to create a module that is similar to an existing module. To speed up the process, 
LearnMate allows you to create a copy of a module that can then be edited without affecting the 
original module.  

This function should be used if you wish to modify either the details or the content of a module 
inherited by a parent organization. Once the module is copied, you have essentially created a 
new, albeit linked, version of that module that now originates in your organization. You will then be 
able to make required changes to the module’s index or details. 

To copy a module: 

1. Select Content > Modules. The list of modules is displayed. 

2. Click the Copy Module icon  next to the module that you would like to copy. 
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3. The modules list is redisplayed. The copy of the module is named “Copy of [name of module], 

[Date and Time of copy]”. This module can then be edited as discussed before. 

 
Note: Once a module has been copied, we recommend changing its name. 

 

Launching a Module 
To preview a module from the Modules page: 

1. Select Content > Modules. The list of modules is displayed. 

2. Click the Preview icon  next to the module to be viewed. The module is launched in a 
separate Content Viewer window. 

 

Content Objects 
When we talk about LearnMate modules, we are essentially referring to the final material that the 
student will see. As we shall see, the material that the student sees in the Content Viewer is 
composed of a number of different system objects, known as ”content objects”. 

• Content objects are chunks of data designed to be used in multiple contexts. 

• Content objects are essentially the pages that the student can see in the Viewer. 

• Content objects can include text, graphics, animations, glossary items, links and tests. 

• Each content object is known as a Reusable Learning Object (RLO), and is both portable and 
reusable, meaning that it can be used repeatedly from module to module. 
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For example, a content object could be a section on safety when working with electrical 
systems. This section can be included in multiple modules, as required. 

• A single copy of the content object is stored in the bank, and is referenced in as many modules 
as required. Because of this design, any changes to the content object need only be made 
once, to the content object in the bank. The changes will automatically be seen in each 
instance of the content object. 

• Content objects can be designed to fit your requirements, and can be made as simple or as 
complex as your imagination and budget allow. We recommend that a typical content object 
be anywhere from a single page to no more than 10 pages. It should be the smallest chunk of 
data that you would consider reusing from module to module. 

 

Viewing the List of Content Objects in a Module 
To view the index, or list of content objects, of a module: 

1. Select Content > Modules. The list of all modules available to your organization is shown. This 
list includes all modules created by your organization, as well as those assigned to your 
organization by a parent organization. 

2. Click the Index icon  next to the module of interest.  

 
The index is shown: 

� The index will be blank if no content objects have been added. 

 
 

� For modules that originated in your organization, each content object in the index will be 
followed by a number of icons that enable you to manipulate the object (e.g., Add , Add 
Subentity , Edit , Delete , Preview , Change Order  , Change Level  ).  
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� For modules that did not originate in your organization, you will only be able to preview  

the content object and not make any editing changes. To edit such modules, you will first 
need to make a copy of the module (see Copying a Module on page 319). 

 
� Next to each content object is a number. That number is the content object ID number. 

� A $ sign next to a content object indicates that the content object originates in another 
module, and can thus not be edited in this module. 

Adding the First Content Object to the Index  
To add a content object to a blank index: 

1. Select Content > Modules. 

2. Click the Index icon  next to the module to which you would like to add a content object. The 
index is shown. The index will be blank if no content objects have been added thus far. 

3. Click Add. 

 
The Add Content Object page is displayed, enabling you to either add a new content object 
to the index, or to insert an existing content object into the index: 

4. To add an existing content object to the index: 

� Enter either the Title, Text or content object ID in the relevant field in the Search area. 

� Click Search.  
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The Search Results page is displayed. 

 
� Select the content object of interest and: 

� Click Add to Index  to add the content object to the module and return to the module 
index. 

OR 

� Click Add and Edit  to add the content object to the module and to go to the content 
object editing page. 

OR 

� Click  to preview the content object. 

Note: If you select a content object that is owned by another module, that content object 
will appear with a $ sign next to it in the index. 

5. To add a new content object to the index: 

� Enter the name of the new content object in the Name field in the Add New Content Object 
area. 

� Enter a description of the new content object in the Description text field of the Add New 
Content Object area. 

� Select a content object tag: 
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� General: For general purpose content objects. 

� Safety: For a content object that provides safety instructions. This content object can 
be opened automatically in the preview page by clicking the Safety icon . Only one 
content object should be defined as a Safety content object per module. Once one 
content object has been set to Safety, this option will not be listed in the Tag pull-down 
menu. 

� Test: For a content object that will contain a test. A Test content object cannot contain 
text or graphics, only a test. 

 
6. Click Add to Index  to add the content object to the module and return to the Module Index. 

OR 

Click Add and Edit  to add the content object to the module and to go to the Edit Content 
Object page. 

 
You will learn how to add content and formatting to content objects in the next chapter, Content 
Authoring, on page 373. 

Adding Additional Content Objects to a Module 
In the previous section, you learned how to add the first content object to a module. Once you 
have done so, the Add link is no longer displayed. To add content objects, you will use the  and 

 icons. 

To add a content object below an existing content object, at the same level in the hierarchy: 

1. Click the Add icon  next to the content object below which the new content object should 
appear. 
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The Add Content Object page is displayed. Follow the instructions for adding a new content 
object, or using an existing content object, as explained in the previous section. 

The new content object is listed at the same level as the previous content object. 

 
2. To add a content object below an existing content object, at the next level in the hierarchy: 

� Click the Add Subentity icon  next to the content object below which the new content 
object should appear. 

 
The Add Content Object page is displayed. Follow the instructions for adding a new content 
object, or using an existing content object, listed in the previous section. 

The new content object is listed at the next level under the previous content object. 
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Reordering Content Objects 
As you learned in the previous sections, additional content objects are always added to the index 
of a module below existing content objects, using the  and  icons. At times, you may want to 
change the order of the index. This is done using the  and  icons. 

1. Click  next to a content object that you would like move up.  

 
The content object is shifted up one position. 

 
2. Click  next to a content object that you would like to move down.  

 
The content object is shifted down one position. 
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When a content object is moved up, it always moves above the next content object on the 
same level. Therefore, if a content object has “children”, it will be moved together with all of its 
children. 

The same principal applies when moving content objects down. 

Note: To move a content object up/down multiple places, you will need to “follow” the content 
object. Each click of the  and  icons will move it up/down one space. You will then need 
to click the  and  icons next to the content object’s new position. 

3. To save the changes that you have made, click Submit Structure Changes. 

 
The index is redisplayed, reflecting the changes you made. 

Changing Hierarchy of Content Objects 
At times, you may want to change the hierarchy of content objects in the index. To do so, use the 

 and  icons. 

1. To lower the hierarchy of a content object (to move it to the right in the index), click  next to 
the content object. 
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The selected content object is moved towards the right in the index. Its children content 
objects move with it. 

 
2. To move a content object to the left in the index, click . 

3. To save the changes that you have made, click Submit Structure Changes. 

 
The index is redisplayed, reflecting the changes you made. 

 

Removing Content Objects from a Module 
You can remove content objects from a module. If the module is the owner of the content object, 
deleting the content object from the index will also delete the content object from the database. If 
the current module is not the owner of the content object, the content object will no longer be a 
part of the module, but will remain available to be included in the module (or in another module) at 
a later time. 

If a content object has sub-entities underneath it, those sub-entities must be deleted first. 

Content objects can either be deleted one at a time, or using the multiple delete function. 

To remove a content object from the index, one at a time: 

1. Click Delete  next to the content object you would like to remove from the index. 

 
You will be asked for confirmation. 
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2. Click OK to confirm its deletion. The content object is removed from the module. 

 
 

To remove a content object from the index, one at a time: 

3. Select the checkboxes next to all content objects to be deleted. Alternatively, select the Select 
All checkbox, which automatically results in all checkboxes being selected. Then deselect the 
checkboxes next to the content objects that are not to be deleted. 

4. Click the Delete  icon at the top or bottom of the page. 
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Previewing Content Objects 
To preview a content object from the Index: 

1. Click the Preview icon  next to the content object you would like to view. 

 
The content object is displayed in the Content Viewer window. 

 
 

Uploading Media 

 
Uploads is used for adding new graphic or video files to the Media Bank. It cannot be used to 
upload new resource files to a module.  

Uploads is the second option available on the Content submenu. If you are already working in 
another part of the Content Section, you can also simply click on the Uploads tab on the Content 
submenu. If you are working in another part of the LearnMate system, you must first click on the 
Content tab of the Navigation Menu. 
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The Media Bank includes media that can be used in content objects. Media types includes 
graphics (GIF or JPEG files), animations (SWF files), and videos (AVI, MPG and MPEG files).  

• Once uploaded to the system, a single media item can be included in multiple content objects. 

• As with content objects, a single copy of the media item is saved in the bank. This item is 
referenced in each of the content objects that use it. 

• Given this structure, any change to a media item need only be made once, to the item in the 
bank, in order for the changes to be seen in every instance of the item. 

• Media items are “owned” by a module. Therefore, media items must be uploaded to a 
particular module. They can then be reused in other modules.  

Uploading Media Files 
To upload a media file: 

1. Select Content > Uploads. The Upload pop-up window is displayed. 

 
2. Select the module that is to “own” the media item from the Module drop-down menu. 

3. Click Browse and browse to the media file that you want to upload to the bank. 
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The Choose file dialog box is displayed. 

4. Select the file to upload. 

5. Click Open. The file name and location are displayed in the File field in the Upload pop-up 
window. 

 
The Upload window is redisplayed, with the file name shown. 

6. Click Upload. 

 
When the file has been successfully uploaded to the bank, a confirmation message is 
displayed. 

 
7. Either close the Upload window, or repeat the process to upload more files. 

You will learn more about the use of media items in content objects in the next chapter. 

Note: The same procedure is available when editing a specific content object. Clicking Upload in 
the Edit Content Object page opens the same Upload window as discussed above. The Module 
drop-down by default shows the name of the module currently being edited. 
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Category Management 

 
Categories are used to group related modules together, even if the modules are not all included 
together as a set in every class. Modules in the same category appear together in the Modules 
page. Modules in the same category share a single Glossary and a single Links file. In this way, 
students learning about electronics will have access to terms relating to electronics, without 
having to wade through terms relating to geology, structural engineering, career skills and CNC 
programming. Similarly, they can browse through Web links, pre-screened to cover the topic of 
the class and nothing else. 

Instructors can use Categories to help them find specific modules. However, only a Content 
Administrator can create or edit Categories. If you find that you need either of these capabilities 
and you do not see a Content tab on your Navigation Menu, contact your Organization 
Administrator. See Perm  on page 225. issions

Categories is the sixth option available on the Content submenu. If you are already working in 
another part of the Content Section, you can also simply click on the Categories tab on the 
Content submenu. If you are working in another part of the LearnMate system, you must first click 
on the Content tab of the Navigation Menu. 

Notes on Category Inheritance 
You have previously learned that modules can be inherited from an organization to its 
sub-organizations. Those sub-organizations are not permitted to edit inherited modules, but may 
make copies of those modules and edit the copies.  

The same is true of categories. When a sub-organization inherits a module from its parent 
organization, it automatically inherits the category into which that module was grouped. Thus the 
sub-organization also inherits the glossary and links databases for that category. 

The sub-organization is not permitted to edit the inherited category in any way: 

• The name of the category cannot be changed. 

• Glossary entries cannot be edited, added or deleted. 

• Links entries cannot be edited, added or deleted. 

Should the sub-organization wish to make any of the changes listed above, a copy of that the 
category must be made. Copying a category also copies the glossary and links.  

If the parent organization makes a change to a category, such as changes to links or glossary 
terms, those changes will be seen by sub-organizations to which the category had been assigned 
previously. However, if the sub-organization made a copy of the inherited category, the new 
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category so created will not be affected at all by changes made to the original by the parent 
organization. 

Adding Categories 
To add a category: 

1. Select Content > Categories.  

The System Categories page is displayed. All the defined categories are shown.  

2. To add a category, click Add. 

 
The Add New Category page is displayed. 

3. Enter a name for the new category in the Title field. 

4. Click Save to add the new category to the system.  

 
A glossary and links bank for your new category are automatically added to the system. 

 

Editing a Category Name 
You may only edit the name of a category owned by your organization. You may not edit the name 
of a category that was inherited from a parent organization. 
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To change the name of a category: 

1. Click the Edit icon  alongside the category name in the System Categories page. This icon 
is inactive if your organization does not own the category.  

 
The Edit Category page is displayed. 

2. Make the change to the title. 

3. Click Save. 

 
The category name is changed.  

 

Deleting a Category 
You may only delete categories owned by your organization. You cannot delete categories that 
were inherited from a parent organization. 

Note: Once a category is deleted, all related resource banks belonging to that category (glossary, 
library of links) are also deleted. They cannot be restored. 

To delete a category: 
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1. Click the Delete icon  next to the category to be deleted. This icon is inactive if your 

organization does not own the category.  

 
You will be asked for confirmation. 

2. Click OK to confirm the deletion. The category is deleted. 

 

Copying a Category 
You may copy any category listed on the Categories page. 

To copy a category: 

1. Click the Copy icon  next to the category to be copied.  

 
The Copy Categories pop-up window displays. 

2. Enter the name to be given to the new category. It may not be the same as the name of the 
category being copied. 

3. Click Save.  

 
The new category is now listed on the Categories page.  
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Note: After copying a category, all modules that were previously assigned to the original 
category will still be assigned to that original category. If you want a module to be part of your 
new category, you must change the category specification in the module’s Edit page, see 
Adding a Module on page 310. 

 

 

Competencies 

 
By completing a LearnMate module, a student gains a wide rage of competencies. Such 
competencies include an understanding of the material covered, skills gained by solving complex 
problems, and the ability to integrate knowledge in a task.  

LearnMate’s Competencies Management feature allows an instructor to keep track of the 
competencies gained by the students as they progress through the modules. 

• An organization defines the competencies that are of interest to it by uploading a list of 
standards known as a Skills Standard or Content Standard. 

• The skills standard can be edited and updated at any time. 

• Instructors can map any number of the organization’s competencies to a module, identifying 
the competencies that students are expected to accumulate during the module. 

• Competencies can also be allocated to individual test questions. 

• Reports can be generated to display the competencies gained by each student, as well as the 
competencies that have been assigned to each module. 

• Skills standards can be inherited to sub-organizations. Parent organizations can also import 
skills standards from sub-organizations. 
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Students and instructors can read the text of competencies that have been mapped to their 
modules. However, only a Content Administrator can edit the text of the Skills Standards or map 
Skills Standards to modules and questions. If you find that you need either of these capabilities 
and you do not see a Content tab on your Navigation Menu, contact your Organization 
Administrator. See Perm  on page 225. issions

What is a Skills Standard? 
The term Skills Standard (also referred to as a Content Standard) refers to the list of 
competencies that an organization has defined for its modules. Typically, states will have defined 
skills standards for language arts, science, math and technology. Industrial standards are also 
typically divided into skills standards. For example, the National Institute for Metalworking 
Standards (NIMS) has separate standards for various levels of metalworking and machining. 

Creating a Skills Standard File 
LearnMate allows you to quickly add multiple Skills Standards to the system by enabling you to 
upload external files containing those standards. A skills standard import file must consist of a 
spreadsheet that is organized as follows: 

• ID: The ID number assigned to the specific competency.  

• Level: The grade level for which the competency is defined. 

• Skills Standard: The name of a list of competencies defined by the organization. Usually, only 
one Skills Standard is defined per organization, although multiple Skills Standards may be 
appropriate if there are categories of completely unrelated competencies. An example could 
be Science, Math or Language Arts. 

• Strand: This is usually the first category level in the Skills Standard. Examples may include 
Algebra, Trigonometry, Physical Science, etc. 

• Standard: This is typically the second category level in a Skills Standard. It either clarifies the 
strand, or in some cases, is a general statement that is then clarified by the particular 
competencies that follow it. 

• Competency (competency, indicator or skill): A skill or item in a skills standard that defines a 
particular theoretical or practical understanding a student should obtain from the learning 
material. 

The Content Standard, Strands, Standards and Competencies form a hierarchical structure. 

Note: The system accepts only a four-tier hierarchy. If the set of standards to be uploaded 
consists of a different number of tiers, it must first be adapted. The lowest level is the actual 
standard. The upper levels function as groupings, and are for order and convenience only. 

 

To create a Skills Standard file that can be uploaded into LearnMate: 
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1. Create a spreadsheet file with six columns. The following column headers must be entered in 

the first row of the spreadsheet: 

 
2. Fill in each column, using as many rows as required. An example is shown below: 

 
3. Save the file in a tab-delimited format, with a .txt extension, by selecting Text (Tab delimited)(*.txt) 

from the Save as type drop-down menu. (Attempting to upload an Excel xls file will fail.) 

4. Click Save. 

 
5. Close your spreadsheet program. You may not be able to upload the file to LearnMate if your 

spreadsheet program is still open. 

Uploading a Skills Standard 
To upload the Skills Standard file: 

1. Select Content > Competencies. The Competencies page is displayed. 

2. Click Upload New Standard. 
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The Upload New Skills Standard page is displayed. 

3. Select Upload New Skills Standard from the Action drop-down menu. 

4. Enter a name for the Skills Standard in the Name field. This name must be unique – you 
cannot upload more than one skills standard under the same name. 

5. Enter the source of the skills standard in the Source field. 

6. Enter copyright details in the Copyright field. 

7. Click Browse. 

 
The Choose File dialog box is displayed. 

8. Select the file to be imported. 

9. Click Open. 
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The file name is displayed in the Upload New Skills Standard page. 

10. Click Upload File. 

 
� If the upload was successful, a success message is displayed: 

 
Note: Any spaces in the file name are converted to underscores. 

� If the upload was not successful, a failure message is displayed, typically indicating that 
the file you uploaded was not in the correct format. 
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The Competencies page is displayed, with the new Skills Standard shown. 

 
You are now ready to either edit the standard or to map the standard to LearnMate Content 
modules, both of which you will learn about in subsequent sections. 

Assigning Competencies to Modules 
Once a skills standard is uploaded to LearnMate, it is ready to be mapped to LearnMate Content. 
Competencies from a skills standard can be mapped to LearnMate modules or specifically to 
particular test questions.  

These mappings enable the following and more: 

• Instructors can show detailed proof to administrators that the content used in their classroom 
is mapped to required standards. 

• Instructors and administrators can determine the effectiveness of LearnMate Content, by 
generating reports that show student successes and failures in terms of state defined 
standards.  

• Students can show future employers the various competencies to which they have been 
exposed and achieved various levels of competency. 

To map competencies from a skills standard to a module: 

1. Click the Map Standard to Content icon  next to the Skills Standard you would like to map to a 
module. 

 
The Mapping a Skills Standard with a Module page is displayed. 

2. Select the standards to be mapped. Selecting the checkbox next to any of the standard 
groups (any checkbox other than those for the lowest level standards) selects all lower 
standards in the hierarchy. 
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3. Select the modules to which the selected standards are to be mapped. 

 
4. Click Submit, either at the top or bottom of the page. 
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The page refreshes. The number of competencies assigned to each module is listed in 
(brackets).  

 

Associating Questions with Competencies 
You have learned how to assign competencies to modules. LearnMate also enables you to assign 
competencies to individual assessment questions. To learn how to assign competencies to a 
question, see Associating Questions with Competencies on page 434. 

Viewing Competencies that have been Mapped to a Module 
To view the competencies already mapped to a module: 

1. In the Competencies page, click the Map Standard to Content icon  next to the Skills Standard 
of interest. 

 
The Mapping a Skills Standard with a Module page is displayed. 

2. Click on the name of the module of interest. 
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The Mapped Competencies pop-up window opens. 

3. Select a sills standard from the Skills Standard drop-down menu. 

 
The list of competencies from the selected skills standard that have been mapped to the 
selected module are listed. 

 

Disassociating Modules and Competencies  
Competency mappings can easily be deleted if a mistake is made during the mapping process. 

To disassociate modules from a particular competency: 

1. Follow the instructions in the section above to display a list of all competencies mapped to the 
module. 
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2. Check the checkboxes corresponding to all competencies that are to be un-mapped. 

3. Click Remove Mapping. 

 
You will be asked for confirmation. 

4. Click OK to confirm. 

The page is refreshed. The disassociated competencies are no longer listed. 
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Viewing Modules to which a Competency has been Mapped  
To view a list of the modules that have been assigned a specific competency: 

1. In the Competencies page, click the Map Standard to Content icon  next to the Skills Standard 
of interest. 

 
The Mapping a Skills Standard with a Module page is displayed. 

2. Click on the number in brackets next to the competency of interest. (If there is no number next 
to the competency name, the competency has not been assigned to any modules.) 

 
The Mapped Modules pop-up window is displayed, listing all modules to which the 
competency is assigned. 

 
3. Competency associations can be removed by selecting the checkboxes of modules and 

clicking Remove Mappings. 
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Manually Editing Skills Standards 
After having uploaded a Skills Standard, you may want to edit existing competencies, or add new 
ones. LearnMate enables you to do this online. 

To edit a skills standard: 
1. Select Content > Competencies. The Competencies page is displayed. 

2. Click the Edit icon  next to the Skills Standard you would like to edit. 

 
The Edit Skills Standard page is displayed. 

To add a new item to the skills standard: 
1. Click Add  next to the competency (at any level) under which the new item should be listed, 

if it is to be at the same level. 

 
The Add Content Standard page is displayed. (The name of the page shown depends on the 
level at which you are adding an item.) 

2. Enter the name of the new item in the text entry area, and click Save. 

 
The new item is added to the Skills Standard. 
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To add an item at a lower level in the skills standard hierarchy: 
1. Click Add Subentity  next to the standard, strand or competency under which the new 

competency should be added. 

 
The Add Strand page is displayed. (The name of the page shown depends on the level at 
which you are adding an item.) 

2. Enter the name of the item in the text entry area and click Save. 
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The new item is displayed in the Skills Standard. 

 

To edit an item in the skills standard: 
1. Click Edit  next to the item to edit. 
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The Edit Strand page is displayed. (The name of the page shown depends on the item’s level 
in the hierarchy.) 

2. Edit the name of the item in the text entry area and click Save. 

 
The tile of the item is changed. 

 

Inheriting Skills Standards to Sub-Organizations 
A parent organization can inherit its skills standards to its sub-organizations. The following 
important points must be noted: 

• By default, a sub-organization inherits all of a parent organization’s skills standards. To learn 
how to select which skills standards are to be inherited by each sub-organization, see 
Changing Settings for Sub-Organization on page 218. 

• A sub-organization that inherits a skills standard from its parent organization, also inherits all 
the mapping between the competencies of that skills standard and the modules and questions 
that it inherited from the parent organization.  

• A skills standard can only be edited by the organization that owns it – a sub-organization 
cannot edit a skills standard inherited from its parent organization.  
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• A sub-organization may make a copy of an inherited skills standard. This copy then 

constitutes a new standard owned entirely by the sub-organization, which can then edit or 
delete it as required. See the next section, Copying a Skills Standard on page 352. 

• A sub-organization cannot map competencies of an inherited skills standard to modules or 
questions. If a sub-organization wishes to do so, a copy of the skills standard must be made 
first. 

• Any changes made to a skills standard by a parent organization will be seen by all 
sub-organizations that have inherited the skills standard. 

In the example below, the California Grade 6 Science Standard was inherited from a parent 
organization, and thus cannot be edited or deleted. The Technology standard is owned by the 
organization shown, and can be edited or deleted. Both skills standards can be copied. The 
California Grade 6 Science Standard COPY is a copy made of California Grade 6 Science 
Standard, and is fully editable in this organization. 

 

Copying a Skills Standard 
An organization can make a copy of any skills standard that it owns, inherited from a parent 
organization, or imported from a sub-organization. 

• The copy is owned by the organization that made the copy, not by the organization that owns 
the original. 

• The copy constitutes a new, separate skills standard, that can be edited or deleted by its 
owner organization. 

• When a skills standard is copied, the copy’s competencies are mapped to the same modules 
and questions as the corresponding competencies in the original skills standard. 

• Any changes to the copy will not affect the original skills standard. 

• A copy made of an inherited skills standard can be imported by the parent organization. (See 
the next section, Importing Standards from Sub-Organizations, on page 353) 

To copy a skills standard: 

1. Select Content > Competencies. The Competencies page is displayed. 

2. Click the Copy icon  next to the skills standard to be copied. 
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The Copy Competency pop-up window is displayed. 

3. Enter the name to be given to the copied skills standard in the Name for New Skills Standard 
field. 

4. Click Save. 

 
The Competencies page is refreshed, and the copied competency is listed. Note that the 
organization that made the copy owns the copy, and can edit or delete it. 

 

Importing Standards from Sub-Organizations 
A parent organization is able to import skills standards created by its sub-organizations. 

• The imported skills standard is not a copy of the original.  

• The imported skills standard is owned by the sub-organization that created it, not by the 
parent organization. 
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• When a skills standard is imported, the skills standard’s competencies are mapped to the 

same modules as the corresponding competencies in the sub-organization. 

• The parent organization cannot edit the imported skills standard, or make new mappings. 

• If the parent organization wishes to edit the imported skills standard, a copy of the standard 
must be made. The copy can then be edited. 

To import a skills standard: 

1. Select Content > Competencies. The Competencies page is displayed. 

2. Select an organization from which to import a skills standard, from the Select Organization 
drop-down menu in the Import Skills Standard from Another Organization area. 

 
All skills standards owned by the selected sub-organization are listed. 

3. Select all skills standards to be imported, and click Import. 

 
The Competencies page is refreshed, and the imported skills standard is listed. 

Deleting A Skills Standard 
An organization can delete any skills standard that it owns. 

• When a parent organization deletes a skills standard, the skills standard, together will all 
competency mappings, are simultaneously removed from all sub-organizations. 

• A sub-organization may not delete a skills standard that it inherited from a parent organization. 

To delete a skills standard: 

1. Select Content > Competencies. The Competencies page is displayed. 

2. Click the Delete icon  next to the skills standard to be deleted. 
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You will be asked to confirm the deletion. 

 
3. Click OK to confirm deletion. 

The Competencies page is refreshed, and the selected skills standard is no longer listed. 

 

Competencies Reports 
LearnMate is able to generate a range of competency-related reports. See Reports – 
Competencies on page 163. 

 

Links Management 
Link libraries are comprehensive databases of links to websites that are relevant for a specific 
category. Once a link has been entered into the library for a specific category, it can be accessed 
by the student by clicking the Link icon  at the bottom of the Content Viewer. 

Note: The URLs for external websites are likely to change as time passes. You may need to 
occasionally update both the links provided with LearnMate modules, as well as those you added 
on your own. 
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An instructor has the same rights to view the Links library as the students have, and this is done in 
the same way. Only a Content Administrator, however, can add new items to a Links library or edit 
the individual links. If you find that you need either of these capabilities and you do not see a 
Content tab on your Navigation Menu, contact your Organization Administrator. 

Notes on Links Inheritance 
In Category Management on page 333you learned that inherited categories cannot be edited. The 
links library of an inherited category similarly cannot be edited: 

• Links cannot be edited. 

• Links cannot be deleted. 

• Links cannot be added. 

If you would like to add links to or edit links in a links library of an inherited category, first make a 
copy of the category (see Copying a Category on page 336). Remember to then assign affected 
modules to your new category (see Editing Module Details on page 319).  

Adding Links 
To add a link: 

1. Select Content > Categories. The Categories page is displayed, showing all available 
categories. 

2. Click the Links icon  next to the category to which you want to add a link to a relevant 
website. 

 
The Links page is displayed. 

3. Click Add. The Add link will be inactive if the category is not owned by your organization.  
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The Add Link page is displayed. 

4. Enter a name for the website in the Name field. 

5. Enter the website address in the URL text field. 

6. Enter a description of the website in the Description box. 

7. Click Save.  

 
The link is added to the Links List page.  

LearnMate v3.2 User Manual  357 
0609  Content Management 



  
 

 
When the student clicks the Link icon  in the Content Viewer, a separate window listing all 
the defined links is displayed. Clicking on a link of interest will open a new browser window to 
that site. 

Glossary Management 
Glossaries are comprehensive databases of key words and phrases used in the modules in a 
specific category. Once a term has been entered into the glossary for a specific category, it can be 
linked to from any of the modules in that category. In addition, the student can access and search 
the glossary from the Viewer by clicking the Glossary icon at the bottom of the window. 

An instructor has the same rights to view the glossary as the students have, and this is done in the 
same way: launching a module and clicking on the Glossary icon or the green hyperlinks. Only a 
Content Administrator, however, can add new terms to a Glossary or edit the definitions. If you 
find that you need either of these capabilities and you do not see a Content tab on your 
Navigation Menu, contact your Organization Administrator. See P  on page 225. ermissions
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Notes on Glossary Inheritance 
Category Management on page 3  you learned that inherited categories cannot be edited. The 
glossary of an inherited category similarly cannot be edited: 

• Glossary terms cannot be edited. 

• Glossary terms cannot be deleted. 

• Glossary terms cannot be added. 

If you would like add terms to or edit terms in a glossary of an inherited category, first make a copy 
of the category (see Copying a Category on page 336). Remember to then assign affected 
modules to your new category (see Editing Module Details on page 319). 
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Adding Glossary Terms 
To add a term to a category glossary: 

1. Select Content > Categories. The Categories page is displayed, showing all available 
categories. 

2. Click the Glossary icon  next to the category to whose glossary you wish to add a new term.  

 
The Glossary page is displayed for the category selected. 

3. Click Add New Term. The Add New Term link will be inactive if the category is not owned by your 
organization.  

Th
The Add New Term page is displayed. 

4. Enter the new glossary term in the Term text field located in the Add New Term area. 

5. Enter the definition of the term in the Definition box located in the Add New Term area. 

6. Click Save. 
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The term is added to the glossary for that category, and can be linked to from any of the 
modules assigned to that category. 

Viewing a Glossary Definition 
To search for and view a glossary definition: 

1. Select Content > Categories. The Categories page is displayed, showing all available 
categories.  

2. Click the Glossary icon  next to the category to whose glossary you wish to add a new term.  

 
The Glossary page is displayed for the category selected. 

3. Either enter the term in the Term field or part of the definition in the Definition field and click 
Search to search for a term, 

 
OR 
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Click the letter in the alphabet with which the term begins. 

The search results are shown. 

4. Click Edit  next to the term you would like to view. If the category is not owned by your 
organization, the Edit icon will be replaced by the View icon . Clicking  will allow you to 
view the definition, but not to edit it.  

 
The Edit Term page is displayed, with the definition of that term. 

 

Editing a Glossary Definition 
To edit a glossary definition: 

1. Select Content > Categories. The Categories page is displayed, showing all available 
categories.  

2. Click the Glossary icon  next to the category to whose glossary you wish to add a new term.  

3. Search for a term in the glossary as described in the previous section. 

4. Click Edit  next to the term you would like to edit. If the category is not owned by your 
organization, the Edit icon will be replaced by the View icon . Clicking  will allow you to 
view the definition, but not to edit it. 

 
The Edit Term page is displayed. 

5. Make the required change to the term and/or definition. 
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6. Click Save. If the category is not owned by your organization, the Save link will not be present. 

 
 

Assignments 

 
An assignment is a project that an instructor sets for the students of a class.  

They may be: 

• Library research reports 

• Experiments 

• Writing assignments 

• Art or shop projects 

• Photographs 

• Interviews 

• Analysis 

The instructor can provide computer files, links, and instructions to enable the students to 
complete the assignment, which can then be submitted via LearnMate.  

Assignments are graded individually by the instructor. If they are presented in electronic form, 
they may be submitted to the instructor through the LearnMate environment, even though they 
are not graded automatically like the module tests and class tests. Instructors can view 
Assignments and include them in their classes, but only a Content Administrator can create or edit 
an assignment. 

Instructors can view Assignments and include them in their classes, but only a Content 
Administrator can create or edit an assignment. If you find that you need either of these 
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capabilities and you do not see a Content tab on your Navigation Menu, contact your 
Organization Administrator. See P  on page 225. ermissions

Creating an Assignment 
To create an assignment: 

1. Select Content > Assignments. The Assignment Builder page is displayed. 

2. Click Add. 

 
The Add Assignment page is displayed. 

3. Complete the Name, Topic and Description fields. 

4. Click Save.  

 
The Edit Assignment page is displayed. 

5. To add a link for the assignment, enter the name of the website in the Description field, and 
the URL address in the URL field. Then click Add. 

 
The link is listed in the Links area. 
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6. A Reference File is a file that all students will be able to open or download, but not to edit and 

re-upload. Reference Files can either be imported from your My Folder, or uploaded from 
your PC or network. 

� To import a reference file for the assignment from My Folder: 

� Click Import from My Folder. 

 
My Folder is displayed. 

� Select the files to import and click Export to Assignment. 

 
The file is displayed in the Reference Files area. 

 
OR 

� To upload a reference file from your PC or network: 

� Click Upload to browse your computer hard-drive to find the file to attach.  

 
The Upload window is displayed. 

� Click Browse. 
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The Choose file dialog box is displayed. 

� Select the file to add as a reference file and click Open. 

 
The Upload window is redisplayed, with the selected file name shown. 

� Click Upload. 

 
The file is displayed in the Reference Files area. 

 
7. User Files are files that students upload to their own Assignments page. They can upload 

user files, download them, edit them and re-upload them. Finally, the student submits his user 
files to the instructor for grading (see Working with User Files on page 109). 

The instructor may want to provide each student with an initial user file. This could take the 
form of a worksheet on which each student will fill in his own answers before submission. 

� To provide the students with a user file: 

� The file must be first added as a reference file, as explained in the previous step. 

� Select the reference file that you would like to assign to each student as a user file. 

� Click Move to User Files. 
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The file is moved to the User Files area. 

 
� To move a user file back to the Reference Files area, select the file and click Move to Reference 

Files. 

� To delete a user file, select the file and click Delete. 

Note: Reference files cannot be moved to the User Files area if the assignment has already 
been included in a class. If the assignment has been included in a class, the Move to User Files 
link will not be displayed. 

8. To specify the criteria against which the students’ work will be graded: 

� Click Add in the Grading Criteria area. 

 
The Criteria page is displayed. 

� Select the criteria to be included. 

 
� To add your own criteria: 

� Click Add in the Organization Criteria area. 
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The Add Criteria page is displayed. 

� Enter the criterion in the Criterion field and click Add. 

 
The criterion is added to the Organization Criteria area of the Criteria page. 

 
� Organization criteria can be deleted by selecting the criteria to be deleted and clicking 

Delete. 

� Once you have selected all the criteria for the assignment, click Add to Assignment.  

  
The Edit Assignment page is displayed, with the chosen criteria listed in the Grading 
Criteria area. 

9. To weight the importance of each criterion in the students’ final assignment grade: 

� Either click Average Weighting Criteria to set all criteria to equal values. 

 
OR 

� Enter the percentage weightings manually.  
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� Click Calculate Criteria Total to calculate the total so that you can ensure that the total equals 
100%. 

 
� Click Save. The grading criteria are saved and the assignment is now created. 

To learn how to assign an assignment to a class, see Adding an Assignment on page 297. 

 

Searching for an Existing Assignment 
To search for a previously created assignment for editing or viewing via the Content menu: 

1. Select Content > Assignments. The Assignment Builder page is displayed. 

2. Complete any of the Name, Topic, or Description search fields.  

3. Click Search. 

 
A list of all assignments that match your criteria is displayed. 
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Editing an Assignment 
To edit an assignment: 

1. Search for an assignment as described in the previous section. 

2. Click the Edit Assignment icon  next to one of the search results. 

 
The Edit Assignment page is displayed. 

 
3. Make the required changes and click Save. To learn how the fields and links on this page 

function, see Creating an Assignment on page 3 . 63

Note: You may only edit assignments that you created. If you wish to make changes to an existing 
assignment that was created by another LearnMate user, you will need to make a copy of that 
assignment. 

Copying an Assignment 
You may wish to create an assignment that is similar to an existing assignment. LearnMate allows 
you to make a copy of an existing assignment. The copy can then be edited. 

To make a copy of an assignment: 

1. Select Content > Assignments. The Assignment Builder page is displayed. 

2. Complete any of the Name, Topic, or Description search fields.  
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3. Click Search. 

 
A list of all assignments that match your search criteria is displayed. 

4. Click the Copy Assignment icon  next to the assignment to be copied. 

 
The Search Results page is updated, and the new assignment is listed. The copy is assigned 
a name according to a default format, beginning with the word “copy”, and ending with the 
date of its creation. 

If you are permitted to edit an assignment, as will be the case with the copied assignment, an 
Edit  icon will be displayed to the right of the assignment name. If you are not permitted to 
edit an assignment, a View  icon will be displayed. 

5. Click the Edit Assignment icon  to edit the copied assignment.  

 
The Edit Assignment page is displayed. (If you click the View Assignment icon , the View 
Assignment page is displayed. This page contains the same information as the Edit 
Assignment page, but cannot be edited.) 

Make all required changes, particularly to the name of the assignment.  
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6. Click Save. 

Deleting Assignments 
To delete an assignment: 

1. Search for the assignment as explained above. 

2. Click the Delete icon  next to the assignment to be deleted.  

 
Note: You cannot delete any assignment that is currently assigned to a class. The Delete icon 

 will be inactive for all assignments that are currently assigned to classes.  
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Managing Assignments 
To learn how assignments are added to a class, see Assignments on page 297, in the Class 
Management chapter. To learn how students view and submit assignments, and how instructors 
grade assignments, see Assignments on page 1  in the My Desktop chapter. 07

Review 
In this chapter, we covered the following material: 

• Modules 

• Content Objects 

• Uploads 

• Categories 

• Competencies 

• Links 

• Glossary 

• Assignments 

 

Ask Yourself… 
• Can you create, edit, copy and delete each of the content types, as listed above? 
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11 
Content Authoring 

Review of Previous Chapter 
In previous sessions, we discussed the structure of content in the LearnMate database. You 
learned that LearnMate modules are built using content objects. A content object, as you have 
learned, is essentially one or more “pages” of information that can include text, tests (questions), 
graphics, animations, and video. 

We discussed the logic behind the database structure, and explored how media objects are 
stored in system-wide banks. You learned that each of these items can be independently 
referenced multiple times for use in different content objects. 

Introduction 
In this session, we are going to explore the facilities provided by LearnMate for content authoring. 
We will examine the use of each of the content authoring tools. By experimenting with the 
authoring tools, you will become familiar with the ways in which these tools are used.  

Note: The options discussed in this chapter are only available to instructors and administrators 
with Content Administrator permissions. 

Objectives 
This chapter will explore the following topics: 

• Introduction to Content Editing 

• Adding or Editing Text 

• Formatting Text 

• Creating Bulleted and Numbered Lists 

• Adding Page Breaks 

• Inserting Glossary Links 

• Inserting Links to Other Sections 

• Inserting Links to External Applications 

• Inserting Links to Websites 

• Inserting Tests 
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• Uploading Audio Narration Files 

• Content Editing Icons Quick Reference 

Introduction to Content Editing 

XML Tags 
All text formatting in a content object is performed using XML and HTML tags. While you do not 
need to have a background in XML programming to use these tools, you must keep in mind that 
these tags appear between triangular brackets <tag> and work in pairs. 

The first tag opens a command <tag>, and the second tag closes the command </tag>. The 
“close” tag is indicated by a / before the command.  

Adding or Editing Text 
Adding and editing text are the most basic tasks that you can perform to a content object. After 
text has been entered or edited, it can be formatted. For example, the size of the text can be 
changed, or certain words can appear in a different color. 

Text is added or edited simply by typing the required text in the Content Object Body area of the 
Content Object page. 

Adding or Editing Text 
To add or edit text: 

1. Click Content > Modules. The Modules page is displayed, listing all the modules in LearnMate to 
which your organization has access. 

2. Click Index  next to the name of the module in which the content object to which you want to 
add text is found. (To learn how to create a new module, see Adding a Module on page 310.) 

 
The Module Index (table of contents), in the form of a tree showing all the content objects in 
the selected module, is displayed. 
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3. Click Edit  next to the name of the content object that you want to edit. (To learn how to 

create new content objects, see Adding the First Content Object to the Index on page 322.) 

 
The Content Object page is displayed. 

4. Enter the required text in the Content Object Body area. 

 
5. When you have entered all the required text, click Update or Save As to save your changes.  

Note: LearnMate Content is written directly to the database and must be saved before it can 
be previewed. You must always click Update or Save As after making any changes to a content 
object. If you do not save your work and move to another page, those changes will be lost. 

� Update saves any changes made to the content object. Always save changes before 
moving to another page. 

� Save As enables you to make a change to and save a shared (reused) content object. 
The content object will then be owned by the current module and is unlinked from previous 
instances. This hyperlink only appears for shared content objects. To make a change that 
will be reflected in all other modules that use the content object, you must enter the index 
of the module that owns the content object and edit the content object there. 
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6. Click Preview to preview the way your content object will appear to students. 

 
The content object is displayed in the Content Viewer. 

 

The Navigation Hyperlinks 
The navigation hyperlinks below the Content Object Body area in the Content Object page enable 
you easily move between the content objects in a module, as well as save changes and preview 
objects. 

 
• Update saves any changes made to the content object. Always save changes before moving 

to another page. 

• Save As enables you to make a change to and save a shared (reused) content object. The 
content object will then be owned by the current module and is unlinked from previous 
instances. This hyperlink only appears for shared content objects. To make a change that will 
be reflected in all other modules that use the content object, you must enter the index of the 
module that owns the content object and edit the content object there. 

Before making a change in a shared content object (indicated by the presence of a Save as 
hyperlink and not an Update hyperlink), decide whether the change is relevant to all uses of 
this content object or only to this particular instance of it.  

� If the change is relevant to all uses of the content object, click Modules to find the module 
owner of that object (indicated by a checkmark), and then make the change in the module 
of origination.  
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� If the change is relevant only to this module, then click Save as to enable the current 
module to acquire “ownership” over this version of the content object. Then make required 
changes. 

• Preview displays the content object as it will be seen by the student.  

• Upload enables you to upload new media items to the Media Bank. See Uploading Media on 
page 330. 

• Index displays a tree showing all the content objects in the currently active module. 

• Prev moves you to the Content Object page for the previous content object in the module 
hierarchy. 

• Next moves you to the Content Object page for the next content object in the module 
hierarchy. 

• Modules enables you to view the Modules in which a content object is used. A  to the left of 
a module indicates that the content object originated in – and is owned by - that module. This 
is critical information for shared content objects, for which you need to decide whether to edit 
the original content object or to click Save As to unlink the content object. 

 
 

Tips and Tricks 
Always click Update after making any changes to a content object. If you do not click Update, and 
move to another page, your changes will not be saved. 

If you edit a content object and your changes are not shown when you Preview the content object, 
update (press F5) the Content Viewer window to ensure that the latest version of the content 
object is being previewed. 

Content Object Types 
In Adding the First Content Object to the Index on page 322, you learned that each content object 
must be defined by type: 

• General: For general purpose content objects. 

• Safety: For a content object that provides safety instructions. This content object can be 
opened automatically in the preview page by clicking the Safety icon . Only one content 
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object should be defined as a Safety content object per module. Once one content object has 
been set to Safety, this option will not be listed in the Tag pull-down menu. 

• Test: For a content object that will contain a test. A Test content object cannot contain text or 
graphics, only a test. 

The content object type is reflected in the Tag drop-down menu on the Edit Content Object page. 

Note the following: 

• It is recommended that you do not change the Tag setting of an existing content object. 
Instead, create a new content object of the required type (see Adding Additional Content 
Objects to a Module on page 324), and delete the old one (see Removing Content Objects 
from a Module on page 3 ). 28

• The Safety tag will not be listed in the Tag drop-down menu if another content object in the 
module has already been defined as a Safety content object.  

Formatting Text 
The appearance of text that has been added to a content object can be formatted as required. 

• Text can be made bold or italicized.  

• The size, color and font of the text can similarly be changed. 

The text formatting options are divided into two groups: 

• Independent Tools: Bold and Italics 

Bold and italics are independent text tools, meaning that they can perform their task without 
the use of any additional commands. Simply select the text to which you want to apply the 
formatting, click the appropriate icon, and the formatting is applied. 

• Dependent Tools: Font Size, Color and Face. 

Font Size, Font Color and Font Face are dependent formatting tools, meaning that they 
require the use of an additional tag in order to perform their task. These commands are 
inserted in front of the text to which you want to apply the formatting. The tag <end_font> is 
placed after the text, to stop the application of the formatting command. 

Bolding (Emphasizing) Text 
To bold text: 

1. Select the required text in the Content Object Body field. 
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2. Click . 

 
The tags <b> and </b> are displayed before and after the selected text, respectively. 

 
3. Click Update to save your changes. 

4. Click Preview to preview the content object. The text to which the formatting was applied should 
appear darker relative to the rest of the text. 

 

Italicizing (Slanting) Text 
To italicize text: 

1. Select the required text in the Content Object Body field. 
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2. Click . 

 
The tags <i> and </i> are added before and after the selected text, respectively. 

 
3. Update and preview the content object. The text to which you applied the formatting should 

appear slanted relative to the rest of the text. 

 

Changing the Font Size 
To change the font size: 

1. In the Content Object page, click in front of the text whose size you want to change. 
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2. Click .  

 
The tags <font_size></font_size> are inserted in front of the text. Note that unlike the bold or 
italics tags, both the tags appear before the text whose size you want to change. 

 
3. Enter the size of the text between the tags. The default text size is 2.  

4. To create smaller text, enter 1 between these tags.  

To create larger text, enter a number higher than 2. 

 
5. In the Content Object page, click after the text whose size you want to change. 
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6. Click . 

 
The tag <end_font> is added after the required text. 

 
7. Update and preview the content object. The text to which the formatting was applied should be 

a different size relative to the rest of the text. 

 
Note: The default text size is 2. All the text before the <font_size></font_size> tags is this size. All 
the text after the <end_font> tag will revert back to this default size. 

Changing the Font Color 
To change the font color: 

1. In the Content Object page, click in front of the text whose color you want to change. 

2. Click . The command <font_color></font_color> is inserted in front of the text. Note that 
unlike the bold or italics tags, both the tags appear before the text whose color you want to 
change. 
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3. Enter the new color of the text between the tags. You can change the color of the text to any 

color recognized by XML or HTML. 

4. You can enter the color either by typing the name or the color (for example, red) or by typing 
the color’s code (for example #00FFFF). 

5. Go to this website for a complete list of colors and their HEX codes. 
http://www.w3schools.com/html/html_colornames.asp. 

 
6. Click after the text whose color you want to change. 

7. Click . The tag <end_font> is added after the required text. 

 
8. Update and preview the content object. The selected text should be a different color relative to 

the rest of the text. 

 
Note: The default font color is black. All the text before the <font_color></font_color> tags is this 
color. All the text after the <end_font> tag will revert back to this default color. 
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Changing the Font Face 
To change the font face: 

1. In the Content Object page, click in front of the text whose font you want to change. 

2. Click . 

 
A pop-up window is displayed. 

3. Select the required font and click OK. Note that the default text font is Arial. 

 
The tag <font_face>font></font_face> is added before the selected text. 

 
4. Click after the required text. 

5. Click . The tag <end_font> is added after the required text. 

 
6. Update and preview the content object. The selected text should be a different font relative to 

the rest of the text. 
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Note: The default font face is Arial. All the text before the <font_face></font_face> tags is this 
font. All the text after the <end_font> tag will revert back to this default font.  

Adding a Header 
Typically, each LM page starts with a sub-heading that describes the page.  

To create a header: 

1. Select the required text in the Content Object Body field. 

 
2. Click the Header icon .  

 
The tags <header> and </header> are added before and after the selected text, respectively. 
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3. Update and preview the content object. The text to which you applied the formatting should 

appear in bold. 

 
Note: To make the header stand out more, we recommend that you place at least one blank line 
between the header and the first line of text. This is done by pressing [Enter] twice after the 
</header> tag. 

Creating Bulleted Lists 
To create a bulleted list: 

1. In the Content Object Body field, select the first line in the list. 

 
2. Click . 
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The Bullets pop-up window is displayed. 

3. Select the level of bullets that you require, where 1 are left aligned, 2 are indented one level, 
and so on, and click OK. 

 
The tag <blt1> or <blt2> is added before the text and the tag </blt1> or </blt2> is added at the 
end of the line. 

4. Repeat this procedure for each line in the bulleted list, or copy and paste the tags at the 
beginning and end of each line, respectively. 

Note: In a bulleted list, each entry should be on a separate line. 

 
5. Update and preview the content object. The modified text will appear as a bulleted list. 
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Creating Numbered Lists 
To create a numbered list: 

1. In the Content Object Body field, select the first line in the list. 

 
2. Click . 

 
The Numbering pop-up window is displayed. 

3. Select the level of numbers that you require, where 1 are left aligned, 2 are indented one level, 
and so on, and click OK. 
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The tag <nmbr1> or <nmbr2> is added before the text and the tag </nmbr1> or </nmbr2> is 
added at the end of the line. 

4. Repeat this procedure for each line in the numbered list, or copy and paste the tags at the 
beginning and end of each line, respectively. 

Note: In a numbered list, each entry should be on a separate line. 

 
5. Update and preview the content object. The modified text will appear as a numbered list. 

 

Adding Page Breaks 
Page breaks enable you to split up the information displayed in a single content object. The 
information is displayed in separate pages, but is saved in the database as a single content 
object. 
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To add a page break: 

1. Click after the last line of text that you want to appear on the page. 

 
2. Click . 

 
The tag <break> is added. 

3. Enter the text that you would like to appear on the next page. 

 
4. Update and preview the content object. All the text before the page break is displayed on one 

page.  
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5. Click the Next link to view the next that appears after the page break. 

 

Adding Media Items 
Media items, such as graphics, animations, videos or sound clips enliven the learning 
experience., making it more interactive and engaging 

LearnMate enables you to add different types of media files: graphics, animations and videos. 
Media items can be displayed in either a small frame or a big frame. Ideally, a small media item 
should be displayed in a small frame, and a big media item in a big frame. 

• If a big media item is displayed in a small frame, the media item will be shrunk down 
automatically to fit in the frame. This may result in a loss of quality. 

• If a small media item is displayed in a big frame, there will be a large amount of empty space 
around the media item. 

The Media Bank 
The Media Bank includes media files that can be used in content objects. Media types includes 
graphics (GIF or JPEG files), animations (SWF files), and videos (AVI, MPG and MPEG files). 

• Once uploaded to the system, a single media item can be included in multiple content objects. 

• As with content objects, a single copy of the media item is saved in the bank. This item is 
referenced in each of the content objects that use it. 

• Given this structure, any change to a media item need only be made once, to the item in the 
bank, in order for the changes to be seen in every instance of the item. 

• Media items are “owned” by a module. Therefore, media items must be uploaded to a 
particular module. They can then be reused in other modules.  

Uploading Media Files 
To upload a media file: 

1. Click Upload beneath the content object editing area. 
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OR  

2. Select the Upload submenu option from the Content navigation menu. 

The Upload pop-up window is displayed. 

3. Select the module that is to own the media item from the Module drop-down menu.  
(The current module is selected by default, if the Upload window is accessed from the 
Content Object page.) 

4. Upload media files as described in Uploading Media on page 330. 

Adding a Media File 
To use a media file in a content object: 

1. In the Content Object page, click at the beginning of the first line in the content object (or after 
a <break> tag to insert a media file on a subsequent page). 

2. Click the appropriate media icon depending on the type of media file you want to add. 

� To add a graphic in a small frame, click .  

� To add a graphic in a large frame, click .  

� To add an animation in a small frame, click .  

� To add an animation in a large frame, click . 

� To add a movie in a small frame, click . 

� To add a movie in a large frame, click . 

The Media Bank window is displayed. Media files are organized by the modules to which they 
originated. 

3. Select a module from the drop-down menu at the top of the window. Once a module has been 
selected, the list of graphics/animations/videos for that module is displayed in the File List. 
The File List also includes media items owned by other modules that have been used in the 
selected module. 

Note: Each selected media file can be viewed in the Preview window. 

4. Browse to the media file that you would like to insert and click Add. 

Note: The graphic shown represents the Insert Graphic to Section option. A similar but slightly 
different window will open when inserting an animation or video to the content object. 
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The media link is added to the content object. 

 
The following links are used, depending on the icon selected in step 2: 

� Big Picture: <big_picture></big_picture> 

� Small Picture: <small_picture></small_picture> 

� Big Flash: <big_flash></big_flash> 

� Small Flash: <small_flash></small_flash> 

� Big Movie: <big_movie></big_movie> 

� Small Movie: <small_movie></small_movie> 

5. Update and preview the content object. 
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Referencing Multiple Media Items on One Page 
You just learned how to specify one media file per page, by inserting a command such as 
<big_picture>1/1/mathoperators.gif</big_picture>. You may want to reference multiple media 
files on a single page.  

For example, a content object in a biology class may contain a picture of an adult elephant. On the 
same page, you can insert text “Click here to view a picture of a baby elephant.” The word here 
can be inserted as a link to a media file.  

To create a link for multiple media files on a single page: 

1. Insert the media item as usual. For example, you may insert a picture of a baby elephant. 

Example: <small_picture>425/526/babyelephant.gif</small_picture> 

2. Remove the second part of the command: 

Example: <small_picture>425/526/babyelephant.gif 

3. Add the command <link_text> after the file name: 

Example: <small_picture>425/526/babyelephant.gif<link_text> 

4. Enter the text from which you want to link: 

Example: <small_picture>425/507/math_01_003.gif<link_text>here 

5. Add the command </link_text> to close the link: 

Example: <small_picture>425/507/math_01_003.gif<link_text>here</link_text> 
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6. Add any other text that may be required to complete the page. 

Example: Click <small_picture>425/507/math_01_003.gif<link_text>here</link_text> to see a 
baby elephant. 

The content object will display a picture of an adult elephant at first. When the student clicks 
the word here, a picture of a baby elephant will be shown. 

 
7. Update and preview the content object. The link text should appear a different color, and when 

you click on it, the appropriate media item should be displayed. 

 
 

On a page that contains links to media items, it is advisable to create links for all media items. In 
the example shown above, once the student has clicked to see the baby elephant, he is unable to 
redisplay the adult elephant, unless you provide a link enabling this. 

For example, you may add text saying “Click here to redisplay the adult elephant. 
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The link is added as shown below. 

 
 

The page is displayed as shown below. 

 

 

Tips and Tricks 
• On a page that contains links to media items, it is advisable to create links for all media items, 

as described above. 

• Only one size of Viewer can be displayed per page. If a small media item and a large media 
item have been added to a single page, both items are displayed in large frames. 

• If a graphic and an animation have been added to a single page, the graphic is displayed first, 
regardless of the order in which they are called. 

• When an animation or movie is displayed, Play, Stop and Rewind buttons are added to the 
frame, enabling the user to stop, rewind or replay the animation or movie. 

Linking to Glossary Terms 
You can add a link to any glossary term defined for the category to which your module is assigned. 
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To add a link to a glossary term: 

1. In the Content Object page, click on the point in the text at which you would like to place a link 
to a glossary term. 

 
2. Click the Glossary icon . 

 
The Glossary pop-up window is displayed. 

3. Enter the term to which you would like to link, and click Add.  

Note: The term must exist in the glossary for this link to work. To check the glossary for 
existing terms, or to add a new term to the glossary, see Glossary Management on page 3 . 58

 
The link is added to your content object. 

 
Note that the term appears twice. The first instance is the text that will be looked up in the 
glossary, and must match a term that exists there. The second instance is the text that 
appears on the page. They need not be the same. For example, you may prefer that the term 
“integer number” be displayed. 

 
In the Content Viewer, the term will be displayed in green. Clicking on it will open the glossary 
to the relevant term. 
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Tips and Tricks 
• Links to glossary terms appear as follows in the content object. In this example, the link is to 

the word Example. 
<glossary>Example</glossary><glossary_text>Example</glossary_text> 

• The first set of tags refer to the entry in the glossary. This text must be identical to the term that 
appears in the glossary, including capital letters, punctuation and blank spaces. 

<glossary>Example</glossary> 

• The second set of tags refer to the link to the glossary term that is displayed in the content 
object. When the student clicks on this link, the appropriate glossary term is displayed. 

<glossary_text>Example</glossary_text> 

• By default, the link text is identical to the glossary term. The link text can however be changed 
as required. 

<glossary_text>Example</glossary_text> or <glossary_text>Examples</glossary_text>  

Linking to Sections 
To add a link to a different section in this module: 
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1. In the Content Object page, click at the point in the text where you would like the section link 

to appear. 

 
2. Click the Insert Section Link icon .  

 
The Add Link to a Section pop-up window is displayed, listing all the sections (content 
objects) in the current module. 

3. Select the section to which you would like to link. 

 
The link is inserted in the content object. 

 
4. Update and preview the content object. The name of the section is displayed as the link.  

5. Click on this text to go to the linked section. 
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The text between the <section_link></section_link> tags is by default the name of the content 
object to which you are linking. This text can be changed if required. 

Linking to Other Modules 
To add a link to a section in a different module: 

1. In the Content Object page, click at the point in the text where you would like the section link 
to appear. 

 
2. Click the Insert Module Link icon .  

 
The Add Link to Section in Different Module pop-up window is displayed. At the top of the 
window is a drop-down list box containing all of the available modules. 

3. Select a module. A list of sections in that module is displayed. 

4. Click the section to which you would like to link. 
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The link is added to your content object. 

 
5. Update and preview the content object. The name of the section is displayed as a link. When 

the student clicks on this text, the section opens in a new Content Viewer window. 

 

Linking to External Applications 
 modules often involve student experimentation with a range of software applications, 

such as PLC programmers, CAD/CAM packages and CNC and robotics simulation and control 
software. LearnMate offers unique capability that allows these programs to be activated from 
within a content object. For example, students can open the software by clicking on a link within 
the Content Viewer to open the software. Actions supported include opening and closing the 
program as well as minimizing, maximizing and restoring the software window. 

To add a link to an external application: 

1. In the Content Object page, click the point in the text at which you would like the link to the 
application to appear. 
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2. Click . 

 
The Add Application Operation pop-up window is displayed. 

3. Select the application to which you would like to link from the drop-down list. 

 
4. Select the operation that you would like performed on the application from the dropdown list. 

Note that the first link must always be to run the application. Once the application is opened, 
additional links can be made to manipulate the application, such as minimize, resize or exit. 

 
5. Enter link text in the Text field. This is the text on which the student will click to activate the 

link. 

6. Click Add. 
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The link is added to your content object. You may add text after the link to complete the 
sentence. 

 
7. Update and preview the content object.  

8. Click on the link to run and/ or manage the external application. 

 

Linking to Websites 
LearnMate enables the content developer to insert a link to an Internet website. When the student 
clicks the link, a new browser window will open, displaying the specified website. 

To add a link to a website (URL): 

1. In the Content Object page, click at the point in the text at which you would like the link to a 
website to be inserted. 

 
2. Click .  
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The Insert a Link pop-up window is displayed. 

3. Enter the URL of the website to which you want to link. http:// is shown by default. 

4. Enter the link text in the Link Text field. This is the text that the student will click to activate the 
link. 

5. Click Add. 

 
The link is added to your content object. You may add text after the link to complete the 
sentence. Note that http:// is not displayed inside the link. 

 
6. Update and preview the content object.  

7. Click on the link to open the web site in a new browser window. 

 

Adding Tests and Questions 
Tests can be inserted either in the form of questions or tests. A test is a predefined grouping of 
questions. Therefore, after defining a test, by inserting a single link to that test, a number of 
questions will be asked. 

The advantage of inserting a link to a test as opposed to links to each question is that the results 
of a test are saved and remain available to the instructor and student, whereas the results of 
individual questions cannot be retrieved.  
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This section explains how tests and questions are inserted into content objects. To learn how 
tests and questions are created, see the Test Authoring chapter on page 422. 

Searching for a Question 
To search for a question to insert: 

1. Select Content > Tests. The Test Builder page is displayed. 

2. Click Question Bank at the top of the page. 

 
The Add/Search Questions page is displayed. 

3. Enter the search criteria. 

4. Click Search. 

 
All questions matching the search criteria are listed.  

5. Note the ID number of the question you would like to insert in your content object. 

 

Adding a Question to a Content Object 
1. In the Edit Content Object page, click at the point in the text at which you want the question 

(test) to appear, and add the tags <Q></Q>. 
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2. Enter the identification number of your organization and the question in the database between 

the tags, separated by a “-“. 

 
3. Apply formatting as follows: 

� If the question is the first item in a content object, insert a page break after the question, 
before any text. 

� If the question is the last item in a content object, insert a page break before the question, 
after any text. 

� If the question is in the middle of a content object, insert page breaks both before and after 
the question, thus differentiating between the question and the text that comes before and 
after it. 

� If a number of questions are to be shown consecutively, the <q></q> tags do not have to 
be separated by <breaks>, but each set of <q></q> tags should be on a separate line. For 
example: 

text 

<break> 

<q>1-3232</q> 

<q>1-3244</q> 

<q>1-2939</q> 

<break> 

more text 

4. Update and preview the content object. The question is displayed in the Test Viewer. 
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Searching for a Test 
To search for a test to insert into a Content Object: 

1. Select Content > Tests. The Search for Test page is displayed. 

2. Enter the search criteria. 

3. Click Search. 

 
All tests matching the search criteria are listed.  

4. Note the ID and organization number of the test you would like to insert. 

 
5. To preview a test, click  next to the required test. 
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The list of the test’s questions is displayed in the View Test pop-up window. The correct 
answer(s) for each question are bolded. 

 
6. Click Close to close the View Test pop-up window. 

Adding a Test to a Content Object 
Whereas a content object can contain both text and questions, a content object that is to contain a 
test can only contain that test – it cannot contain text or other media. 

To add a test to a content object, you must create a new content object to contain that test. 

1. In the Module Index page, click Add  next to the content object under which you would like 
the new content object to be created. 
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The Add Content Object page is displayed. 

2. Enter the name of the new content object in the Name field in the Add New Content Object 
area. 

3. Select Test from the Tag drop-down menu. 

4. Click Add & Edit. 

 
The Add Test page is displayed. 

5. Enter any of the Name, Description, or Test ID of the test you would like to add. 

 
6. Click Search. 

The Search Results page is displayed. 

7. Click the Add Test icon  next to the test to be added. 
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The Edit Content Object page is displayed. The test number is automatically inserted 
between <T></T> tags, together with your organization number. A Test content object cannot 
be edited. 

 
8. Update and preview the content object. The test is displayed in the Test Viewer. 

 

Adding Automatically Converted Measurements 
When authoring a content object, you may wish to include measurements, such as 10 cm or 35 
inches, within your text. If your content is to be viewed by users of multiple organizations, some of 
which use the metric measurement system and others of which use the imperial system, you 
would want the appropriate unit system to be used for each. 

LearnMate allows you to enter measurements using either measurement system. LearnMate then 
automatically converts the measurements as required, depending on the student’s organization 
settings. For example, measurements can be entered using the metric units listed in the first 
column of the table below. The table shows the imperial units displayed when viewed by a user 
from an imperial organization. 
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Metric Unit 
Entered 

Symbol Imperial Unit 
Displayed 

Symbol 

meter m yard  yd 

centimeter cm inch  in 

millimeter mm inch  in 

kilometer km mile mi 

Grams g ounce oz 

milligram mg ounce oz 

kilogram kg pound  lb 

ton ton  pound  lb 

Celsius c  Fahrenheit F 
 

Measurements can be entered using the imperial units listed in the first column of the table below. 
The table shows the metric units displayed when viewed by a user from an metric organization. 

Imperial Unit 
Entered Symbol Metric Unit Displayed Symbol 
inch in centimeter cm 

feet ft centimeter cm 

yard yd meter m 

mile mi kilometer km 

pound lb kilogram kg 

ounce oz gram g 
 

Entering Measurements 
1. In the Edit Content Object page, locate your cursor at the point where you would like the 

measurement to be displayed. 
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2. Click the Measurements icon . 

 
The Add Measurement pop-up window is displayed. 

3. Enter the numerical value in the Text field. 

4. Select the unit of measurement from the drop-down menu. 

 
5. If you would like the unit of measurement to be displayed next to the number, select Add Name. 

If you do not, select Add Name, the number will be shown without a unit symbol. 

6. Click OK. 

 
The appropriate tag and number is entered in the content object body. 
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Note that the number is written between <lb></lbn> tags. This tells LearnMate that the value 
12000 is in terms of pounds. The n in the second tag instructs LearnMate to display the unit 
symbol – the student will see 12000lb. Had the n been omitted, the student would only see 
12000. 

7. You can enter measurements from both measurement systems in the same content object. 
For example, in the content object shown below, the weight is specified in pounds, and the 
height is specified in meters. 

 
� A student from an organization whose default measurements are defined as “metric” will 

see both measurements in metric units: 

 
� A student from an organization whose default measurements are defined as “imperial” 

organization will see both measurements in imperial units: 
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Adding Audio Narration Files 
LearnMate allows all content editors to upload sound files to narrate content text. The following 
principles must be followed.  

• One sound file must be created for each page of content that requires narration. 

• The sound files must be in MP3 format. 

The process consists of two steps: 

• Recording the speech files 

• Uploading the speech files 

Recording Speech Files 
One speech file must be recorded per page of content. The files can be given any name at all, but 
it is important that it be clear which page each file corresponds to. This will make it easier for you 
to upload the files later. 

1. Open the module to be narrated, in the Content Viewer. 
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2. Read the page aloud while recording. 

3. Save the recording file. 

You may give the file any name, but it must clearly identify the page recorded. This will help 
you when uploading the file later. 

We recommend the following format: [Content object name]-[First line of text].mp3 

For example, the speech file for the page shown above would be Electricity and Electronics – 
Introduction to Electricity and Electronics.mp3. 

4. Continue to the next page, and repeat the instructions above for all pages that are to have 
speech narration. 

Uploading a Speech File 
NOTE: Some system administrators block the upload and download of MP3 files. Uploading 
speech files requires that the upload of MP3 files be allowed. 

To upload a speech file: 

1. Open the content editing page of the content object for which you want to upload speech files. 
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2. Click the TTS icon . 

 
The Add Alternative Text window opens.  

3. Click Upload Sound File. 

 
4. The Upload Audio File window is displayed. It shows all the text in the content object, for 

each page separately. 

5. Click Upload File next the text of the page for which you would like to upload a sound file. 
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The Upload Audio File pop-up window is displayed. 

6. Click Browse. 

 
7. Locate the speech file that corresponds to the page for which you are uploading narration, and 

click Open. 

 
8. Click Upload in the Upload Audio File pop-up window. 
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After the file has uploaded, the pop-up closes. 

LearnMate assigns a new name to the audio file you uploaded, based on the ID of the content 
object and the page number within the content object. This number is shown in the Audio File 
column of the Upload Audio File window. 

 
9. If there are other pages listed on the Upload Audio File window, repeat steps 4 to 8 for each. 

10. Once you have uploaded sound files for all pages in the content object, click Close. 

 
11. To verify that the files have been correctly uploaded, preview the content object, and click the 

Audio icon  on each page to listen to the narration. 

For each content object that requires speech narration, repeat the above process from step 1 
through 11. 
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Content Editing Icons Quick Reference 
The following is a quick reference guide for all icons used in LearnMate Author. 

Icon Description Tag 

 

Insert a graphic from the bank. The 
graphic is displayed in a small frame. 

 

<small_picture>graphic.gif</small_picture> 

 
Insert a graphic from the bank. The 
graphic is displayed in a big frame. 

<big_picture>graphic.gif</big_picture> 

 

Insert a graphic from the bank. The 
graphic is displayed without a frame, in 
the text area. 

<inside_picture>graphic.gif</inside_picture> 

 

Insert a flash animation from the bank. 
The flash animation is displayed in a 
small frame. 

<small_flash>flash.swf</small_flash> 

 

 

Insert a flash animation from the bank. 
The flash animation is displayed in a big 
frame. 

<big_flash>flash.swf</big_flash> 

 

Insert a movie from the bank. The movie 
is displayed in a small frame, with Stop, 
Play and Rewind options. 

<small_movie>graphic.gif</small_movie> 

 

Insert a movie from the bank. The movie 
is displayed in a big frame, with Stop, 
Play and Rewind options. 

<big_movie>graphic.gif</big_movie> 

 
Make selected text bold. <b>text</b> 

 
Make selected text italics. <i>text</i> 

 
Insert a bullet at the beginning of a 
sentence.  

<blt1> 

 
Insert a number at the beginning of a 
sentence, 

<nmbr1> 

 

Change the font face of the text that 
follows the command. Close this 
command using <end_font>. 

<font_face>font</font_face> 
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Icon Description Tag 

 

Change the font size of the text that 
follows this command. Close this 
command using <end_font>. 

<font_size>#</font_size> 

 

Change the font color of the text that 
follows this command. Close this 
command using <end_font>. 

<font_color>color</font_color> 

 

Close the font size, font face or font color 
commands. 

Note: Even if more than one font change 
command is being cancelled, the 
end_font tag need only appear once. 

<end_font> 

 
Adds a sub-heading to the page. Close 
this command using <\header>. 

<header>Header</header> 

 
Insert a page break within a content 
object. 

<break> 

 

 

Insert a link to a term in the glossary. 

Note: The first command references the 
exact term in the glossary. The second 
command is the link text that is displayed 
in the Viewer. 

<glossary>Glossary</glossary><glossary_ 
text>Glossary</glossary_text> 

 

Insert a link to a site on the World Wide 
Web. 

Note: When entering a link to a website, 
begin the address with www. Do not 
include http://. 

<link>www.intelitek.com</link> 

 
Insert a link to an external application.  

 
Insert a link to another content object in 
the module. 

<section_link>00000</section_link>section_
name</section_link_text> 

 

Link to a content object in a different 
module. The content object opens in a 
separate Module Viewer 

<module_link>00000</module_link>section_
name</module_link_text> 

 
Add or replace a test (only for content 
objects that are defined as Test). 
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Icon Description Tag 

 

Insert a number with a measurement tag. Depends on measurement, for example: 

<lb></lb>, <km></km>, <yd></yd>. 

Suffix an in the second tag to display the unit 
symbol after the number, for example, 
<lb></lbn> 

 

Used by customers to upload their own 
MP3 narration files. 

Used by Intelitek to insert text (alternate 
narration text) to be read by the 
text-to-speech engine instead of the text 
entered in the editing page.  

 

Review 
In this chapter, we covered the following material: 

• We experimented with the different options that LearnMate offers for editing content objects.  

• We added and formatted text, added media items, tests and questions, and inserted links to 
glossary terms, sections and websites. 

Ask Yourself… 
• Can you add text to a content object? 

• Can you use the independent formatting tools (bold and italics)? 

• Can you use the dependent formatting tools (font size, font face and font color)? 

• Can you create bulleted or numbered lists? 

• Can you add media items to a content object? 

• Can you create links to media items? 

• Can you insert and modify links to glossary terms to a content object? 

• Can you control external applications? 

• Can you insert links to websites? 

• Can you insert questions and page breaks? 

• Can you insert tests? 

• Can you add audio narration files to a content object? 
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12 
Test Authoring 

Review of Previous Chapter 
In the previous chapter, we explored the tools provided by LearnMate for online content editing.  

• You experimented with changing the appearance of text in a content object, for example, by 
making text bold or italicized, adding bullets or numbers, or changing the size or color of the 
text. 

• You experimented with adding media items such as pictures and videos to a content object. 

• You learned how to add links to other content objects within the same module, content objects 
in other modules and Internet websites. 

• You learned how to add questions and tests to a content object. 

• You learned how to upload audio narration files. 

Introduction 
LearnMate allows one to author questions and to use existing questions from the question bank. 
LearnMate includes a wide variety of question types that on the one hand ensure that the student 
has grasped the material, and on the other hand ensure an interactive learning experience. 

Each question includes the question text, the possible answers, the number and style of which 
change depending on the question type, and feedback. Each question can also include a graphic 
and a hint. Each question can be linked to one ore more competencies. 

Tests, which comprise a number of questions, can be created and placed throughout a module, or 
assigned to a class. The scores each student obtains on any test will be available to the instructor. 

In LearnMate, questions can be considered the building blocks of tests, much like content objects 
are the building blocks of modules. 

Note: The options discussed in this chapter are only available to instructors and administrators 
with Content Administrator permissions. 

Objectives 
In this chapter, we will explore the following topics: 
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• Questions: Including question types, how questions are created, edited and inserted into 

modules. 

• Tests: How tests are created and inserted into modules. 

• Pre-Tests: How pre-tests are created and added to modules. 

Questions 

Question Types 
LearnMate enables an instructor to formulate questions in a range of formats: 

• A multiple choice question includes a question and four possible answers, of which only 
one answer is correct. 

• A multiple multiple choice question includes a question and four possible answers, of 
which more than one answer is correct. 

• Fill-in-the-blank questions include a question and up to our possible answers, only one of 
which correctly completes the statement. 

• True or False questions include a statement, of which the student has to determine validity - 
decide whether the statement is true or false. 

• Hot spot questions require the student to click on a specific point in a graphic. 

• Drag and drop (Ordered) require that the student arrange a list of items, or a group of 
graphics, in the correct order. This type is recommended for procedural-type questions. 

• Drag and drop (Not Ordered) require the student to move the correct or incorrect items into a 
box. This question type is recommended for sorting tasks. 

• Matching questions require that the student match between two lists of items. 

• Authentic assessment: requires that the student perform a task in the presence of the 
instructor, who then assigns a grade for the task, according to predefined criteria. 

• Open/Essay: requires that the student answer a short answer or essay question. This is the 
only question type that is not automatically graded by LearnMate. 

Generic and Non-Generic Questions 
When creating a question, you are required to specify whether the question is generic or not.  

• A non-generic question is one that is context sensitive, and as such, can only reasonably be 
asked at a particular point in the module. As an example, questions relating to the results of an 
experiment conducted in a task should only be asked during, or directly after, the task.  

• For example: “Which LED was lit during the experiment?” 
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• A generic question is a non-context sensitive question that a student can reasonably be 

asked on completion of an activity or module. Questions on theory or general understanding 
are most often generic.  

For example: “Which of the following materials are conductors?” 

The significance of whether a question is marked as generic or not relates to the generation of the 
post-test that the student takes after completing the module. LearnMate can automatically select 
40 questions from a module to formulate a post-test. Only questions marked as generic are 
included in the post-test. (To learn more about post-tests, see Adding/Creating a Post-test on 
page 314) 

Creating Questions 
To create a question: 

1. Select Content > Tests. The Test Builder page is displayed. 

2. Click Question Bank at the top of the page. 

 
3. The Question Bank page is displayed, and allows you to search for existing questions (see 

Searching for a Question on page 4 ) or to create new questions. 05

4. Click Add. 

 
The Add Question page is displayed. 

5. Select the type of question you would like to create from the Question Type drop-down menu. 

6. Select the module that you would like the question to be a part of from the Module drop-down 
menu. This module will “own” the question, although the question will be available for use by 
other modules created by your organization. 

7. Click Add. 
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The Question Editing page is displayed. 

8. Type the question text in the Question text box. 

� For FI (Fill-in-the-blank) questions, type _______ to form the blank space. 

 
� For AA (Authentic Assessment) questions, type the task instructions in the Task text box. 

 
9. To select a picture to be displayed with the question: 

� Click the Choose Picture icon .  

 
The Media Bank is displayed.  

� Choose the picture to insert, and click Add. 
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The question name is shown in the Picture field. 

 
Note: Do not use animated gifs in questions, as they do not display properly in questions. 

10. Check the Generic checkbox if the question is generic. When LearnMate creates a post-test 
automatically, only generic questions are included.  

 
11. Fill in the answers and mark the correct one, depending on the question type: 

� TF (True/False):  

� Check the checkbox next to the correct answer. 

� You may click the Choose Picture icon  to select a graphic for each alternative (the 
graphic should be small).  

 
� MC (Multiple Choice):  

� Enter the alternative answers in the fields Answer 1 to Answer 4.  

� Check the checkbox next to the correct answer. 

� You may click the Choose Picture icon  to select a graphic for each answer (the 
graphic should be small).  
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� MMC (Multiple Multiple Choice):  

� Enter the alternative answers in the fields Answer 1 to Answer 4.  

� Check the checkbox next to all correct answers. 

� You may click the Choose Picture icon  to select a graphic for each answer (the 
graphic should be small).  

 
� HS (Hotspot):  

� A picture must first be defined, as described above.  

� Click the Set Coordinates  icon. 

 
The selected graphic is displayed.  

� Click the location of the upper left corner of the correct area of the picture.  
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� Select the Bottom Right checkbox, and click the location of the lower left corner of the 

correct area of the picture. 

 
� Click Save. 

 
The coordinates (in pixels) are shown in the Coordinates field. Up to four correct locations 
can be specified. 

 
� MAT (Matching):  
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� For each matching pair, fill in the Answer and Match Text fields.  

� Alternatively, or in addition, you can specify graphics to be matched by selecting 
graphics for the Picture and Match Picture fields, using the Choose Picture icon . Up to 
four pairs can be specified. 

 
� FI (Fill-in-the-blank):  

� Enter the alternative answers in the fields Answer 1 to Answer 4.  

� Check the checkbox next to the correct answer. 

� You may click the Choose Picture icon  to select a graphic for each answer (the 
graphic should be small).  

 
� DDO (Drag-and-Drop-Ordered):  

� Select whether the answers should be arranged vertically or horizontally from the 
Picture Order drop-down menu.  
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� If you select Vertical, you will be able to enter either text or picture answers. 

� If you select Horizontal, you will only be able to enter picture answers. The text answer 
fields will be disabled. Text answers can only be displayed vertically. 

 
Enter the answers in order in the fields Answer 1 to Answer 4, such that the first answer is 
Answer 1 and the last is Answer 4.  

� You may click the Choose Picture icon  to select a graphic for each answer (the 
graphic should be small).  

 
� DDN (Drag-and-Drop Not Ordered):  

� Select whether the answers should be arranged vertically or horizontally from the 
Picture Order drop-down menu.  

 
� If you select Vertical, you will be able to enter either text or picture answers. 

� If you select Horizontal, you will only be able to enter picture answers. The text answer 
fields will be disabled. Text answers can only be displayed vertically. 

LearnMate v3.2 User Manual  430 
0609  Test Authoring 



  
 

 
� Enter the alternative answers in the fields Answer 1 to Answer 4.  

� Check the checkbox next to all correct answers. 

� You may click the Choose Picture icon  to select a graphic for each answer (the 
graphic should be small).  

 
� AA (Authentic Assessment): Type each criterion for evaluation in the Criteria for 

Evaluation text box. Press Enter at the end of each criteria, so that each criterion is listed 
on its own line. 

 
� Open/Essay Question: This question type does not require answers to be entered. 

12. Type a hint in the Hint text box (optional). 

 
This text is displayed when the student clicks Hint in the Test Viewer. 
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13. Type feedback in the Feedback text box. This text is displayed when the answer to the 

question is shown. 

 
14. Click Save to save your question. The Question Editing page is refreshed. A question ID 

number is assigned to the question, and is displayed in the Question Details area. 

 
15. Click Preview to see how your question will appear to the student. 

 
16. Click Back on the Question Edit page to return to the Create New Question page. 

 

LearnMate v3.2 User Manual  432 
0609  Test Authoring 



  
 
Editing a Question 
Once a question has been saved, it can be edited at any time.  

To edit a question: 

1. Select Content > Tests. The Test Builder page is displayed. 

2. Click Question Bank at the top of the page. 

3. Search for the question you wish to edit by entering search criteria. Then click Search. 

 
All questions matching the search criteria are listed. 

 
Note: A  icon next to a question indicates that the question is used in a test. This may 
influence your decision on whether to edit the question or not. 

Clicking the Test icon  opens a pop-up window listing all the tests in which the question is 
used. Clicking the Edit icon  next to a test in this window directs the main LearnMate window 
to the Test Edit page, see Creating a Test on page 437. Clicking the Preview  icon opens 
the View Test pop-up window, see Searching for a Test on page 407. 
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4. Click the Edit icon  next to the question you would like to edit. 

 
The Edit Question page is displayed.  

5. Make the required changes. 

6. To delete an alternative answer from the question, click the Delete icon  next to that answer. 

 
7. Click Save. The Edit Question page is refreshed. We recommend previewing the question to 

ensure that it still displays correctly. 

Associating Questions with Competencies 
You learned previously how competencies can be assigned to modules and content objects. 
LearnMate also enables you to assign competencies to individual assessment questions. 

For more information about competencies, see Competencies on page 3 . 37

1. Select Content > Tests. The Test Builder page is displayed. 

2. Click Question Bank. The Question Bank page is displayed. 

3. Enter the search criteria, such as the ID number of the question. 

4. Click Search. 
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The search results are displayed. 

5. Click the Edit icon . 

 
The Edit Question page is displayed. 

6. Select a Skills Standard from the Skills Standard drop-down menu.  

 
7. To add a mapping to the skills standard, click Add.  

 
Note: You may only map questions to skills standards owned by your organization. The Add 
link will be disabled if you select a skills standard not owned by your organization. 

The Add Questions to Competencies pop-up window is displayed. 

8. Check all competencies to be mapped to the question.  

 
9. Click Submit to save your mappings. 

The competencies selected are now listed in the Competencies area.  
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10. To remove a competency, select the relevant checkbox and click Unmap.  

 
11. You will be asked for confirmation. Click OK.  

 
The selected competency is removed from the list of competencies.  

 

Inserting Questions into a Module 
To learn how questions are inserted into a module, see Adding a Question to a Content Object on 
page 405. 

Deleting Questions 
To delete a question from the database: 

1. Select Content > Tests. The Test Builder page is displayed. 

2. Click Question Bank at the top of the page. 

3. Search for the question you wish to edit by entering search criteria. Then click Search. 
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All questions matching the search criteria are listed. 

4. Select the question to be deleted, and click Delete. 

 
The question is deleted. 

Note: LearnMate does not permit questions that have been included in tests to be deleted. 
The presence of a Test icon  next to a question indicates that it is part of a test.  

 
 

Tests 
A test is made up of individual questions. Only once all the questions for a test have been created 
should the test be created. Questions can also be added to an existing test at any time. 

Creating a Test 
To create a test: 

1. Select Content > Tests. The Test Builder page is displayed. 
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The Test Builder page allows you to search for existing tests (see Searching for a Test on 
page 407) or to create new tests. 

2. Click Add. 

 
The Add Test page displays. 

3. Enter the test’s name in the Name field, and a description of the test in the Description text 
box. 

Note: The test name may not include quotation marks. 

4. Click Save.  

The Edit Test page is displayed. Note that a test ID number has been assigned to the test, 
and is shown in the Test Details area. 

 

Adding Questions to a Test 
1. In the Edit Test page, click Add in the Questions area. 
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The Add Questions page is displayed. 

2. Enter the search criteria for the question you are looking for and click Search. 

 
A list of questions matching the criteria is displayed. 

3. Select the checkbox next to the question(s) you would like to add to the test. You can select 
multiple questions if multiple questions are listed. 

4. Click Add.  

 
The Add Question page is redisplayed, ready for you to search for the next question to add. 

5. To add another question, return to step 2,  

OR 

To stop adding questions, and save the test, click Back.  

 
The Edit Test page is displayed, listing all the questions you added in the Questions section. 

6. Click Set Average Weight to set all questions to have the same weighting in the calculation of the 
test average, or fill in the values manually, ensuring that the total equals 100%. 
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7. The questions can be reordered by using the arrow icons: 

: Moves the question one place up. 

: Moves the question one place down. 

: Moves the question to the first place in the list. 

: Moves the question to the last place in the list. 

8. Click Save New Order and Weight to save the weightings and order that have been set. 

 
9. To view a list of questions and answers, click View Test. The View Test pop-up window is 

shown. Click Close to close the View Test pop-up window. 

 
10. Click Back to return to the Test Builder page. 
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11. To remove questions from a test, select the relevant checkboxes, and click Delete.  

Inserting Tests into a Module 
To learn how tests are inserted into a module, see Adding a Test to a Content Object on page 408. 

Adding Tests to a Class 
To learn how tests can be added to a class, see Adding a Test to a Class on page 288. 

Deleting a Test 
1. Select Content > Tests. The Test Builder page is displayed. 

2. Enter the search criteria, and click Search. 

 
All tests matching the search criteria are listed. 

3. Select the test to be deleted, and click Delete. 

 
The test is deleted. 

Note: LearnMate does not permit tests that have been included in modules or in classes to be 
deleted. The checkbox next to such a test is not selectable. 
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Pre-Tests 
An instructor may like to gauge the progress that each student makes over the course of a 
module. One way of accomplishing this is by having each student take a pre-test before starting 
the module. The pre-test can optionally be identical to the post-test, in which case the results of 
the two scores can be compared question-by-question in the Academic Progress Report to 
determine the extent of the learning that occurred. Alternately, the pre-test can be an entirely 
different test built and selected by the instructor, in which case the Academic Progress Report will 
compare the final grades of both tests (pre and post). Should an instructor wish to deploy a 
pre-test for a module, the student is prevented from launching the module until the pre-test score 
has been submitted.  

If the instructor prefers that the pre-test be the same as the post-test, there is no need to create a 
pre-test – the existing post-test can be specified as the pre-test. 

If the instructor would like to create a new test to be used as a pre-test, see section Creating a 
Test on page 437, and create the pre-test as you would any other test. There is no defined naming 
or any other pre-test-specific conventions – pre-tests are no different than other tests. 

Specifying which test is to be used as a pre-test, if any, is accomplished on the Define Delivery 
Options page, explained in the section Enabling Pre-Test on page 271. 

 

Comparing the Pre-Test and Post-Test Results 
Test results can be compared using the Academic Progress Report, which is described in the 
section Academic Progress Report, on page 1 . 86

Review  
In this chapter, we covered the following material: 

• We explored questions and tests.  

• We learned what question types LearnMate supports. 
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• We discovered how questions and tests are created. 

• We learned how to create a pre-test.  

Ask Yourself… 
List some of the question types that can be created in LearnMate. 

• Can you create questions of all different types? 

• Can you create a test? 

• Can you add questions to a test? 

• Can you create a pre-test? 
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13 
Troubleshooting 

Introduction 
This section presents a list of problems that may seem to occur and their solutions. The problems 
are divided into the following categories: 

• Class Management 

• Content Editing 

• Content Management and System Administration 

• My Folder 

• Other 

Class Management 
Problem Possible Cause Solution 

The Average Class Grade 
shown at the top of the Class 
Main Page seems very low. 

This value takes into 
consideration the grades that 
have not yet been completed. 
To simplify this concept, the 
Average Class Grade is the 
average of the students’ grades 
if they all received a 0% on all 
remaining graded activities.  

For this reason, the Average 
Class Grade will increase 
throughout the course. 

See Average Class Grade on 
page 256. 

 

The Average Class Grade 
never seems to change. 

This value is not updated 
automatically. 

Click Update Grades in the 
Students panel in the Class 
Main Page. 

See Updating All Students’ 
Grades on page 281. 
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After copying a class, the new 
class does not include the 
Rotational Schedule set up for 
the original class. 

Rotation Schedules are not 
copied by the Copy Class 
function. 

Set up a new Rotational 
Schedule in the new class. 

See Rotational Schedules on 
page 262. 

Students are unable to navigate 
freely through a module using 
the Index. 

The Open index navigation 
checkbox at the top of the 
module’s Define Delivery 
Options window is not checked.

Check the Open index 
navigation checkbox at the top 
of the module’s Define Delivery 
Options window. 

Do not confuse this with the 
Navigation Open checkbox 
lower down in the window, 
which pertains to navigation 
within tests. 

See Specify Open Index 
Navigation no page 270. 

Content Editing 
Problem Possible Cause Solution 

After reordering content objects 
in an index, the changes made 
seem to be lost. 

User did not click Submit 
Structure Changes. 

After making changes to the 
order or hierarchy of content 
objects in an index, click Submit 
Structure Changes. The page 
will refresh, and the changes will 
be reflected. 

See Reordering Content Objects 
on page 3 . 26

An Open/Essay question with a 
picture looks distorted. 

The picture assigned to the 
question is too large. 

Resize the picture to 300 pixels 
(width) x 200 pixels (height).  

See Creating Questions on page 
. 424
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The Update button in the Edit 
Content Object page is renamed 
as Save As. 

The content object is owned by a 
different module, and cannot be 
edited. 

Click the Modules link. You will 
be shown a list of all modules 
that use the content object. The 
module that owns the content 
object is indicated with a 
checkmark. 

If your organization owns the 
module that owns the content 
object, you can edit the content 
object in that module, and all 
changes will be visible in all 
other modules that use it. 

If your organization does not 
own the content object, you must 
create a new content object that 
you can edit. To do so, click the 
Save As button. You will be 
warned that doing so will create 
a new content object. Click OK. 

A new content object is created 
in place of the old one, and you 
are now free to edit it and click 
Update as required. 

See The Navigation Hyperlinks 
on page 3 . 76

The automatically-created 
Post-Test does not contain 40 
questions. 

The module does not include 40 
questions.  

The post-test includes all 
generic questions that were 
assigned to the module in the 
Create New Question window, 
and all generic questions owned 
by other modules that are used 
within the module. 

Create new questions for the 
module and create a new 
post-test, or, if appropriate, 
manually edit the post-test, 
adding questions from other 
modules. 

See Adding/Creating a Post-test 
on page 3 . 14
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An Internet link within the 
Content Viewers is not displayed 
correctly; the address is shown 
twice. 

The link <link> tags include 
http://, for example: 

<link>http://www.intelitek.com<li
nk_text> 

Intelitek.com</link_text> 

Remove the http:// from the link, 
for example:  

<link>www.intelitek.com<link_te
xt> 

Intelitek.com</link_text> 

See Linking to Websites on page 
. 404

Clicking a green glossary link in 
the Content Viewer opens the 
Glossary window, with the 
message “not found”. 

The glossary term in the 
<glossary></glossary> tags is 
not the same as any term within 
the glossary. 

1. Check that the word is found 
in the glossary. For example, if 
the glossary includes a definition 
for Car, the glossary tags must 
be written 
<glossary>Car</glossary> and 
not <glossary>Cars</glossary>. 

 

2. Ensure that there are no extra 
spaces within the tags, such as 
in 

<glossary>Car </glossary>  

 See Linking to Glossary Terms 
on page 3 . 96

Clicking any green glossary link 
in the Content Viewer opens the 
Glossary window, with the 
message “not found”. 

The module is not linked to the 
correct category. 

In the Module Details page, 
ensure that the correct Category 
is selected. 

See Linking to Glossary Terms 
on page 3 . 96

When creating a new content 
object, the Tag drop-down menu 
in the Add Content Object page 
does not include Safety. 

The module already includes a 
Safety content object. Each 
module can only have one 
content objected tagged as 
Safety. 

Return to the module index. The 
words (Safety CO) are shown 
next to the content object 
currently marked as Safety. 
Change the tag to General, and 
Update. You may now add a 
new Safety content object to the 
module. 

See Content Object Types on 
page 377. 
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A test question does not load in 
the Test Viewer. 

The graphic specified to be 
shown with the question is an 
animated gif file.  

Replace the animated gif with a 
static gif or jpg graphic. 

See Editing a Question on page 
. 433

The file exists in your computer’s 
cache. 

In Internet Explorer, select 
Tools>Internet Options. In the 
Temporary Internet Files area, 
click Delete Files.  

 

Refresh you Content Viewer by 
pressing F5 on your keyboard. 

After uploading a new version of 
a media object file (gif, jpg, avi or 
swf), the old version is still being 
shown in the Content Viewer. 

The file exists in your network’s 
cache. 

If are working on a network, and 
have tried clearing your 
computer’s cache without 
success, the old file may be 
present in your network’s cache. 
Ask your system administrator to 
clear the cache. 

 

Alternatively, upload the file 
under a new name, and change 
the media tags appropriately. 
This tactic does result in a 
number of unused files on the 
server, and can cause confusion 
later. 

In the Content Viewer, in a place 
where a question is supposed to 
be displayed, a red x is 
displayed instead. 

JAVA is not installed. In the Class Main Page, click 
Utility Check, and install JAVA 
from there. 

See LearnMate Utility Check on 
page 6. 

In the Content Viewer, in a place 
where a flash (swf) is supposed 
be displayed in the Viewer, the 
Viewer is blank, except for an 
icon in its top right corner. 

Macromedia Flash is not 
installed. 

In the Class Main Page, click 
Utility Check, and install 
Macromedia Flash from there. 

See LearnMate Utility Check on 
page 6. 
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Content Management and System Administration 
Problem Possible Cause Solution 

One or both of the Content and 
Administration tags are missing 
from my Navigation bar 

You do not have the necessary 
levels of permission. 

Contact your LearnMate 
system administrator, to adjust 
your levels of permissions. 

See Roles on apge 223 and 
Permissions on page 2 . 25

Error on page message 
displayed at bottom of screen. 

Module, Test or Assignment 
listed on page includes an 
apostrophe in its name. 

Do not include apostrophes in 
Module, Test or Assignment 
names. 

Module, Test or Assignment not 
found in a search. 

Apostrophes in Module, Test 
and Assignment names may 
cause those entities to not be 
found in searches. 

Do not include apostrophes in 
Module, Test or Assignment 
names. 

A sub-organization is missing 
from drop-down menus and 
reports. 

The sub-organization is of a 
different language than your 
organization. 

Log into the sub-organization of 
interest to edit, change settings 
or generate reports, instead of 
attempting to do so from the 
parent organization. 

After changing the 
Measurement Type setting in 
the Edit Organization page, 
modules are still displayed with 
the old measurement settings. 

Changes to the Measurement 
Type setting are only enforced 
at log in. 

Log out of LearnMate, and log 
in again. All other users will 
view modules using the newly 
select measurement type after 
logging in. 

See Measurement Type on 
page 210. 

A search for a Module, Content 
Object, Test or Assignment 
does not find any matches, 
although at least one match 
definitely exists. 

One or more spaces were 
entered at the end of the search 
string. 

 

Redefine the search, taking 
care not to add spaces at the 
end of search strings. 

A student or instructor would 
like to change his or her 
username. 

LearnMate does not allow a 
username to be changed once 
a user has been created. 

If the user has just been 
created, delete the user and 
create a new one. If the user 
has existed for some time, 
doing the above would cause 
all data collected to date, such 
as test and assignment grades, 
to be lost. 
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When searching for a content 
object in the Add Content 
Object window, a content object 
that is known to match the 
search strings is not found. 

The content object already 
exists in the module. Since 
each content object can only 
exist in one place within a 
module, the search will not 
display content objects that 
exist in the module index 
already. 

See Adding the First Content 
Object to the Index on page 

. 322

 

My Folder 
Problem Possible Cause Solution 

When you send a file as an 
attachment to a mail message, 
that file occupies space 
allocated to you My Folder, but 
cannot be deleted from there. 
Such files are only deleted once 
both the sender and the 
recipient of the mail message 
have deleted the message. 

Delete all items with 
attachments in your Sent Items 
folder. If that does not free 
sufficient space, ask the 
recipients of messages that you 
have sent with large 
attachments to delete those 
messages. 

See Deleting a Message on 
page 38. 

Free space in My Folder is low, 
although there are few files 
there. 

When an instructor adds files to 
an Assignment, those files 
occupy space allocated to the 
instructor’s My Folder. 

Once the Assignment is no 
longer needed, the instructor 
should delete the Assignment, 
and the space in his My Folder 
will be cleared. 

See Deleting Assignments on 
page 371. 
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Other 
Problem Possible Cause Solution 

When LearnMate is supposed 
to open a new window, the new 
window shows the Login page, 
instead of the intended page. 

The security setting on your 
computer prevents LearnMate 
from successfully opening 
another window. 

In Internet Explorer, select 
Tools>Internet 
Options>Security>Trusted 
Sites. Add the address of your 
LearnMate server to the 
Trusted sites zone, for 
example: 

http://www.learnmate.com 

 

Do not check Require server 
verification (https:) for all sites 
in this zone. 
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